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About This Guide
Welcome to the Smartphone handheld device. This guide is designed to 
help you get up and run quickly on your handheld. It describes all you need 
to know about how to use your Smartphone and the applications that come 
with it. 

This guide shows you how to:

• Identify all the parts of your Smartphone
• View and enter data 
• Use your Smartphone with your computer
• Personalize your Smartphone with your own preference settings

After you become familiar with the basic functions of your Smartphone, 
you can use the rest of this guide as a reference for less common tasks, for 
maintenance of your Smartphone, and also a source of information if you 
have problems operating it.
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1
Safety

Traffic safety
Please check the laws and regulations on the use of mobile phones in the 
areas where you are driving. Always obey them. Please use the hands-free 
kit while driving.

Pull off the road and park before making or answering a call if driving 
conditions so require.

Always secure the phone in its holder. Do not place the phone on the 
passenger seat or where it can break loose in a collision or sudden stop.

Phone operating
Remember to follow any special regulations in force in any area and 
always switch off your phone whenever it is forbidden to use it, or when it 
may cause interference or danger.

When connecting, read the Owner's Guide for detailed safety instructions. 
Do not connect it to incompatible products.

Electronic devices
Most modern electronic equipment is shielded from radio frequency (RF) 
signals.However, certain electronic equipment may not be shielded against 
the RF signals from your wireless phone.
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Persons with pacemaker
• Should always keep the phone more than 20cm (7.8 inches) from 

their pacemaker when the phone is switched on.
• Should not carry the phone in a breast pocket.
• Should use the ear opposite the pacemaker to minimize the 

potential for interference.
• If you have any reason to suspect that interference is taking place, 

switch OFF your hand-held phone immediately.

Hearing aids
Some digital wireless phones may interfere with some hearing aids. In the 
event of such interference, you may want to consult your operator or 
service provider.

Other medical devices
Operation of any radio transmitting equipment, including wireless phones, 
may interfere with the functionality of inadequately protected medical 
devices. Consult a physician or the manufacturer of the medical device to 
determine if they are adequately shielded from external RF signal or if you 
have any question.

Switch off your phone in health care facilities when any regulation posted 
in these areas instructs you to do so. Hospitals or health care facilities may 
be using equipment that could be sensitive to external RF signal.

Vehicles
RF signals may affect improperly installed or inadequately shielded 
electronic systems in motor vehicles. Check with the manufacturer or its 
representative regarding your vehicle. You should also consult the 
manufacturer of any equipment that has been added to your vehicle.
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Do not carry it with any combustible, explosive object. In such 
environment, it could cause an explosion or fire resulting in injury or even 
death.

An air bag inflates with great force. Do not place objects, including both 
installed or portable wireless equipment, in the area over the air bag or in 
the air bag deployment area. If in-vehicle wireless equipment is improperly 
installed and the air bag inflates, serious injury could result.

Posted facilities
Turn your phone OFF in any facility where posted notices require you to do 
so.

Potentially explosive environment
Turn your phone OFF and do not remove the battery when in any area with 
potentially explosive environment and obey all signs and instructions. 
Sparks, from your battery, in such areas could cause an explosion or fire 
resulting in injury or even death.

Areas with a potentially explosive environment are often, but not always 
clearly marked. They include fueling areas such as gasoline stations; lower 
deck of boats; fuel or chemical transfer or storage facilities; areas where 
fuel odors are present, etc.

if a gas/propane leak occurs in a car or home; areas where the air contains 
chemicals or particles, such as grain, dust, or metal powders; and any other 
area where you would normally be advised to turn off your vehicle engine.

Aircraft
FCC regulations prohibit the use of your phone while in the air. Switch 
OFF your phone before boarding an aircraft.
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To avoid interfering with the aircraft instrument, do not use the phone on 
the plane.

Persons who disregard the regulations could have their wireless device 
being confiscated, or being charged in court; OR both.
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2
Introduction to the 
Smartphone
With your Smartphone, you’ll successfully be able to manage meetings and 
appointments, remember people’s names and personal details, and keep 
track of all the items on your To Do List at both work and home. 

Become familiar with its physical buttons and controls, and use HotSync® 
technology to synchronize (exchange and update) your Smartphone and 
Smartphone. You’ll find it easy to start using the Smartphone. Once you 
familiarize yourself with the basic workings of the Smartphone, you’ll 
easily be able to do the following:

• Enter all your schedule details in the Date Book and view them by 
the day, week, or month, and even set an alarm to remind you of an 
important event

• Keep all your contact names, addresses, phone numbers, and other 
details in the Address Book, so you can find them as soon as you 
need them

• Add your tasks to the To Do List, prioritize them so you don’t 
overlook them, and assign them a due date

• Ensure that you don’t lose any of this important information simply 
by synchronizing your data with Smartphone on your computer to 
create a backup copy

• Customize your phone and set different levels of security to prevent 
unauthorized users from viewing your data

System requirements for Windows
To install and operate Smartphone on Windows, your computer system 
must meet the following requirements:
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• Smartphone
• 8 MB RAM minimum (Windows XP requires 64 MB), 16 MB 

recommended (required with Windows NT 4.0)
• 20 MB available hard disk space
• VGA monitor or better (the Smartphone Quick Tour requires a 256 

color video display)
• CD-ROM drive 
• Mouse pointing device
• One available serial port

In addition, the following equipment is optional: 

• Modem 

• Windows-compatible printer

Product Layout

Locating front panel controls
1. Speaker
2. Indicator light for GSM signal/low battery warning

Flashing green -GSM is connected

Flashing green (faster) - There is an incoming call 

Off - No SIM card/GSM off/GSM is disconnected

Red - Being charged.

3-10. Graffiti area (please see “Locating function icons in 
Graffiti area” later in this section.)

11. Home button
Press briefly - Exit to previous screen (press it 
repeatedly to cycle through all the application 
categories, like Studio, System, etc.)

Press and hold-  Open the Applications Launcher

12. Call/Receive button
Opens Phone application/Answers an incoming call/
Dials a number

13. C button
Works as Backspace in editing interface/Works as ESC 
in other interfaces.
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14. Application button
Opens a favorite application which can be reassigned in Buttons Preferences (set to 
Camera as default)

15. End Call button
Ends a phone conversation/Rejects an incoming call

16. 5-way Jogdial (Up/Down/Left/Right/Enter)
Enables you to navigate among and select entries on your handheld

17. Keyboard
While the handheld is in standby mode, slide the keyboard out of the dock to open Phone 
application. Slide out the keyboard to answer an incoming call, slide in the keyboard to 
end a phone conversation. And it can be used to input data in editing interface.

Locating function icons in the Graffiti area
3. Brightness

Prompts Adjust Brightness dialog box which enables you to adjust screen brightness

4. Home icon
Prompts the Application Launcher (tap it 
repeatedly to cycle through all the application 
categories, like Studio and System, etc.)

5. Menu icon
Opens the menu of an application

6. Alphabetic keyboard
Prompts alphabetic keyboard

7. Contrast
Prompts Adjust Contrast dialog box which enables you to adjust screen contrast

8. Favorite icon
Opens a favorite application which can be reassigned in Buttons Preferences (set to 
Calculator as default)

9. Find icon
Prompts Find dialog box enabling you search through applications installed on your 
handheld for specific text

10. Numeric keyboard
Prompts numeric keyboard
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Locating bottom and top panel components
1. CMOS Camera
2. Power button

Turn on/off the unit. 

Press BRIEFLY when the phone is on- turn off/ on the 
LCD Display.only the GSM (use as a PDA when you’re 
on a plane), or to turn on/off both GSM and PDA.

Press and HOLD down the button when the phone is off 
(both GSM and PDA)- turn on both GSM and PDA. a 
show screen appears, the unit will be powered off in 2 
seconds.

Press and HOLD down the button when both GSM and PDA are on- a show screen 
appears, you can select to turn off GSM Only or to turn off GSM and PDA both.if you 
don’t make any selection,both GSM and PDA will be turned off in 2 seconds.

Press and HOLD down the button when only PDA on - a show screen appears, you can 
select to turn on GSM as well or to turn off GSM and PDA both. If you don't make any 
selection, both GSM and PDA will be turned off in 2 seconds.

3. Antenna
4. Universal port

Connects your handheld to the HotSync USB cable and the charger. The universal port 
also connects peripheral hardware devices to your handheld.

5. Stylus

Slides in and out of the slot in the side channel of your handheld.

Locating side panel components
1. Earphone jack
2. Volume/Shortcut

During a phone conversation, press the volume up/down 
button to increase/decrease volume.

Press the up/down button to open Shortcut application at any 
time except when you are in a phone conversation (please see 
“Using the Shortcut” in Chapter 11, “Working with Utility 
Applications”).

3. RESET button
Resets your handheld

4. IR port
5. Stylus/Side channel
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SIM card
Before using communication functions, like making/receiving  calls, 
sending/receiving SMS/MMS/Email, or connecting to the internet, you 
need to install the SIM card first.

Inserting and removing the SIM card
To insert the SIM card

To remove the SIM card:
Unlock the holder and slide the SIM card out.

Charging the battery
1. Connect your unit to the charger as below (Arrow faces up).

2. Connect the charger to the main power supply.

3. Charge the battery for about 120 minutes. (Approximate charging 
time depends upon battery usage). We recommend you to charge the 
battery for 12 hours at the first time.

l Remove the battery if attached.
Push the holder upward a little
bit and lift it.

2 Slide the SIM card into the slot, with
the golden connectors facing down and
the cut corner to the right. Lower the
holder, press down and pull it down-
ward to lock the holder.
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*Besides the standard charger, you can use the extra desktop charger to 
charge the battery.

Important Notice
• It’s important that you shall always turn off your handheld (both 

GSM and PDA) before removing the battery. Failing to do so can 
cause data memory corruption.

• Always detach the charger before installing or removing the 
battery. 

• To maximize the performance of the phone and not void the 
warranty, always purchase the accessories that are specially 
designed for use with the phone. Customer Service can not be held 
liable for any damage due to use with non authorized accessories.

• The data created by users (like Date Book entries, photos/messages 
received and e-mails/data generated by the Palm Desktop 
synchronization application) will be lost in 5 minutes after power 
off. So, when replacing the battery, please make sure the process 
won’t take too long. In order to prevent the loss of data as a result of 
power off, there are two ways to backup data:
– Backup data to PC with Palm Desktop synchronization 

application. Data will be restored via the synchronization 
application when incidents happen (please see Chapter 13, 
“Exchanging and Updating Data using HotSync Operations”).

– Backup data to Flash in the local machine via the Flash Backup 
Manager application (Flash will not lose data when power off). 
When accidents happen, you could restore data via Flash 
Backup Manager (please see “Flash Backup Manager” in 
Chapter 12).

Tapping versus clicking 
Just as you use a mouse pointer to click elements on your computer’s 
screen, you use the stylus to tap elements on your phone’s touch-sensitive 
screen. Tapping is the basic action used to execute tasks on your phone.
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IMPORTANT: Always use the point of the stylus for tapping or 
making strokes on the phone screen. Do not use a pen, pencil, or 
any other sharp object to write on the phone screen. If you 
misplace your stylus, please contact the supply provider.

With your phone turned on, you can tap the phone screen to perform many 
operations, such as the following:

• Open applications.
• Choose menu commands.
• Initiate a global Find operation.
• Select options in dialog boxes.
• Open the onscreen keyboards.

Just as you drag the mouse to select text or move objects on your computer, 
you can drag the stylus to select text. In addition, you can use the stylus to 
drag the slider of any scroll bar.

Starting your phone and calibrating its screen
The first time you start the Smartphone, setup instructions appear onscreen. 
These instructions include a calibration screen, or a digitizer. Calibration 
aligns the internal circuitry of the phone with its touch-sensitive screen so 
your phone can detect the task you want to perform when you tap an 
element on the screen.

To calibrate your screen:

1. Tap the Home icon , and then tap the Prefs icon .

2. In the pick list in the upper right corner of the screen, tap Digitizer.
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3. Follow the on-screen instructions, tapping the screen where indicated.

Selecting preferred language
After calibrating the screen, you need to select your preferred language.

NOTE: You can switch to another language by changing the 
language preference in Prefs application or by performing a hard 
reset (please refer to “Resetting your handheld” in Chapter 15, 
Appendix A).

Adjusting the brightness of your screen
You can adjust the brightness of your screen to make it easy to see in a 
variety of lighting conditions. 

To adjust the brightness of your phone screen:
1. Turn on your device. 

Tap to select your 
preferred language

And then tap OK 
to apply
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2. Tap the Brightness icon in the upper left conner. The Adjust 
Brightness slider appears.

3. Do one of the following: 

• Drag the slider to adjust the brightness.
• Tap to the right or left of the slider to adjust the brightness in small 

increments.
• Push or push and hold the jogdial upward/downward to adjust the 

brightness in small or large increments, respectively. 

Adjusting the contrast of your screen 
You can adjust the contrast of your screen to make it easy to see in a variety 
of lighting conditions. 

To adjust the contrast of your phone screen:
1. Turn on your device. 

2. Tap the Contrast icon in the upper right conner. The Adjust Contrast 
slider appears.

3. Do one of the following: 

• Drag the slider to adjust the contrast.
• Tap to the right or left of the slider to adjust the contrast in small 

increments.
• Push or push and hold the jogdial upward/downward to adjust the 

contrast in small or large increments, respectively. 

Tap here to show 
this slider

Tap here to 
show this
slider
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To open applications
You can use the Application Launcher to open any application installed on 
your phone. You can activate the individual Smartphone applications that 
correspond to the icons marked on the buttons: Camera and Phone. See 
“Assigning applications to buttons” in Chapter 5 for details on reassigning 
these buttons to other applications on your Smartphone. And you can also 
open commonly used applications from Shortcut, which can be activated 
by pressing the Volume/Shortcut buttons on the left side of your 
Smartphone. See “Using the Shortcut” in Chapter 11 for details using 
applications shortcuts in Shortcut.

TIP: When you press a application button on the front panel of your 
device, the selected application immediately appears. 

In addition to providing a way for you to open applications, the 
Applications Launcher displays the current time, battery level, and 
application category. 

To open an application:
1. Tap the Home icon. 

2. Tap the icon of the application you want to open. If you have many 
applications installed on your Smartphone, tap the scroll bar to see all 
the available applications.

TIP: You can find an application quickly by writing the Graffiti 2 
character for the first letter of its name. The Application Launcher 
scrolls to the first application with a name that begins with that letter.
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Using the interface
Your handheld includes the following interface elements:

• A menu bar containing a set of menu commands specific to the 
application. Not all applications have a menu bar.

• A command bar that lets you tap icons or write a ShortCut stroke to 
initiate a command instead of tapping a command in the menu bar. 
The icons displayed in the Command bar vary within each 
application. 

• Command buttons that initiate a command when tapped. Command 
buttons appear in dialog boxes or at the bottom of application 
screens.

• Icons that open applications and menus, and find text anywhere in 
your data.

menu bar

command bar

command button
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• An abc dot in the input area that activates the alphabetic keyboard 
when tapped; note that the cursor must be in an input field for this 
option to work. 

• A 123 dot in the input area that displays the numeric keyboard 
when tapped; note that the cursor must be in an input field for this 
option to work. 

• Check boxes that indicate the state of the corresponding option. A 
check mark in a check box indicates that the option is active. If a 
check box is empty, tapping it inserts a check mark. If a check box 
is checked, tapping it removes the check mark.

• Pick lists that display a list of choices. Tap the black triangle next to 
the pick list name to display a list of choices, and then tap an item in 
the list to select it.

icons

check box
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• A scroll bar to move through long notes or memos. Tap and hold 
down the scroll bar slider to scroll through pages; tap the slider 
arrow at either end to move one line at a time. To scroll to the 
previous page, tap the scroll bar just above the slider; to scroll to the 
next page, tap the scroll bar just below the slider. You can also 
scroll to the previous and next pages by pressing the upper and 
lower portions of the scroll button on the front panel of the phone.

• Previous/nnext arrows display the previous or next page of 
information.

• Text areas and screens in which you can enter information.

pick list

scroll bar

next/previous arrows
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Using menus and menu commands 
Menus on your phone are easy to use, and work the same way in all 
applications. Menu bars and menu commands differ based on the 
application and the area of the application in which you’re working. For 
example, in the Memo Pad, the Memo List screen and the Memo screen 
display different menus. 

Menu commands for each application are described in the corresponding 
application’s chapter, with the exception of the Edit menu. 

Most menu commands have an equivalent Graffiti 2 command stroke, 
which is similar to keyboard shortcuts used to execute commands on 
computers. To use Graffiti 2 menu commands, menus must be closed. 

To display a menu bar and choose a command: 
1. Do one of the following: 

• Open an application (such as the Date Book); then tap the Menu 
icon. Select the desired command from the menu. 

• Tap the inverted tab at the top of any application’s screen (The 
Calculator does not have an inverted tab); then tap the desired 
command. 

• In the text input area of your device’s screen, drag a diagonal line 
from the lower left to upper right to display the Command toolbar. 
The command bar is displayed for approximate 4 seconds.

screen

text area
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Tap an icon that represents the command you want, or enter the ShortCut 
for the command in the text input area below the Command toolbar. For 
example, to choose Select All in the Edit menu, draw the Graffiti 2 
command stroke in the text area to display the Command toolbar; then 
draw the letter S. Note that if you wait more than three seconds to draw the 
ShortCut letter, you’ll have to redraw the Graffiti 2 command stroke to 
redisplay the Command toolbar.

Displaying tips
Many of the dialog boxes that appear on your phone contain a Tips icon in 
the upper right corner. Tips anticipate questions you may have and provide 
shortcuts for using the dialog box or other useful information. 

To display a tip:
1. Tap the Tips icon (the lowercase “i” in the upper right corner of the 

dialog box). 

2. Tap Done after reading the tip. 

Entering data
You can enter data into your Smartphone in four ways:

• Using the onscreen keyboard
• Using the hard keyboard
• Using Graffiti 2

Tips icon
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• Entering or importing data in Smartphone, and then synchronizing 
with your phone

For more information, see these topics in Chapter 3, “Entering Data in 
Your Smartphone”.

Palm Desktop software
Palm Desktop includes the same main applications as your Smartphone: 
Address Book, Date Book, To Do List, Memo Pad, and desktop e-mail 
connectivity. You can use the HotSync feature of this software to back up 
and exchange data between your phone and your computer.

It’s a good idea to back up your data in case something happens to the data 
on your Smartphone. Changes you make on your Smartphone or Palm 
Desktop appear in both places after you synchronize.

With Palm Desktop, you can do the following:

• Work with your Smartphone applications on your computer. Palm 
Desktop duplicates the Date Book, Address Book, To Do List, and 
Memo Pad applications on your phone, so that you can view, enter, 
and modify any data stored on your phone.

• Back up the data stored on your phone with HotSync technology 
and synchronize the data on your Palm Desktop. Synchronization is 
a one-step procedure that ensures your data is always safe and up to 
date. See “Exchanging and Updating Data using HotSync 
Operations” in Chapter 11 for more information. 

• Import and export data, so you can easily transfer data from other 
desktop applications into any of your main applications. See 
“Importing data” in Chapter 3 for more information.

• Print your Date Book, Address Book, To Do List, and Memo Pad 
information on any printer.

Connecting the HotSync cable
The HotSync cable that comes with your Smartphone enables you to 
synchronize the information on your Smartphone with the Smartphone 
using HotSync technology.
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To connect your HotSync cable:
• Turn off your computer and plug the HotSync cable from the 

Smartphone into the serial port on your computer.

Installing Palm Desktop
The following instructions guide you through installing Palm Desktop so 
that you can transfer data from your computer to your phone.

After installation, refer to the online Help in Palm Desktop for information 
on how to use the software.

To ensure a safe and uninterrupted installation of Palm Desktop, do the 
following before installing:

• Turn off your computer and connect to it with the HotSync cable. 
• If you are installing from floppy disks (rather than the CD included 

in the box), make sure that the original Palm Desktop disks are 
write-protected, and then make backup copies of them. When you 
have finished, use the copies to install the software, and store the 
original disks in a safe place. Refer to your computer’s manual or 
operating system documentation for information on locking or 
copying diskettes.

• Do not copy the Palm Desktop files to your computer’s hard disk. 
You must use the installer to place the files in their proper locations 
and to decompress the files. 

To install Palm Desktop:
1. Exit any open programs, including those that run at startup such as 

Microsoft Office, and disable any virus-scanning software.

2. Insert the Palm Desktop CD into the computer’s CD-ROM drive (or 
insert the Setup disk into the floppy disk drive). 

3. When the Palm Desktop Installer Menu screen appears, click the 
Install button to begin the installation procedure.

4. Follow the onscreen instructions to complete the installation. When 
prompted, use the HotSync cable to connect your phone.
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3
Using the Phone

Activating the Phone function
1. Activate GSM first.

Before using the phone function, please make sure the SIM card is properly 
inserted and GSM is turned on (you can see from the signal strength icon in 
the status bar, Off: ; On: ). If not, follow one of the following 
to activate GSM:

• Press and the Power button to show Switch list and tap GSM On to 
activate GSM.

• Tap GSM application icon from the Applications Launcher, and tap 
“Turn On GSM” to activate GSM.

Tap this to turn off GSM

The Signal Strength icon shows 
that GSM is currently Off

Tap this to turn on GSM

GSM is now on

If the Auto On and
Auto Off functions are
enabled, the GSM will

be activated and
deactivated

automatically at the
time you specified.
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2. Enter Phone application.

There 3 ways to open Phone application:

• Press the Call button  on the front panel of the unit.

• Tap the Home icon , and select Communication from the pick 

list in the upper right corner; then tap the Phone icon . 
• Slide the hard keyboard away from the dock.

Network selection
When you activate the Phone, it searches for the most suitable network 
automatically. If you want to shift to another network, follow the steps 
below to do so:

1. Tap the Home icon  and tap the GSM On/Off application icon from the 
Applications Launcher.

2. Tap the network pick list to select the method your phone searches for 
networks:

• If Automatic is selected, it searches for the most suitable network 
automatically and connects to it.

• If Manual is selected, it searches for networks available within the 
range, and then lists out the networks for your selection. Tap a 
network to connect.



Using the Phone
Making a call

Smartphone User’s Manual 24
   

This is the internet version of the User Manual.Print only for private use.

Making a call
1. Do one of the following to open Phone application.

• Press the call button on the front panel of your smart phone.
• Tap the Home icon and tap the Phone icon.
• Slide the hard keyboard away from the dock. (This won’t work 

when you’re in edit mode.)
2. Do one of the following to input the number you want to dial:

• Press numbers on the hard keyboard

• Tap the number you want to dial on the numeric key pad.

3. Press the Call button to dial.

4. When finished, slide the hard keyboard back into the dock or press the 
End Call button to end.

Numeric key pad

Backspace
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Instead of tapping the key pad to enter a number, you can dial a phone 
number directly from Address Book or Speed Dial.

To dial a number from Address Book:
1. In Phone screen, push the jogdial down to go to the index screen of 

Address Book.

2. Tap a desired number (or you can press down the jogdial (Enter) to 
highlight the first entry and the push the jogdial up/down to select an 
entry) and press the Call button to call.

To dial a number from Speed Dial:
1. In Phone screen, push the jogdial up to skip to the index screen of 

Speed Dial.

2. Tap a desired number (or you can press down the jogdial to highlight 
the first entry and the push the jogdial up/down to select an entry) and 
press the Call button to call.

Or tap Select to export 
the selected number to 
the Phone screen

Select an entry and 
press the Call button 
to dial directly

Select an entry and 
press the Call button 
to dial directly
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If there is no existing entry in Speed Dial, you can create a new entry right 
away, or import numbers from Address Book.

To create a new entry in the index screen of Speed Dial:
1. Tap any blank entry and then tap Edit.

2. Input necessary information, and then tap Done when finished.

To import an entry from Address Book
1. Tap any blank entry and then tap Edit.

2. Tap Addr to skip to the index screen of Address Book.

3. Select an entry and then tap Paste.

Tap any entry to 
show dialog box 
of details Tap Edit to edit 

the selected 
entry

Tap Delete to delete 
the selected entry

Tap Addr to 
skip to 
Address 
Book

Tap Paste to 
paste the 
selected entry 
to Speed Dial 
as a new entry
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Answering a call
When you have an incoming call, the caller id and number will be 
displayed on screen, or only the number appears if the caller is not listed in 
your Address Book. If you have assigned a photo to the caller in Address 
Book, you'll see the photo when the caller calls you. Similarly, if you've 
assigned a private melody or Category Ringtone, you'll hear the Ringtone 
when the caller calls you.

NOTE: The Caller ID function won't be available unless you've 
subscribed to the service. Please contact your service provider for 
relative information.

To answer/reject an incoming call:
• Press the Call button  or slide out the hard keyboard to answer 

the call.
• Press the End Call button  or to reject the call.
• Slide the hard keyboard out/in to answer/reject the call.

During a call
When a call is established, buttons at the bottom of the screen provide you 
extra functions:

Tap this button 
or press the Call 
button to answer 
the call

Tap this button or 
press the End Call 
button to reject 
the call
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NOTE: Only if your subscription supports 2-line service, some of 
the services described above will be available, like Hold and New.

Other Phone related functions
In the main screen of Phone application, use the jogdial for quick access to 
other Phone related functions.

1. In standby mode, press the jogdial (Enter) on the front panel of the 
unit to pop up the Function list.

When there’s another incoming call, tap Hold to hold the 
current conversation and answer the new call.

During the conversation, if you don’t want to be heard 
temporarily, tap Mute. Tap this button again to resume.

DTMF (dual tone multi frequency) is the signal to the phone 
company that you generate when you press an ordinary 
telephone's touch key. It’s used to control answering machines 
or repeaters. Tap this button to show the DTMF key pad.

Tap this to hold the current conversation and make a new call.

Save the phone number currently 
onscreen to Address Book as a 
new entry

Switch to Call Divert 
setting screen

Switch to the list screen of 
Country Code

Switch to the list screen of 
IP Number

Switch to Ringtone Profile 
setting screen
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2. Select the function you want to use:

Save to Address Book
Tap this button to save the number in the number input area to Address 
Book as a new entry.

Call Divert
If you want to make certain that your incoming calls are correctly 
handled when you are unable to answer them, you can use the Call 
Divert service to divert them to another phone number.

Insert Country Code
For quick access to country code list.

When finished, tap OK to save and return 
to the Phone screen.

This icon indicates that Call Divert is currently enabled.

Tap this to switch Call Divert on/off.

Apply this number to all items below if it’s checked.

Divert all incoming calls to the specified number.

Divert calls if your phone’s busy.

Divert calls if the incoming calls are not answered within 
a specified time.
Divert calls if your phone is turned off or if you’re 
unreachable.

Only when you tap Done, changes will take effect.
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Insert IP Code
For quick access to IP code list.

Profiles
Tap the Profiles button to enter Ringtone Profiles setting screen. 
Alternatively, you can tap the speaker icon  in the status bar on the 
top of the screen to enter Ringtone Profiles setting screen.

Use various ringtone profiles to adopt to different environment you’re 
currently situated in.

Tap on a desired country code.

Tap Select to paste the selected code to the 
number input area in Phone screen.

Tap this to apply the selected IP number

Tap this to add a new IP number

Tap this to edit a selected IP number
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Checking call records
In Standby mode, press the Call button to show Call Record screen, 
missed/received/dialed/rejected calls will be listed in this screen. Tap the 
category tab respectively to show only missed, received, dialed calls, or to 
show all call records.

Alternatively, you can push the jogdial left/right to check records of 
missed/received calls. 

NOTE: Please make sure that the number field is empty, 
otherwise pushing the jogdial left/right will only move the cursor 
left/right.

Tap the Profile pick list to select a preferred profile.

Or you can adjust the options below specifically to 
customize a profile which might suit you best.

Tap this to restore to default settings.

Tap this to return to previous screen.

Tap this to save the
highlighted number to

Address

Tap this to modify the
name and phone number

of the individual

Tap Details to check call 
details of the selected record

Category Pick list (All/
Missed/Received/Dialed)
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Call Setting
To adjust Call Setting:

1. In Standby mode, tap the Menu icon.

2. Select Call Setting from the Call pull-down menu.

Phone security
There are several way to protect your phone and subscription from 
unauthorized use. Anything from a SIM card lock to full phone number 
control.

To enter security setting screen:
1. In Standby mode, tap the Menu icon.

2. Select setting from the Option pull-down menu.

If you wish to be able to receive a second call, while another 
call is in progress, you must turn on Call Waiting service.

You can select to display Call line ID or Network title 
onscreen, or select Hide to hide those information.

Two display methods of country code provided. To show code 
only or add a “+” prefix before the code.

If Auto Redial is enabled, the call you dialed will be 
automatically re-dialed after a few seconds if the phone 
receives busy signal.
Tap this to save changes.
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Password
This function protects only your subscription and not your phone from 
unauthorized use. If you change SIM cards, the phone still works with the 
new SIM card. 

If you enable Password, you need to set a PIN (Personal Identity Number) 
CODE (4-8 digits). Once the PIN CODE is set, you have to enter the PIN 
code every time you turn on your phone. 

If you enter your PIN CODE incorrectly three times in a row, the SIM card 
will be locked. 

To unlock the SIM card, you have to enter your PUK which you can find in 
the information supplied by your network operator.

Voice call barring
This function allows you to restrict certain types of calls to be made and 
received. To enable this function, you need to set a BARRING CODE first.

Outgoing
• Deactivated - disable call barring function
• All - all outgoing calls
• Int'l - all outgoing international calls 
• Int'l x Home - all out going international 

calls except home calls. 

Incoming
• Deactivated - disable call barring function
• All - all incoming calls
• Roaming - all incoming calls when you 

are aboard (when roaming).
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Fix dialing
Fix Dialing is a way of restricting outgoing calls. It requires a SIM card 
that allows fixed numbers to be saved. It allows calls to be made only to 
certain numbers saved on the SIM card. The fixed numbers are normally 
protected by your PIN 2 CODE. 

Conference calls
A conference call is a call with more than two participants. As in ordinary 
conference, all participants can hear each other at the same time. 

Setting up a Conference Call
To set up a conference call, you must have one active call and one call on 
hold.

1. When you’re talking to B, press the New button to call participant C. 
If C is connected, B will be temporarily hold automatically.

• Tap On to enable this function
• Tap Off to disable this function
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2. Tap the Conference button on the bottom of the screen, now the call on 
hold is added to a conference call.

Adding new participants to a conference call
1. During a conference call, tap the New button on the bottom of the 

screen to call the person you want to add to the conference call.

2. Now tap the Conference button to re-initiate the conference call with 
D’s participation.

Having a private conversation with one of the 
participants

1. During a conference call, tap the participant with whom you want to 
have a private conversation.

Once a 
conference call 
is set up, the 
Conference 
button will be 
changed to New 
button

Tap New to call 
participant D

Once D is connected,
all the previous

participants will be
temporarily hold.
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2. Tap the Menu icon and select Private Conv from the Options pull-
down menu.

To cancel the private conversation with C and resume the conference call, 
just simply select Activate All from the Options pull-down menu.

Now only the selected 
participant C is active.
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4
Entering Data in Your 
Smartphone
You can enter data into your Smartphone by using the hard keyboard, 
onscreen keyboard, writing with the stylus in the text input area, or by 
importing data from another application.

Using the onscreen keyboard
You can open the onscreen keyboard anytime you need to enter text or 
numbers on your Smartphone. 

To use the onscreen keyboard
When the system language is set to English:

1. Open any application (such as the Address Book). 

2. Tap any record, or tap New.

3. Choose one of the following to display the alphabetic or numeric 
keyboard:

• Tap abc on the front panel of your Smartphone to display the 
alphabetic keyboard. 

• Tap 123 on the front panel of your to display the numeric keyboard. 

Tap abc for 
alphabetic 
keyboard.

Tap 123 for 
numeric 
keyboard.
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TIP: To select any of the three keyboards, tap the Menu icon 
and then tap Edit. Tap Keyboard, and then tap the keyboard you 
want.

4. Tap the desired characters or numbers; then tap Done to enter the text 
or numbers. 

When the system language is set to Simplified Chinese:
1. Open the application that requires data entry.

Backspace

Carriage return

Tab

Caps Lock

Caps Shift

Tap here to display alphabetic keyboard 

Tap here to display 
numeric keyboard. 

Tap here to display 
international keyboard. 

Alphabetic 

Numeric International
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2. Tap the “abc” icon or “123” for a alphabetic/numeric keyboard in the 
graffiti area.

3. To select another input method instead of the default Strokes input 
method, tap  to show the list of input methods and select one.

4. Tap proper keys according to the rules of the selected input method to 
key in Chinese characters.

Tap this to show 
editorial tools (Copy/
Cut/Paste)

Line feed

Space

Numeric keyboard

English keyboard

Tap this to call out the 
list of input methods

All candidates 
consist of q, e

More 
candidates

Delete the last
inputted key 
(It’s “e” here)
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5. As you tap keys onscreen, matched candidates will be lined up below 
the onscreen keyboard. Tap a desired word to put it to the content line, 
then associated words will be shown for quick entry.

Besides Chinese keyboard entry, your Smartphone also comes with multi-
lingual (including English, Simplified and Traditional Chinese) 
handwriting recognition:

1. Tap  to enable handwriting entry.

2. Write with the stylus directly on the handwriting area.

3. When you lift the stylus, the closest word will be inputted to the 
content line, and less matched candidates will be lined up below the 
handwriting area. If the inputted word is not a right one, you can tap 

Put the
desired

word into
the

content
line by

tapping on

Content line

And then
associated words

appears

Tap this to 
enable 

handwriting 
recognition

Handwriting
area Chinese 

recognition

English 

Number 

Symbol 
recognition
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any candidates below to replace it right away. Once the inputted word 
is confirmed, you can select associated words below for quick entry.

When the system language is set to Traditional Chinese:
When inputting data, it’s pretty much the same with the Simplified Chinese 
mode. The only difference is that Traditional Chinese mode uses different 
input modes for Traditional Chinese entry, and it provides more methods.

Entering data using the hard keyboard
To use the hard keyboard
In English Platform

1. Open any application (such as the Address Book). 

2. Tap any record, or tap New.

3. Slide the keyboard away from the dock.

4. Press number key repeatedly until required letter appears. 

For instance: press  briefly once for letter “a”, twice for “b” etc.

Once you lift the stylus, the 
closest word will be inputted 
to the content line

Matched candidates

Associated words

Tap any one of these buttons 
to return to keyboard entry
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TIP: Press  repeatedly to swap between ABC, abc and 
123 modes.

Entering data using Graffiti 2 handwriting
You can use Graffiti 2 strokes to create letters, numbers, punctuation, and 
symbols. The Graffiti 2 writing strokes include all letters, numbers, and 
symbols found on a standard keyboard. 

Learning to write Graffiti 2 characters
With only a few minutes of practice, you’ll find it easy to enter accurate 
text and numbers using Graffiti 2 writing strokes.

The Graffiti 2 demo shows how to use the handwriting software. The first 
time you turn on your Smartphone, or perform a hard reset, the Welcome 
application will automatically guide you through the setup process. When 
you complete setup, you will be invited to learn how to use your 
handwriting software.
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You should try the demo if Graffiti 2 is new to you. After you view the 
Welcome application the first time, a Graffiti 2 Demo icon will appear on 
the Applications Launcher screen. Tap on this icon to view the demo at any 
time.

TIP: When you reach the Stroke Lookup screen of the demo, 
use the pick list to view a wide variety of characters that you can 
make. As you tap a character, you will see an animation of the 
strokes used to form that character.

General Guidelines for Graffiti 2 Writing
Follow these guidelines to learn and use Graffiti 2 writing strokes 
successfully: 

• To achieve 100% accuracy, practice drawing characters exactly as 
they appear in the tables later in this chapter.

• The heavy dot on each shape indicates where to start the stroke. 
Some characters have similar shapes, but different starting and 
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ending points. Always start the stroke at the heavy dot. (Do not 
draw the heavy dot; it is there only as a guideline.) 

• The Graffiti 2 writing strokes for letters closely resemble letters of 
the standard English alphabet, both upper case and lower case. 
Graffiti 2 includes symbols made with a single stroke and symbols 
made with multiple strokes.
For multi-stroke characters, a temporary character is displayed after 
the first stroke, to show that the stroke was recognized. For 
example, after the first vertical stroke of “t”, a temporary “l” is 
shown. There is a limited time window, during which the second 
stroke must be drawn. Otherwise the temporary stroke is recorded.

• The text input area is divided into two parts, one for writing 
lowercase letters and one for writing numbers. The small marks at 
the top and bottom of the text input area define the division line. To 
have your Smartphone recognize letters and numbers, you must 
begin letter strokes on the left side, and number strokes on the right 
side of the text input area. Uppercase letters are formed by writing 
across the division line.

To write Graffiti 2 letters:
1. Tap the screen where you want to write text, for example, on a line 

next to a time in the Date Book. 

NOTE: A blinking cursor must appear onscreen above the 
Graffiti 2 writing area before you can begin writing text. 

2. Use the tables on the following pages to find the stroke shape for the 
letter you want to write. For example, the stroke shown below creates 
the letter n. 

Write lowercase letters here Write numbers here

Start stroke at 
heavy dot.

Lift stylus 
here.
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You use the same shape to create both the lowercase letter and the 
uppercase letter.

3. Position the stylus in the appropriate place of the text input area. 

4. Start your stroke at the heavy dot, and draw the stroke shape as it 
appears in the tables.

5. Lift the stylus from the screen at the end of the stroke shape.

6. Your Smartphone recognizes your stroke immediately and displays 
the letter at the insertion point tap onscreen. As soon as you lift the 
stylus from the screen, you can begin the stroke for the next character 
you want to write.

Graffiti 2 tips
When using Graffiti 2 writing, keep the following tips in mind:

• For greater accuracy, draw letters with large strokes; strokes that 
nearly fill the text input area are easily interpreted. 

• To delete characters, set the insertion point to the right of the 
character you want to delete, and draw the Backspace stroke (a line 
from right to left) in the text input area.

• Write at natural speed. Writing too slowly can produce errors.
• Do not write at a slant. Keep vertical strokes parallel to the sides of 

the text input area.
• When letters and numbers can be written using two different 

strokes, use the easiest one for you. 
• Press firmly.

The Graffiti 2 alphabet
Draw Graffiti 2 letters according to the following alphabet.

Write lowercase 
letters here

Write numbers 

Write uppercase letters across 
these division markers
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Writing punctuation marks and other special 
characters
Using Graffiti 2 writing, you can create any punctuation symbol and 
special character available from a standard keyboard. 

• The period and comma punctuation marks can be written on either 
side of the text input area (the letter or number side). Other 
common punctuation marks can be written on one side of the text 
input area according to the chart below (in general, the more 
frequently used punctuation is on the left side).

Note that the punctuation characters can also be entered anywhere 
on the text input area if you first use the shift character. This 
requires an additional shift stroke, but you may find it more 
convenient, since you don’t have to remember on which side of the 
input area to make the stroke.

• When writing letters with accent marks, first write the letter stroke 
on the left side (or in the center for uppercase letters) of the input 
area. Then quickly write the accent stroke on the right side of the 
input area, as shown in the illustration below.

• Symbols and other special characters can be written using the Shift 
command. When you make a vertical stroke from the bottom to the 
top in the text input area, the Shift indicator arrow appears in the 
lower right corner of the screen. While this arrow is visible, you can 
make the punctuation shift characters shown in the illustration 
below. Once the arrow goes away, the punctuation mark appears.
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TIP: Using an additional Shift stroke to finish writing the 
character (as shown in the demo) is optional, but will make the 
character appear more quickly.

Draw punctuation, symbols or accent marks using the following strokes:

TIP: Samples of the character strokes are available in the 
Graffiti 2 Help file. To view the Help file, use the full-screen pen 
stroke, dragging the stylus from the text input area to the top of 
the screen. Note that the accented characters appear on a 
Punctuation Shift screen, but do not use the Shift command. To 
write uppercase accented characters, write the letter across the 
division mark, just as you would do with an ordinary letter.

Using the Graffiti 2 tuner
The Graffiti 2 tuner provides alternate strokes for making the T, P, Y, and $ 
characters. For example, you may want to write the letter “T” by using 
strokes similar to a space and an “L”. But if this technique is difficult to 
control, you can turn off this option.
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To use the tuner:

1. Tap the Home icon .

2. In the pick list in the upper right corner of the screen, tap Main or 
System.

3. Tap the Prefs icon .

4. Select Graffiti 2 from the pick list in the upper right corner of the 
screen.

5. Tap on one of the letters available for you to tune:

Using Graffiti 2 Gestures
Gestures are editing commands, such as cut, paste, and the ShortCut 
command which will be explained in the next section. To use gestures, 
draw the following strokes:
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Using Graffiti 2 ShortCuts
Graffiti 2 ShortCuts let you quickly and easily enter commonly used words 
or phrases. ShortCuts are similar to the Glossary or Autotext features of 
some word processors. Graffiti 2 writing comes with several predefined 
ShortCuts. You can also create your own, for any words, letters, or 
numbers.

You can create ShortCuts, with up to 45 characters, using the ShortCut 
preferences. For example, you could create a ShortCut for your name or for 
the header of a memo. All ShortCuts you create appear on the list in the 
ShortCut Preferences screen, are available in any of your Smartphone 
applications, and are backed up on your computer when you perform a 
HotSync® operation.

Your Smartphone includes the following predefined Graffiti 2 ShortCuts 
for common entries:

• ds—Date stamp
• ts—Time stamp
• dts—Date/time stamp
• me—Meeting
• br—Breakfast
• lu—Lunch
• di—Dinner

To use a ShortCut:
Draw the ShortCut stroke, followed by the ShortCut character or 
characters. 
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When you draw the ShortCut stroke, the ShortCut symbol appears at the 
insertion point.

To create a ShortCut:

1. Tap the Home icon .

2. Select All or System from the pick list in the upper right corner.

3. Select Prefs from the menu.

4. Tap ShortCuts in the pick list in the upper right corner. 

5. Tap New.

6. In the ShortCut Name line of the ShortCut Entry screen, enter the 
letters you want to use to activate the ShortCut.

7. Tap the ShortCut Text area, then enter the text that will appear when 
you write the ShortCut characters. 

8. You can add a space character after the last word in your ShortCut 
text, so that a space automatically follows the ShortCut text.

9. Tap OK.

To edit a ShortCut:
1. In the ShortCut Preferences screen, tap the ShortCut you want to edit.

2. Tap Edit.

3. Make the changes you want, then tap OK.

ShortCut

Tap New.
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To delete a ShortCut:
1. In the ShortCut Preferences screen, tap the ShortCut you want to 

delete.

2. Tap Delete, then tap Yes.

Importing data
If you have data stored in computer applications such as spreadsheets and 
databases, or if you want to import data from another device, you can 
transfer the data to your Smartphone without having to key it in manually. 
Save the data in one of the file formats listed below, import it into 
Smartphone, and then perform a HotSync operation to transfer the data to 
your Smartphone.

Smartphone can import data in the following file formats: 

• Comma delimited (*.csv, *.txt): Address Book and Memo Pad 
only.

• Tab delimited (*.tab, *.tsv, *.txt): Address Book and Memo Pad 
only.

• CSV (Lotus Organizer 2.x/97 Mapping): Address Book only.
• Date Book archive (*.dba).
• Address Book archive (*.aba).
• To Do List archive (*.tda).
• Memo Pad archive (*.mpa).

Archive formats can only be used with Smartphone. Use the archive file 
formats to share information with other people who use Palm Powered 
handhelds or to create a copy of your important Smartphone information.

To import data:
1. Open Smartphone.

2. Click the application into which you want to import data.

3. If you are importing records that contain a field with category names, 
do the following:

a. Select All in the Category box.
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b. Make sure that the same categories that appear in the imported file 
also exist in the application. If the categories do not exist, create 
them now; otherwise, the records will be imported into the Unfiled 
category.

4. Choose File > Import; then select the file you want to import, and click 
Open. 

5. To import data into the correct Smartphone fields, drag fields in the 
left column so that they are opposite to the corresponding imported 
field on the right.

6. To exclude a field from being imported, deselect the field’s check box. 

7. Click OK.

8. The imported data is highlighted in the application.

9. To add the imported data to your Smartphone, perform a HotSync 
operation.

See Smartphone online Help for more information on importing and 
exporting data.

Beaming data
Your handheld is equipped with an infrared (IR) port that is located at the 
right side of the handheld, behind the small dark shield. The IR port 
supports the IrCOMM implementation of the standards for infrared 
communication established by the Infrared Data Association (IrDA). This 
means that not only can you beam data to another Palm OS handheld that's 
close by and is equipped with an IR port, but you can also beam data to a 
mobile phone and to any other device that supports the IrCOMM 
implementation of the IrDA standards and that can read the type of data 
you're beaming. 

You can beam the following information between devices with an IR port: 

• The record currently displayed in Date Book, Address Book, To Do 
List, Note Pad, Palm Photos, or Memo Pad 

• All records of the category currently displayed in Address Book, To 
Do List, Note Pad, Palm Photos, or Memo Pad 
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• A special Address Book record that you designate as your business 
card, containing information you want to exchange with business 
contacts 

• An application installed in RAM memory 

TIP: You can also perform HotSync operations using the IR 
port. See “IR HotSync Operations” in Chapter 12 for details. 

To select a business card: 
1. Create an Address Book record that contains the information you 

want on your business card. 

2. Tap the Menu icon.

3. Select “Select Business Card” from the Record menu. 

4. Tap Yes. 

To beam a record, business card, or category of records: 
1. Locate the record, business card, or category you want to beam. 

2. Tap the Menu icon.

3. Select one of the following from the Record menu: 

– The Beam command for an individual record 
– In Address Book only: Beam Business Card 
– Beam Category 

4. When the Beam Status dialog box appears, point the IR port directly 
at the IR port of the receiving handheld. 

For best results, handhelds should be between 10 centimeters 
(approximately 4 inches) and 1 meter (approximately 39 inches) apart, and 
the path between the two handhelds must be clear of obstacles. The 
beaming distance to other Palm OS handhelds may be different. 

5. Wait for the Beam Status dialog box to indicate that the transfer is 
complete before you continue working on your handheld. 

To beam an application: 
1. Tap the Home icon.

2. Tap the Menu icon.
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3. And then select Beam from App menu. 

4. Tap the application you want to transfer. 

NOTE: Some applications are copy-protected and cannot be 
beamed. 

5. Tap Beam. 

6. When the Beam Status dialog box appears, point the IR port directly 
at the IR port of the receiving handheld. 

7. Wait for the Beam Status dialog box to indicate that the transfer is 
complete before you continue working on your handheld. 

To receive beamed information: 
1. Turn on your handheld. 

2. Point the IR port directly at the IR port of the transmitting handheld 
to open the Beam dialog box. 

3. Tap Yes.
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5
Performing Common 
Tasks
The tasks described in this section use the term records to refer to an 
individual item in any of the basic applications, for example, a single Date 
Book event, Address Book entry, To Do List item or Memo Pad memo 
item.

Creating records
You can use the following procedure to create a new record in Date Book, 
Address Book, To Do List and Memo Pad.

To create a record:
1. Select the application in which you want to create a record.

2. Tap New. (For the Date Book only, select start and end times for your 
appointment and tap OK.)

3. Enter text for the record.

NOTE: The Smartphone automatically capitalizes the first letter 
of each field (except numeric and e-mail fields). 

4. As an option, tap Details to select attributes for the record.

5. In the Address Book and Memo Pad only, tap Done.

Your Smartphone saves the new record automatically.
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Editing records
After you create a record, you can change, delete, or add new information 
at any time. When the screen is in edit mode, a blinking cursor appears 
within the information, and the information appears on a dotted gray line 
called an edit line.

You can enter text in any of the ways described in Chapter 3, “Entering 
Data in your Smartphone”.

Selecting Text
Select the text you want to edit using one of the following techniques:

• Double-tap on a word in a field to select the word.
• Triple-tap on any word on a line to select the entire line.
• To select a segment character in the character: you can tap the top 

or trail of character you want to select, then pull to the trail or top of 
the segment you want to select. So you can select several character 
one time.

Using the Edit menu
The Edit menu is available from any screen where you enter or edit text. As 
a general rule, the Edit menu commands affect the selected text. You can 
display the Edit menu in three ways: by tapping the Menu icon, by tapping 
the inverted tab at the top of the screen, and by writing a Graffiti® 2 
ShortCut. 

Edit line 

Cursor
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To use the Edit menu: 
1. Do one of the following to display the Edit menu: 

• Tap the Menu icon; then tap the Edit menu to display the 
commands in the menu. 

• Tap the inverted tab at the top of the screen; then tap the Edit menu 
to display the commands in the menu. 

• In the text input area, drag a diagonal line from the lower left to 
upper right to display the Command toolbar. To select a command, 
either tap the icon representing a command on the Command 
toolbar, or draw the Graffiti 2 ShortCut in the text area of your 
screen.

2. Choose from the following commands, depending on the application 
you’re using: 

• Undo reverses the last action taken. 
• Cut removes a selection from its current location to memory. You 

can then paste the text into another area of the current application or 
into a different application.

• Copy copies a selection and moves it to memory. You can paste the 
selection into another area of the current application or into a 
different application.

• Paste inserts a selection from memory into an area you select. Paste 
produces no result if you have not used the Cut or Copy commands, 
it will execute this command.

• Select All selects all the text in the current record or screen. 
• Keyboard opens the onscreen keyboard. Tap Done to close the 

keyboard. 
• Graffiti 2 Help opens the Graffiti 2 character stroke screen.

Deleting records
You can delete records in any of the basic applications. 

To delete a record in any of the basic applications:
1. Select the record you want to affect.
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2. Do one of the following: 

• Tap the Menu icon, open the Record menu, and then tap the Delete 
command. 
The Delete command differs depending on the application you’re 
using, for example, Delete Event appears in the Record menu while 
you’re in the Date Book, and Delete Item appears when you’re 
using the To Do List. 

• Tap the inverted tab at the top of the screen, open the Record menu, 
and then select the desired Delete command. 

• In the Details dialog box of the application, tap Delete, and then tap 
OK.

• Delete the text of the record. 

NOTE: In the Date Book, deleting the text of a repeating event 
deletes all instances of the event. 

• In the text input area, drag a diagonal line from the lower left to 
upper right to display the Command toolbar; then tap the Delete 
icon or draw a Graffiti 2 ‘D’ in the text area.

A confirmation dialog box appears. 

3. To archive a copy of the deleted file on your PC, select the Save 
Archive option. If you choose the archive option, the record is 
transferred to the archive file on your PC the next time you perform a 
HotSync operation.

4. Tap OK to delete the record. 

Purging records
Over time, as you use Date Book and To Do List, you may accumulate 
records that are no longer useful. For example, events that occurred months 
ago remain in the Date Book, and completed To Do List items remain in 
the list.

Outdated records take up memory on your Smartphone, so it’s a good idea 
to remove them by using Purge. If you think Date Book or To Do List 

Delete icon
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records might prove useful later, you can purge them from your 
Smartphone and save them in an archive file. 

Purging is also available in Mail. Purging is not available in Address Book 
or Memo Pad; delete records from these applications manually. 

To purge records:
1. Open the application from which you want to purge records. 

2. Choose from the following options:

• Tap the Menu icon, open the Record menu, and then tap Purge. A 
confirmation dialog box appears.

• Tap the inverted tab at the top of the screen, open the Record menu, 
and select Purge. 

3. Choose from the following options:

• For the Date Book, select the Delete Events Older Than pick list 
and select an option—1 week, 2 weeks, 3 weeks or 1 month.

• For the Date Book or To Do list, select Save Archive Copy on PC 
to save a copy of purged records in an archive file on your desktop. 
Selecting this option transfers purged records to an archive file the 
next time you perform a HotSync operation. Tap OK.

Categorizing records
You can categorize records in the Address Book, To Do List and Memo 
Pad applications for easy retrieval. (The Date Book does not have 
categories.) When you create a record, it is automatically assigned to the 
currently displayed category. For example, if the All category is displayed, 
the record is assigned to the Unfiled category. A record can remain unfiled 
or it can be assigned to a category at any time. 

Each application has a default set of categories: 

• The Address Book includes a Business, Personal, and QuickList 
category.

• The To Do List includes a Business, Personal, and All category.
You can rename or delete the default categories, and you can create new 
categories. Each application can have up to 15 categories.
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To move a record into a category:
1. Select the record you want to categorize.

2. Tap Details. (From the Address View screen, tap Edit first.)

3. In the Details dialog box, tap the Category pick list, select the desired 
category, and then tap OK. 

To display a category of records:
1. Open one of the following applications: the Address Book, the To Do 

List, or the Memo Pad application. 

2. Tap the pick list in the upper right corner of the screen; then tap the 
category you want to display. 

To add or edit application categories:
1. In the Address Book, To Do List or Memo Pad application, choose 

from the following options:

• Tap the pick list in the upper right corner of the screen, and tap Edit 
Categories. 

Tap the pick list Select a category

Edit Categories
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• In the Address Book, select a record and tap Edit; then tap Details. 
In the Category pick list, tap Edit Categories.

• In the Memo Pad and To Do List, select a record from the list, and 
tap Details. In the Category pick list, tap Edit Categories.

2. Select any of the following options:

• To create a new category, tap New, and enter a new name in the 
text input area. Tap OK. 

• To rename a category, tap it in the list to select it. Tap Rename, 
enter a new name in the text input area, and Tap OK.

• To delete a category, tap it in the list to select it. Tap Delete.
3. Tap OK.

To rename a category:
1. Tap the pick list in the upper right corner of the screen; then tap Edit 

Categories. 

2. Select the category you want to rename; then tap Rename.

3. Enter the new name for the category, and tap OK.

4. Tap OK to exit the Edit Categories dialog box. 

TIP: You can move records from multiple categories into a 
single category by renaming all discrete categories with a single 
category name. 
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Finding records 
Your Smartphone lets you find information in several ways: 

• In all applications, starting with the current application, you can 
find the selected text.

• In the Date Book, the To Do List, and the Memo Pad, you can use 
Phone Lookup to display the Address List screen and add the 
information from this list to a record.

• In the Address Book, you can use the Look Up option to enter the 
first letter of a name to scroll immediately to that name.

• In your Smartphone application, you can use Lookup to access 
information in your Address Book.

Finding Address Book records
You can look up Address Book records using the scroll button on the front 
panel of your device or by typing the first few letters of a name in the Look 
Up option at the bottom of the address screen. 

To look up an Address Book record: 
1. Do one of the following:

• From the Address screen, enter the first few letters of the name you 
want to locate. 

• Use the scroll button on the front panel of the device to scroll a 
screen at a time. Holding down the scroll button accelerates 
scrolling. 

Look Up option



Performing Common Tasks
Finding records

Smartphone User’s Manual 63
   

This is the internet version of the User Manual.Print only for private use.

Using the Find option
The Find option lets you locate text in any or all applications. For example, 
if the text “dog” appears in the Address Book and the Date Book, the Find 
option displays both occurrences in the Find dialog box. 

To use the Find option:
1. Tap the Find icon.

2. Enter the text you want to find, then tap OK. 

Note that the Find option is not case sensitive; searching for “davidson” 
also finds “Davidson.” 

TIP: Select text in an application before tapping Find to 
automatically place the text in the Find dialog box. 

Find searches for the text in all records and all notes within all applications. 

If there have no the recorder you want to search in the found recorder, you 
can tap the Continue Find.

Using Phone Lookup 
The Phone Lookup option lets you add a telephone number from the 
Address list to an entry in another application. For example, you can add 
your dentist’s telephone number to your dental appointment date in the 
Date Book. 

To use Phone Lookup:
1. Display the record in which you want to insert a phone number. The 

record can be in the Date Book, the To Do List, or the Memo Pad.

2. Do one of the following: 
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• Tap the Menu icon. Tap Options, and then tap Phone Lookup. 
• Tap the inverted tab at the top of the screen; then tap Options and 

tap Phone Lookup. 
• In the text input area, drag a diagonal line from the lower left to 

upper right to display the Command toolbar. In the text area, write 
an L, the ShortCut for the Phone Lookup command. 

3. Select a record or write the first few letters of the name you want to 
add. Tap Add to add the information to the record.

NOTE: You can also search based on the selected text. Drag to 
highlight the text, then follow step 2 above. When the search is 
complete, the name and phone number of the candidate will 
replace the selected text.

Sorting records
You can sort lists of records in various ways, depending on the application. 
Sorting is available in applications that display lists—in the Address Book, 
To Do List and Memo Pad.

To sort records in the To Do List applications:
1. Open the application to display the list screen.

2. Tap Show.

3. Tap the Sort By pick list, and select an option.

4. Tap OK.

To sort records in the Address Book and Memo Pad:
1. Open the application to display the list screen.

2. Do one of the following:

• Tap the Menu icon. From the Options menu, tap Preferences. 
• Tap the inverted tab at the top of the screen; then tap Preferences in 

the Options menu. 
• In the text input area, drag a diagonal line from the lower left to 

upper right to display the Command toolbar. In the text area, write 
an R, the ShortCut for the Preferences command. 
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3. In the Preferences dialog box, tap the option you want; then tap OK to 
sort the list. 

To sort the Memo List manually:
Tap and drag a memo to a new location in the list. 

TIP: To display the list of your memos on your computer as you 
arranged them manually on your Smartphone, open Memo Pad in 
Smartphone click List By, and select Order on Handheld.

Making records private
In all the basic applications except the Mail application, you can make 
individual records private. Private records can be either masked or hidden. 
Private records remain visible and accessible until you select a security 
setting to Hide Records. Private record names are covered with a gray bar 
when the security setting is set to Mask Records.

If you have assigned a password to your device, you must enter it before 
private records are displayed.

To make a record private:
1. In your application, do one of the following:

• Create a new record and tap Edit, and then tap Details.
• Select an existing record, and tap Details.

2. Tap the Private check box. Tap OK.

3. At the alert in the Private Records dialog box, tap OK.
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To hide private records:
1. Do one of the following:

• Tap the Menu icon; tap the Security Set or Security in the Options 
menu. 

• Tap the inverted tab at the top of the screen; then tap Security Set or 
Security in the Options menu. 

• Bring up the Command Bar and tap the padlock icon. To bring up 
the Command Bar, drag your pen diagonally across the text input 
area from lower left to upper right.

2. In the Change Security dialog box, in the Current Privacy pick list, tap 
Hide Records; then tap OK.

To display private records:
1. Do one of the following:

• Tap the Menu icon; tap the Security Set or Security in the Options 
menu. 

• Tap the inverted tab at the top of the screen; then tap Security Set or 
Security in the Options menu. 

• Bring up the Command Bar and tap the padlock icon. To bring up 
the Command Bar, drag your pen diagonally across the text input 
area from lower left to upper right.

2. From the Current Privacy pick list, tap Show Records; then tap OK.

3. If you have assigned a password, you must enter the password before 
the hidden records are displayed. 

4. Enter your password, and then tap Show.
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Attaching notes
You can attach notes to records in all the basic applications except the 
Memo Pad. A note can be up to several thousand characters long. 

To attach a note to a record:
1. Display the entry to which you want to add a note. 

2. In Address Book only, tap Edit.

3. Tap Details (or tap Notes in Address Book directly). 

4. Tap Note; then enter the desired note. 

5. Tap Done.

Choosing fonts
You can change the font style in all basic applications. You can choose a 
different font style for each application.

To change the font style:
1. Open an application.

Small font

Large font

Bold font
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2. Do one of the following: 

• Tap the Menu icon. From the Options menu, tap Font.
• Tap the inverted tab at the top of the screen; then tap Font in the 

Options menu. 
• In the text input area, drag a diagonal line from the lower left to 

upper right to display the Command toolbar. In the text area, write 
an F, the ShortCut for the Font command. 

3. Tap the font style you want; then tap OK.

Getting information on an application
You can get information on any application by displaying its About box. 
The About box displays the name and version number of the application. 

To display the About box:
1. Tap the Menu icon from any location. 

2. In the Options menu, tap About. 

3. The text following the About command differs based on your location. 
For example, if you’re in the Date Book, the command is About Date 
Book; if you are in the Address Book, the command is About Address 
Book. 

Tap here for small font.
Tap here for large font.

Tap here for bold font.
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6
Managing 
Applications
This chapter explains how to switch between applications on your 
Smartphone, how to personalize application settings, and how to categorize 
applications into related groups. 

Using the Applications Launcher
The Applications Launcher displays all the available applications on your 
Smartphone by default. You can also display only selected applications by 
arranging applications into categories. 

To open the Applications Launcher:
Tap the Home icon.

Selecting applications
Your Smartphone is equipped with a variety of applications. All the 
applications installed on your Smartphone appear in the Applications 
Launcher. 

In addition to providing a way for you to open applications, the 
Applications Launcher displays the current time, battery level, and 
application category. 

To open an application:
Choose from the following options:

• Tap the Home icon, and then tap the icon of the application you 
want to open. If you have many applications installed on your 
Smartphone, tap the scroll bar to see all the available applications. 
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• Press an application button on the front panel to display the selected 
application immediately. 

• Press the volume -/+ buttons on the left side panel of the unit to go 
to show application shortcuts. Press volume + for Group 1 
shortcuts, press volume - for Group 2 shortcuts. For details of using 
applications shortcuts, see “Using the Shortcut” in Chapter 11, 
“Working with Utility applications”.

• To switch between applications, tap the Home icon or press an 
application button on the front panel of your Smartphone. Your 
Smartphone automatically saves your work in the current 
application and displays it when you return to that application.

Categorizing applications
The category feature enables you to manage the number of application 
icons that appear onscreen in the Applications Launcher. You can assign an 
application to a category and then display a single category or all your 
applications. 

To categorize an application: 
1. Tap the Home icon on the front panel of your device. 

2. Tap the Menu icon. 

3. From the App menu, tap Category. 

4. Choose from the following options: 

• To choose a category for an application, tap the pick list next to 
each application.

• To create a new category for an application, tap Edit Categories 
from the application’s pick list. Tap New, enter the category name, 
and then tap OK to add the category. Tap OK.

5. Tap Done.

To display applications by category: 
1. Tap the Home icon. 

2. Do one of the following:

• Tap the Home icon repeatedly to cycle through all the categories.
• Tap the pick list in the upper right corner of the screen, then tap the 

category you want to display.
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Changing the Applications Launcher display
By default, the Applications Launcher displays applications as icons. As an 
alternative, you can display applications in a list format. 

To change the view of applications: 
1. Tap the Home icon; then tap the Menu icon. 

2. From the Options menu, tap Preferences. 

3. From the View By option tap List; then tap OK to see your 
applications in list format. 

In addition to displaying applications by icon or list, you can set an option 
to display the last-selected category of applications each time you open the 
Applications Launcher. 

To display the last-selected category of applications:
1. Tap the Home icon; then tap the Menu icon. 

2. From the Options menu, tap Preferences. 

3. In the Preferences dialog box, tap Remember Last Category.

4. Tap OK. Each time you return to the Applications Launcher, the last 
category of applications you selected is displayed. 

NOTE: If you do not select the Remember Last Category option, 
all applications are displayed when you select the Applications 
Launcher. 

Select Icon and tap OK
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Setting preferences for applications
You can set preferences for individual applications in the Preferences 
dialog box. Not all applications have preference settings. 

To set preferences for an application: 
1. Open an application. For instructions, see “Selecting applications” in 

this chapter.

2. Tap the Menu icon. 

3. From the Options menu, select Preferences.

4. Enter the desired preference settings; then tap OK.

Assigning applications to buttons
Buttons preferences let you assign different applications to the buttons on 
the front panel of the Smartphone. For example, if you find that you 
seldom use the Camera and often use Email, you can assign the Camera 
button to start the Email application.

You can also change whether the full-screen pen stroke activates the 
Graffiti® 2 Help application or one of your Smartphone controls using 
Buttons preferences.

If you assign a different application to a button, you can still select the 
original application using the Applications Launcher. Changes made in the 
Buttons Preferences screen or HotSync Buttons dialog box take effect 
immediately. 

Full-screen pen stroke: draw a line 
from the Graffiti area to the top of the 
screen 
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To change the Buttons preferences:
1. Tap the Home icon.

2. Select All or System from the pick list in the upper right corner.

3. Select Prefs from the menu.

4. From the pick list in the upper right corner, tap Buttons.

5. In the Buttons Preferences screen, tap the pick list next to the button 
you want to re-assign.

6. Tap the application that you want to assign to the button.

TIP: To restore all of the buttons to their factory settings, tap 
Default.

To change what the full-screen pen stroke activates:
1. Tap the Home icon.

2. Select All or System from the pick list in the upper right corner.

3. Select Prefs from the menu.

4. In the pick list in the upper right corner, tap Buttons.

5. In the Buttons Preferences screen, tap Pen.

Tap this triangle 
button to show 
the pick list.
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6. Tap the pick list, and tap one of the following settings for the full-
screen pen stroke:

• Brightness calls out the Brightness adjusting scale.
• Keyboard opens the onscreen keyboard for entering text characters.
• Graffiti 2 Help opens a series of screens that show the complete 

Graffiti 2 character set.
• Turn Off & Lock turns off and locks the Smartphone. You must 

assign a password to lock the Smartphone. When locked, you need 
to enter the password to use your Smartphone.

• Beam Data beams the current record to another PDA Smartphone.
7. Tap OK.

Installing add-on applications
In addition to the applications that came with your Smartphone, you can 
install applications (called add-on applications) using the Install Tool 
during a HotSync® operation. A variety of third-party applications are 
available for your device, such as games and other software, from the 
internet. 

Add-on applications reside in RAM memory and can be removed at any 
time; for information, see “Removing applications” later in this chapter.

Installing games
In addition, you can install games included on the CD using the 
Smartphone Install Tool. These games include:

• Giraffe (a fun and simple way to practice Graffiti 2 writing)
• HardBall
• MineHunt
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• Puzzle 
• SubHunt

After you install and start a game, its instructions appear in the Game 
menu. Depending on the game, the Game menu may also contain 
commands to show high scores, start a new game, or set preferences for the 
game.

To install add-on applications on your Smartphone:
1. From your computer desktop, copy or download the applications you 

want to install into the add-on folder in your Smartphone directory.

2. If the application is compressed, for example, as a zip file, decompress 
the application into the add-on folder before continuing.

3. Double-click the Smartphone icon on your computer desktop to open 
it, then click Install. 

TIP: You can also select the Install Tool dialog box by selecting 
Install Tool from the Smartphone program group or by double-
clicking any file with a PRC file extension.
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4. In the User drop-down list, select the user name that corresponds to 
your Smartphone; then click Add. 

5. In the file list of the Add-on folder, select the application that you want 
to install on your Smartphone; then click Open. The file appears in the 
Palm Install Tool dialog box. 

6. If decide not to install an application, select it in the list of files in the 
Palm Install Tool dialog box and click Remove. The application is 
removed from the dialog box list, but not from your computer. 

7. Click Done. A message appears to indicate that the application or 
applications will be installed the next time you perform a HotSync 
operation. 

8. Perform a HotSync operation to install the applications. See Chapter 
11, “Exchanging and Updating Data using HotSync Operations” for 
more information.

Removing applications
You can remove add-on applications, patches, and extensions from your 
Smartphone if you run out of memory or no longer need them.

You cannot remove the built-in applications that reside in the ROM portion 
of your device, including the Date Book, Address Book, To Do List, Memo 
Pad, Calculator, and Mail applications.
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To remove an add-on application: 
1. Tap the Home icon; then tap the Menu icon. 

2. Tap Delete.

3. In the Delete dialog box, tap the application you want to remove. 

4. Tap Delete.

5. Tap Yes.

6. Tap Done.

Removing Smartphone 
If you no longer want to use Smartphone, you can remove it from your 
computer. 

To remove Smartphone: 
1. In Windows, from the Start menu, choose Settings > Control Panel.

2. Open the Add/Remove Programs icon. 

3. On the Install/Uninstall tab, select Smartphone; then click Add/
Remove. 

NOTE: You must retain the HotSync Manager from the CD for 
installation to synchronize data with another PIM.
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7
Working with 
Communication 
Applications
Your Smartphone includes the following communication applications:

• SMS
• jMMS
• EMailer
• WAP Browser
• STK
• Ringtone Profile
• Melody Manager

Sending and Receiving Text Messages (SMS)
The Short Message Service (SMS) allows you to send and receive text 
messages consisting of up to 160 English characters. 

• Messages can be classified in different categories.
• You can send text messages to a group which you have defined in 

your phone book.

To open the SMS
1. Tap the Home icon .

2. Select Communication from the pick list in the upper right corner.
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3. Tap the SMS icon .

SMS setting
In the main screen, which lists out Inbox messages by default, tap the 
Menu icon, and select Setting from the Tools pull-down menu to enter the 
setting interface.

• Warn Over: You’ll get a warning if the content of the outgoing 
message exceeds 1 or more parts (customizable). Tap the pick list 
the specify the number.

• Expires: Set a period of time for which the message can be retained 
in the message folder before you send it out. Tap the pick list to 
specify the period.

• Message Center

Tap the SMS icon to enter 
the index screen of SMS

Tap Delete to delete 
the selected message.

Call the sender (if in Inbox) 
or recipient (if in Outbox) of 
the selected message.

Compose a new text message.

Total messages
Unread message(s)

Folder pick list

Unread

Read
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– Auto: Before sending text messages, you must input the number 
of the message service centre, which you can get from your 
service provider. If your SIM card contains the number to the 
service centre, it can be recognized once the SIM card is 
inserted. 

– Custom: If your SIM card does not contain the number to the 
message service centre, you must specify the number yourself.

Composing & sending text messages
1. In the main screen, tap the New button to enter the editing interface.

2. Input the number and message contents. When finished tap Send 
button on the bottom of the screen to send the message.

Reading, replying & forwarding SMS
When a text message arrives, an envelope-like indicator will appear in the 
status bar on the top of the screen. Tap the indicator to skip to the list screen 
of SMS. 

Input recipient’s number here

Tap this to send the message

If you don't want to send the message now, 
tap this to save the message to Draft box

Return to previous interface

Indicating the characters you’ve entered.

Tap this to skip to Address Book and import 
phone numbers from Address Book.

Input content here
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While reading a message, you can save the information of the sender to 
Address Book as a new record, or dial the phone number of the sender:

1. In view screen, tap the Menu icon.

2. Select Save Number from the Options pull-down menu to save the 
number to Address Book as a new record, or select Dial to dial the 
phone number of the sender.

Deleting messages
1. In index screen or view screen, select the message you want to delete.

2. Tap the Delete button on the bottom of the screen, then a dialog box 
appears.

3. Tap OK to delete the selected message, or tap Delete All to empty the 
folder you’re currently checking.

Tap a message to read

Reply to the sender

Forward the current 
message to other people

Return to index screen

After inputting 
necessary 
information, tap 
OK to save to 
Address Book as a 
new record.
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If messages are deleted from Trash box, they are permanently removed. Or 
you can use the command “Empty Trash” to clear all deleted messages in 
Trash box at a time:

1. In index screen, tap the Menu icon.

2. Select Empty Trash from the Message pull-down menu.

Using jMMS (Multimedia Messages)
A multimedia message can contain a combination of text, images and 
sound clips. 

NOTE: This function can be used only if it is supported by your 
network operator or service provider. Only devices that offer 
compatible multimedia message or email features can receive 
and display multimedia messages. Devices that don’t have these 
features may receive details of a link to a web page. 

To open the jMMS application

1. Tap the Home icon .

2. Select Communication from the pick list in the upper right corner.

3. Tap the jMMS icon .

The selected message 
will be move to Trash 
box if you tap OK.

Tap Delete All to empty 
the folder you’re 
currently checking.
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Settings needed for multimedia messaging
Multimedia messaging requires GPRS connection, so you need to 
configure the GPRS connection properly in advance.

1. Tap the Home icon .

2. Select System from the pick list in the upper right corner.

3. Tap the Prefs icon.

4. Select Network from the pick list in the upper right corner.

After setting GPRS, return to jMMS. Before sending and receiving 
multimedia messages, select a configuration profile:

1. In the index screen of jMMS, tap the Menu icon.

2. Select Profiles from the Tools pull-down menu.

3. Select a profile from the MMS Profile pick list.

If you’re not sure whether the selected profile suits you, tap Edit to view its 
detailed information and make necessary changes:

Find your service 
provider from the 
Service pick list

For configuration 
details, please 
inquire your 
service provider.

Tap Details for 
further adjustment.

MMS Profile 
pick list

Tap Edit to 
customize the 
selected profile.
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Composing multimedia messages
1. In the index screen, tap the New icon  to enter editing screen.

2. Input the recipient’s phone number and message content.

3. Tap  to insert a picture, tap  to insert a sound clip.

4. When done, tap the Send icon  to enter recipients’ phone numbers, 
and tap  to send out the multimedia message.

Adding pictures to multimedia messages
1. In the editing screen, tap  to list out all the available photos in the 

"MMSPictures" album.

For details of 
configuring 
MMS Profile, 
please contact 
your service 
provider.

Folder pick list
Tap this to write a new 
message

Delete the selected message

Move the selected 
message to another 
folder

Sort messages

Write your message here

Delete the current page

Insert a page

PreviewInsert a sound clip

Insert a picture

Enter recipients' 
phone numbers
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2. Tap a photo view its enlarged version, tap again to resume to normal 
size.

3. When found the desired one, tap  to attach the selected photo to the 
message you’re writing.

If you can’t find any suitable photo in the MMSPictures album, you can 
draw your own one or modify any existing photo with an application called 
Doodles:

1. In the index screen of MMSPictures album, tap  to draw a new 
picture with Doodles or tap  to modify a selected photo.

2. When finished, tap  to save. 

3. Tap  to return to the index screen of MMSPictures album.

Check photo 
details

Delete the 
selected photo

Tap a photo to 
view its enlarged 
version

Tap this to 
insert a photo

Tap this to 
confirm insertion
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Adding sound clips to multimedia messages 
1. While composing a message, tap  to skip to the index screen of 

Tunes.

2. Select a sound clip and tap  to preview.

3. When found the desired one, tap  to attach the selected sound clip to 
the message.

Tap this to 
draw a new 
picture

Modify a selected 
photo

Line thickness (3 levels)

Tap this 
to call 
out the 
hidden 
tools

Undo

Selection box
Color picker
Straight line
Circle
Square
Solid circle
Solid square
Freehand
Text
Eraser

Tap the Menu icon to show the 
Pict pull-down menu

Clear the screen

Tap Color for color picker

Selected color will be 
shown on the background
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Final preview and sending out messages
If you are not satisfied with the picture or the sound clip, tap on the picture 
or the sound clip, a popup menu appears, tap Delete to remove the picture 
or the sound clip from the current message. Finally, you can preview the 
message as a whole by tapping the preview icon .

Now you can add recipients’ numbers if there’s no problem:

Play the 
selected clip
Stop
Check details 
of the selected 
clip
Delete the 
selected clip 
from Tunes 
library

Apply

Tap this to 
preview the 
message

Tap this to 
return

Stop the 
playing 
sound clip

Check 
details of 
the message

Tap these 
buttons to 
import phone 
numbers from 
Address Book

Or input 
phone 
numbers 
here 
directly

Tap this to 
return

Send out the message

Profile setting (please refer to the first section)

Tap this to add 
phone numbers
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Before sending out the message, you can set the priority level, valid period 
etc. for the message, to do so:

1. In the screen of adding recipients' phone numbers, tap  to show the 
Options screen.

2. Configure the options according to your needs. Then tap OK to finish.

Defining the method to download messages
Before receiving multimedia messages, you need to define the way the 
Smartphone to download multimedia messages:

1. In the index screen of jMMS, tap the Menu icon and select 
Configuration from the View pull-down menu.

2. Select Manual, Automatic or Custom from the Download pick list

Tap this to show 
Options screen

Tap OK to return

Tap this to send out the message right away

Select a download 
method from the 
pick list
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If Custom is selected:

3. Tap OK to save the configuration, tap Cancel to quit without making 
any changes.

Reading, replying and forwarding multimedia 
messages
To read a downloaded multimedia message:

1. In index screen, tap a message.

2. Select View from the popup menu.

To extract the image or the sound clip from the message:
1. While reading the message, tap the Menu icon.

Restrict the message size

Only download specified class, like 
Personal or Advertisement
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2. Tap Image or Sound from the Save pull-down menu to save the image 
to your PhotoAlbum or save the sound clip to your MelodyManager.

To reply to the sender:

1. While reading a message, tap  to reply to the sender or tap  to 
reply all.

To forward the current message to other recipients:

1. While reading a message, tap  to forward the current message to 
other recipients.

Using the EMailer
The EMailer application lets you manage, on your Smartphone, the e-mail 
you send and receive through the phone or through your desktop 
computer's e-mail application. You can read, reply to, compose, and delete 
e-mail on your Smartphone.

NOTE: Only if it is supported by your network operator or 
service provider, you can send and receive email items via your 
Smartphone. 

Setting up the EMailer application on the 
desktop
Before you use the EMailer application for the first time, make sure that 
your desktop e-mail application is installed and running. You must also set 
up Palm Desktop for use with your desktop e-mail application. 

Your Smartphone supports various desktop e-mail applications, including 
Microsoft Exchange (version 4.0 or higher), Eudora (version 3.0.3 or 
higher), Microsoft Outlook 97 (or higher), Microsoft Outlook Express, 
Netscape Communicator 4.5 and Lotus cc: Mail (versions 6.0 or higher). 
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You can view the full list of the supported applications when you set up 
EMailer.

If your desktop e-mail application does not appear on the list, you may still 
be able to manage your desktop e-mail application from your Smartphone 
using special connection software, called a conduit, that lets you 
synchronize your desktop e-mail application and your Smartphone. 
Contact the vendor of your e-mail application for more information.

Setting up the EMailer application and Hot 
Sync options
The following instructions assume that you have installed Palm Desktop on 
your computer, but have not yet set up EMailer. 

To set up EMailer:

1. Choose one of the following options:

• If you have not yet installed Palm Desktop on your computer, 
install the software now. You will be prompted to set up EMailer as 
part of the Palm Desktop installation.

• If you already installed Palm Desktop on your computer, and set up 
EMailer, skip to the next procedure, to set up the HotSync options 
for EMailer.

2. In the Windows task bar, click Start.

3. Select Programs, select Palm Desktop, and then click EMailWiz Setup 
to begin the setup.

4. Follow the instructions onscreen to set up your Smartphone for use 
with your desktop e-mail application.

To set or change HotSync options for synchronizing the EMailer 
application:

1. In the bottom right corner of the Windows taskbar (in the system 
tray), click the HotSync icon. If the HotSync icon does not appear on 
the taskbar, select Programs from the Start menu. Then select 
HotSync Manager from the Palm Desktop menu.

2. Choose Custom.
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TIP: You can also choose Custom from the HotSync menu in 
Palm Desktop.

3. Choose Mail from the list box.

4. Click Change.

5. Select one of the following options:

• Click Synchronize the Files to synchronize the mail on your 
Smartphone and your desktop e-mail application.

• Click Desktop Overwrites Handheld to replace the mail on your 
Smartphone with the mail in your desktop e-mail application. Only 
use this option if the two inboxes get out of sync for some reason. 
This setting applies to only one HotSync operation and then reverts 
to the default.

• Click Do Nothing to turn off communication between your 
Smartphone and desktop e-mail application. This setting applies to 
only one HotSync operation and then reverts to the default.

• Click Set As Default to change the default setting for all HotSync 
operations. (When you first set up EMailer, Synchronize the Files is 
the default setting.)

• To turn off the EMailer application, select Do Nothing and then 
select the Set As Default check box.

6. Click OK. 

Synchronizing EMailer with your e-mail 
application
After you turn on and set up EMailer, you can synchronize EMailer with 
your desktop e-mail application. 

For complete information on using HotSync, see Chapter 12, “Exchanging 
and Updating Data Using HotSync Operations”.

Viewing and e-mail items
The first time you open the EMailer application, it displays the Mail list. 
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To open the EMailer application on your Smartphone:
1. Tap the Home icon on the front of your Smartphone.

2. Select Communication from the pick list in the upper right corner of 
the screen.

3. Tap the EMailer icon.

The Mail list displays your incoming e-mail items, who sent them, and the 
date they were received. An opened envelope icon indicates any e-mail 
items that you've read. An exclamatory mark indicates any high-priority e-
mail item.

To view e-mail items:
1. Tap an item in the Mail list to display it in view screen. 

By default, the EMailer application shows only the From and Subject 
fields. You can display complete information about the sender, receiver, 
and copied recipients, as well as the subject and the date the e-mail item 
was created. 

Total items Unread items

Previously read
Sender
Subject
Received date
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2. To change the display of header information, tap a header mode icon 
in the upper right corner of the screen:

• Tap the Complete Header icon to view complete information about 
the sender, receiver, and copied recipients, in addition to the subject 
and date the e-mail item was created. 

• Tap the Abbreviated Header icon to redisplay the abbreviated 
header. 

EMailer uses the header type you select for all your e-mail items.

3. To close an e-mail item, tap Done.

Categorizing and sorting e-mail items
You can display e-mail items by the folders your Smartphone provides for 
categorizing mail, and according to the e-mail date. 

You can also sort e-mail items by the date sent, by sender, or by subject. No 
matter how you sort the list, high-priority e-mail items always appear first.

To select an e-mail folder to display:
1. In index screen, tap the pick list in the upper right corner or your 

screen to display a list of folders.

2. Tap a folder to choose one of the following options:

• Inbox contains e-mail items received from your desktop e-mail 
application Inbox, except any excluded using filtering options. See 
“Creating special filters” later in this chapter.

Header mode icons
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• Outbox contains e-mail items to be sent on the Smartphone since 
the last HotSync operation.

• Deleted contains any e-mail you deleted since the last HotSync 
operation.

• Sent contains e-mail items that you sent since the last HotSync 
operation.

• Draft contains the e-mail you've created using the Smartphone but 
are not yet ready to send.

3. To change the folder displayed, repeat steps 1 and 2 to choose another 
folder. 

To hide the Date column in e-mail items:
The Date column is shown in the Mail list by default, you can hide it to 
increase the available screen space. 

1. In index screen, tap the Menu icon.

2. Select Show As from the Options pull-down menu to display Show 
Options window.

Folder pick list
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3. In Show Options window, tap the Show Date check box to deselect it. 

4. Tap OK.

To sort the Message List:
1. In the Show Options screen, tap the Sort By pick list and tap one of the 

following options to select it:

• Date sorts e-mail by date and displays the most recent e-mail item 
at the top of the screen.

• Sender sorts e-mail by the sender's user name and displays items in 
ascending alphabetical order, based on the first word of the From 
field.

• Subject sorts e-mail by the subject and displays items in ascending 
alphabetical order, based on the first word of the Subject field.

2. Tap OK.

Account setting
Before using your phone to send and receive e-mail, you need to setup an 
e-mail account first.

1. In index screen, tap the Menu icon.

2. Select Account Setting from the Options pull-down menu.

3. Select your e-mail service provider from the Mailbox pick list:

• Select your service provider and tap Detail to show Details screen. 
In Details screen, you can see all the settings are preset, you only 
need to complete your e-mail address.
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• If your service provider is not in the list, you can select any empty 
profile titled Profile6, Profile7 or Profile8, and then tap Details to 
enter your email address, and specify the SMTP Server and POP3 
Server (provided by your e-mail service provider).

4. Enter your user name and password.

• If you enter your password, you’ll login to the server without being 
prompted for a password.

• If you leave it blank, you’ll be prompted for a password every time 
you send or receive e-mail.

5. Select a connection service (your network operator) from the Service 
pick list.

6. When finished, tap Back.

Setting mail preferences
You can set preferences to prompt you before deleting mail:

1. Tap the Menu icon. 

2. Tap Options, and then tap Preferences. 

3. Tap Confirm Deleted Message to display a prompt before the mail is 
deleted.

Mailbox pick list

User name of 
your e-mail 
account
Password of 
your e-mail 
account
Service pick list

Tap Detail to view details 
of the select profile

Complete 
your e-mail 
address here

• POP3 login first: when connected, 
log in POP3 Server first

• Keep mails on server: it means that you 
leave your mails in the server and what 
you receive using the EMailer 
application is just the COPY of the 
original mails.
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You can also create a signature for your e-mail item in the Preferences 
screen:

1. Tap the signature field and enter the text of your signature.

Creating e-mail items
You create e-mail items with your Smartphone the same way you create e-
mail with your desktop e-mail application: you identify the recipient of the 
e-mail item, define a subject, and create the body of the e-mail item. At a 
minimum, all e-mail items must contain information in the To and Subject 
fields.

You create original e-mail items and replies in the New Message screen. 

To create an e-mail item:
1. Tap New.

Check this option to 
prompt you before 
deleting any mail

Enter the text of your 
signature here

Tap this to apply

Tap this to cancelTap this to cancel
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2. Enter the e-mail address of the recipient.

3. To send a copy of the e-mail item to additional recipients, tap the CC 
field, and enter the e-mail addresses of the additional recipients, 
separating the addresses with a comma followed by a space.

4. Tap the Subject (Subj:) field and enter a subject for your e-mail item. 

5. Tap the Body field and enter the text of your e-mail item.

TIP: If the address, CC, subject, or body exceeds the capacity 
of the screen display, tap the name of the field (for example, tap 
“To:”) to expand that field. Tap Done to return to the New 
Message screen.

Looking up an address
To identify the recipient of an e-mail item, you must enter that person's e-
mail address. You can either enter the data directly in the To or CC field, or 
use the Look Up command to access the information in your Address 
Book. 

To look up an e-mail address:
1. In the New Message screen, tap either the To or CC field name to 

expand it.

2. Choose from the following options:

• Tap Lookup to display the Lookup dialog box. The Lookup screen 
lists all records that contain information in an e-mail field.

Tap the name of 
the field to open 
it.
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• Enter the first few letters of the last name of the person whose 
address you want to find, and tap Lookup. If your Smartphone 
completes the desired address for you, tap Done to return to the 
New Message screen.

TIP: You can also display the Lookup dialog box from the New 
Message, To or CC screens by tapping the Menu icon on the front 
of your Smartphone; then tap Options and tap Lookup. Or use the 
Graffiti 2 Command stroke /L. 

3. In the Lookup dialog box, enter the first letter of the entry you want, to 
scroll to the first entry that begins with that letter. Enter additional 
letters to have the list scroll to the first entry that starts with those 
letters. 

4. Tap an address to select it. Tap Add. 

5. Tap Done to return to the New Message screen.

Adding details to e-mail items
Before you send your e-mail items, you can add additional information to 
the message. For example, you can specify the message's priority, create a 
blind carbon copy, add a signature, or confirm that the message was 
delivered or read. 

To add details to an e-mail item:
1. In the New Message screen, tap Details.

Tap this to
switch to the

contacts stored
in SIM card.



Working with Communication
Applications
Using the EMailer

Smartphone User’s Manual 101
   

This is the internet version of the User Manual.Print only for private use.

2. Choose from the following options:

• Tap Priority, and select a ranking for the e-mail item from the 
Priority pick list. Choices are High, Normal, or Low priority. The 
Priority setting must be set for each e-mail item you create.

• Tap the BCC check box to create a blind carbon copy. The BCC 
option must be set for each e-mail item.

• Tap the Signature check box to select it and add your signature to 
all subsequently created e-mail items until you deselect this option. 
The signature is visible only to the e-mail recipient, and does not 
appear in your e-mail item. See “Creating a signature for your e-
mail item” for information on defining a signature.

• Tap Confirm Read to have your device return a confirmation that 
the e-mail item was read.

• Tap Confirm Delivery to have your device return a confirmation 
that the e-mail item was delivered.
Tap  to save changes.

3. If the BCC option is selected, BCC field will be shown as below. For 
information on looking up an address, See “Looking up an address”.
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Replying to e-mail items
To reply to an e-mail item:

1. Tap an e-mail item in the Message List to display it onscreen.

2. Tap Reply.

a. In the Reply Options dialog box, tap a Reply To option to 
select who should receive the reply, the sender only or all 
recipients; or tap Forward to reply to someone who didn't 
see the original e-mail item.

b. Tap Include Original Text to include the original e-mail 
message in the reply. Clearing the option creates a blank 
reply. 

c. If you selected Include Original Text, tap Comment Original 
Text to let you edit the original text. 

d. Tap .
3. Enter the text of your reply.

4. If you are forwarding the message, enter a recipient in the To field.

5. Tap Outbox to place your reply in the Outbox. See “Storing and 
editing e-mail items” for more information.

Tap Reply to show the 
Reply Options dialog box

Tap this to enter text of 
your reply
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The e-mail items you create are stored in your Smartphone's Outbox folder 
until you perform a HotSync operation to synchronize your device with 
your computer. For more information on performing a HotSync operation, 
See Chapter 11.

Storing and editing e-mail items
Before sending an e-mail item from your device, you can store it in the 
Outbox folder. You can edit unsent e-mail as long as you have not yet 
performed a HotSync operation or sent them out. 

You can also draft e-mail items and store them until you're ready to send 
them, and you can file e-mail items. 

During synchronization, your Smartphone transfers e-mail items stored in 
the Outbox folder to your desktop e-mail application. The next time you 
send mail from this desktop application, it sends the mail created on your 
Smartphone.

For instructions on synchronizing your device, see “Synchronizing 
EMailer with your e-mail application.”

To store an e-mail item in the Outbox folder:
1. Create a new e-mail item or reply to an item. (See “Creating e-mail 

items.”) 

2. Then tap Outbox. 

To save an e-mail item as a draft:
1. Create a new e-mail item or reply to an item. 

2. Choose from the following options:

• Tap the Menu icon on the front of your Smartphone. Tap Message, 
and then tap Save Draft.

• In the New Message screen, tap Cancel, and then tap Yes at the 
prompt.

To edit an unsent e-mail item:
1. In the Mail list, tap Outbox or Draft in the pick list in the upper right 

corner of the screen.

2. Tap the e-mail item you want to retrieve.

3. Tap Edit. Change the e-mail item as desired.
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4. Choose from the following options:

• To store the e-mail item in the Outbox, tap Outbox.
• To store the e-mail item in the Draft folder, tap Cancel and tap Yes 

when prompted.
• To abort, tap Cancel and tap No when prompted.

Deleting e-mail items
When you delete an e-mail item, your Smartphone stores it in the Deleted 
folder until you purge the folder's contents or perform the next HotSync 
operation. You can purge the contents of the Deleted folder to avoid having 
deleted e-mail monopolize your Smartphone's storage space. 
Synchronization deletes the e-mail item, as well as purged items, from your 
desktop e-mail application.

You can restore a deleted e-mail item by removing it from the Deleted 
folder, if you haven't purged the folder contents or performed a HotSync 
operation.

To delete e-mail:
1. In the Mail list, tap the e-mail you want to delete to open.

2. Tap Delete. 

3. If prompted, tap Yes. 

To restore an e-mail item by moving it out of the Deleted folder:
1. In the Mail list, tap Deleted from the pick list in the upper right corner 

of the screen.

2. Tap the e-mail item you want to restore. 

3. Choose from the following options:

• If you created the e-mail item that you deleted, tap Edit to display 
and modify the item. You can send the item or save it as a draft.

• If you received the e-mail item that you deleted, tap Undelete to 
move the selected item to the Inbox and mark it as Read.

To purge the contents of the Deleted folder:
1. Tap the Menu icon. 

2. Tap Message, and then tap Purge Deleted.
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3. Tap Yes. 

NOTE: You cannot restore e-mail items after you purge them.

To display a prompt before e-mail is deleted: 
1. In the Mail list or in a view screen, tap the Menu icon on the front of 

your device.

2. Tap Options, and then Tap Preferences.

3. To display a prompt, tap the Confirm Deleted Message screen. To 
delete a message without a prompt, clear the check box.

Sending and Receiving e-mail items
By using your Smartphone, you can send and receive e-mail items directly. 

To send e-mail items:
1. In the Mail List, tap the Menu icon on the front of your device.

2. Choose one of the following options:

• Tap Message, and then tap Send All to send all the items stored in 
Outbox.

• Tap Message, and then tap Receive & Send.

To receive e-mail items:
1. In the Mail List, tap Receive.

2. In the Mail List, tap the Menu icon on the front of your device, and 
then choose one of the following options:

• Tap Receive
• Tap Receive & Send.

Managing your e-mail application with HotSync
You can manage your e-mail application more effectively by selecting 
HotSync options to control which e-mail items download when you 
synchronize your Smartphone and your computer. You can define different 
settings for local and remote synchronization. 
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For example, you may want to download all of your e-mail items when 
you're working at the office and synchronizing your devices locally, but 
only urgent e-mail items when you're away from your office and 
synchronizing your devices remotely. Once your local and remote options 
have been defined, your Smartphone determines if synchronization is 
occurring locally or remotely and uses the appropriate settings for the 
HotSync operation.

You can filter messages to control which ones are downloaded, and you can 
set truncation options to download only part of lengthy e-mail items.

Downloading transmits only e-mail items and any text information, not 
attachments, to your Smartphone. Downloaded attachments are left in your 
desktop e-mail application. 

To set HotSync Options to control synchronizing e-mail items:
1. In the Mail List, tap the Menu icon.

2. Tap Options, and then tap HotSync Options.

3. Tap the Settings For pick list, and select Local HotSync or Remote 
HotSync.

Note: For more information about Local and Remote HotSync operations, 
see Chapter 12.

4. Tap the filtering option you want to apply during synchronization:

• All to download all e-mail items in your desktop Inbox to your 
Smartphone, and to send all e-mail items in your Smartphone 
Outbox to your desktop e-mail application.
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• Send Only to send only the e-mail items in your Smartphone 
Outbox to your desktop e-mail application; from there, the 
application sends the items to their destinations.

• Filter to download all e-mail items in your desktop Inbox that meet 
specific criteria to your Smartphone, and to send e-mail items that 
meet specific criteria from your Smartphone Outbox to your 
desktop application. When you select the Filter setting, the 
HotSync Options dialog box opens and displays additional filter 
settings. See “Creating special filters” later in this chapter.

• Unread to download only unread e-mail items from your desktop 
Inbox to your Smartphone, and all items in your Smartphone 
Outbox to your desktop e-mail application.

5. Choose from the following options:

• If you selected All, Send Only, or Unread, tap OK. 
• If you selected Filter, continue to the next section.

Using filters to control downloading
You can create special filters to control the type of e-mail items that 
download to your Smartphone during synchronization. Special filters 
ignore or retrieve items that contain specific information in their header 
fields, according to what you've instructed your Smartphone to look for in 
the To, From, and Subject fields. 

To access the special filter settings:
1. In the HotSync Options dialog box, tap Filter.

2. If your e-mail application can flag high-priority items, tap Retrieve All 
High-Priority items to retrieve these items and override any filter 
settings.

3. Tap the pick list in the center of the HotSync Options dialog box, and 
choose whether to ignore or retrieve e-mail items based on the 
matching information:
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• Tap Ignore Messages Containing to have your Smartphone exclude 
e-mail items that meet the defined criteria and download all other e-
mail items during synchronization. In general, this filter downloads 
more e-mail during synchronization because it blocks only one 
defined subset of e-mail.

• Tap Retrieve Only Msgs Containing to have your Smartphone 
include only the e-mail items that meet the defined criteria and 
ignore all other e-mail items during synchronization. This filter can 
block more e-mail during synchronization because it downloads 
only one subset of e-mail.

• Enter a filter string in the To, From, and Subject fields. For 
information on creating filter strings, see “Defining filter strings” 
later in this chapter.

• Tap  (Truncate) to stop long e-mail items from downloading, 
and then specify a number of characters, between 250 and 8,000 

(the default is 4,000.) When done, tap  to save truncate setting.
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NOTE: A lower value reduces the time to synchronize your 
desktop e-mail and EMailer and the e-mail storage space that 
your Smartphone needs. Messages longer than 8,000 characters 
will be truncated.

4. Tap .

Defining filter strings
Your Smartphone filters e-mail items based on information in their To, 
From, and Subject fields, called a filter string. You create a filter string by 
listing the words you want your Smartphone to find and separating them by 
either a comma or a space. Each word in the filter string is joined by an 
implicit OR; your Smartphone adds the logical connectors like AND or 
OR.

To create a more complex filter, you can define filter strings for the To, 
From, and Subject fields. Your Smartphone joins the filter strings for these 
fields using an implicit AND, and adds the logical connector for you.

For example, you might want to receive only e-mail items from John Smith 
(jsmith@aol.com) or Jack Jones (jjones@aol.com) concerning the Apollo 
Project. You would create the following filter strings:

• In the To field: jsmith@aol.com, jjones@aol.com
• In the Subject field: Apollo Project

Your Smartphone interprets this as, “Accept e-mail items about the Apollo 
Project from John Smith or Jack Jones. Do not accept e-mail items from 
other people. Do not accept e-mail items from John or Jack about any other 
subject.”

When you define a string, your Smartphone searches for any instance of 
that sequence of characters. For example, if you define a filter that retrieves 
only e-mail items with the string “info” appropriate matches would include 
“info”, “rainforest” and “kinfolk.” 
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To define a filter string:
1. Tap the To, From, or Subject header field in the HotSync Options 

dialog box. 

2. Enter your filter string, using commas or spaces to separate the words. 
Do not add connectors, such as AND or OR, between words in a string.

3. If your string exceeds the length of the field, tap the name of the field 
to display the Notes screen for that header field. See “Creating e-mail 
items” earlier in this chapter.

4. Tap OK to return to the HotSync Options dialog box.

5. Tap .

Tap here to insert cursor 
and enter your filter strings

Tap here to show 
Note screen.

Enter filter data here

Tap OK to return to 
HotSync Options
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Surfing WAP sites with jBrowser
jBrowser is a complete implementation of a WAP browser. It brings you 
the connectivity to the wireless internet, yet as safe and easy as your 
desktop web browser. 

jBrowser is easy to use because it works much like the web browser you 
use on your desktop computer. You can enter WAP addresses, create 
bookmarks to mark favorites pages.

jBrowser uses advanced encryption technology called WTLS (Wireless 
Transport Layer Security). Encryption makes your data unreadable but the 
intended recipient. WTLS component allows jBrowser to be used for m-
commerce transactions. 

You can create multiple access profiles, each containing information about 
the gateway, port number and homepage. You can activate any desired 
profile from the list.

NOTE: This function can be used only if it is supported by your 
network operator or service provider. 

Opening jBrowser
1. Tap the Home icon and select Communication from the pick list in the 

upper right corner.

2. Tap jBrowser.

When you start jBrowser for the first time, the following screen appears:

Tool bar
Address bar

Web content
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The jBrowser screen has three parts:

• The toolbar provides different action icons to let you navigate in the 
browser, refresh pages and look at your favorite pages. You can 
show/hide the toolbar by following steps below:
a. In the main screen of jBrowser, tap the Menu on the front of 

your device.
b. Select Show/Hide Toolbar from the View pull-down menu to 

show or hide the toolbar.
• The address bar lets you input the WAP address and connect to it 

directly. You can show/hide the toolbar by following steps below:
a. In the main screen of jBrowser, tap the Menu on the front of 

your device.
b. Select Show/Hide Addressbar from the View pull-down menu 

to show or hide the addressbar.
• The rest of the screen is devoted to displaying the content of the 

WAP page.

Setting access profiles
You can create multiple access profiles, each containing information about 
the gateway, port number and homepage. Or select a access profile in the 
name of your network operator from the pick list.

To set your access profile:
1. In the main screen, tap the Menu icon.

2. Select Settings from the Tools pull-down menu.

Select your 
profile here
Configure the 
selected profile
Selected profile 
will be shown here

According to the 
profile selected 
below, the network 
which the selected 
profile uses will be 
automatically applied
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3. Tap Edit to configure the selected profile.

• Homepage: Enter the URL of WML page that you wish to have as 
your homepage.

• Gateway/IP Address/Port: Please inquire your service provider.
• Mode: Select ConnectionLess or ConnectionOriented. Selecting 

ConnectionLess enables temporary data communication, while 
ConnectionOriented is of continuous data communication.

NOTE: Port number should be 9201 for Connection Oriented 
connection and 9200 for Connection Less connection. If WTLS 
enabled version of gateway is being used, then port 9203 can be 
used.

• WTLS Security: Check this option to enable data encryption. If 
checked, Authentication type need to be specified. Authentication 
type can be set to either Anon (anonymous) or Auth 
(authenticated), depending on the configuration of your dial-in 
server.

4. Tap Apply to save changes.

Browsing WAP sites
Just like the web browser you use on your desktop computer, jBrowser lets 
you browse the web in several ways:

• Visit a WAP page by entering its address in the Address bar.

Current profile

Tap Done to 
return to Profile 
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• Select a link from the Favorites list.
• Review the pages you’ve visited from History list.
• Go back to the pages you already visited by using Backward icon.

To visit a WAP page:
1. Enter the URL of the WAP page you want to visit in the Address bar.

2. Tap Go.

Instead of entering the URL letter by letter, you can use preset quick-text 
for quick entering. To do so, follow the steps below:

1. Tap the quick-text pick list on the left of the Address bar.

2. Select any item from the list then it will be shown in the address bar.

Input the 
address here
Then tap Go 
to accessBackward

Stop Refresh Home page Favorites

Tap this to show 
quick-text pick list
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3. Or select More...from the pick list to show URL Wizard screen, and 
tap desired quick-text items to complete the URL.

4. Tap Go.

While browsing WAP pages, you can perform tasks like:

• To return to a page you just visited, tap the Backward icon . 

• To stop a loading page, tap the Stop icon . 

• To refresh the screen, tap the Refresh icon .

• To go your home page, tap the Home Page icon .

• To select a link from the Favorites list, tap the Favorites icon .

Viewing information about a WAP page
To find the name, size and address of the current WAP page, open the 
Properties dialog box.

To view information about a WAP page:
1. Tap the Menu icon.

2. Select Properties from the View pull-down menu.

To view the source of a WAP page:
1. Tap the Menu icon.

2. Select Source from the View pull-down menu.

Tap this to 
open the URL

Tap this to return 
to main screen



Working with Communication
Applications

Surfing WAP sites with jBrowser

Smartphone User’s Manual 116
   

This is the internet version of the User Manual.Print only for private use.

Viewing statistical information for a connection
To view information for a selected connection, like information of the 
pages viewed, object fetched, number of bytes sent and received and the 
average page size, use the Statistic command:

1. Tap the Menu icon.

2. Select Statistic from the View pull-down menu.

3. Select a connection from the pick list on the top of the Statistics screen.

4. Then tap  to leave.

NOTE: In the Statistics screen, tap RESET to reset the values 
to default.

Book marking your favorite pages
When you read a printed book, you place a bookmark at the place where 
you stopped reading so that you can remember where you stopped. In the 
same way, you can bookmark a WAP page for later reference. A bookmark 
in jBrower doesn’t store the actual page; instead, it stores a reference to the 
page’s WAP address (URL).

To add a bookmark to the current page:
1. Tap the Menu icon.

2. Select Add To Favorites from the Go pull-down. 

3. Change the name, URL or category (optional).

Tap this to exit
Tap here to change 
the bookmark name
Tap here to change 
the URL
Tap here to choose 
a category
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4. Then tap  to finish.

Visiting a book marked page
1. Tap the Favorites icon on the bottom of the screen.

2. In the Favorites screen, select a bookmark and tap Go to open the 
page.

Editing a book marked page
1. In the Favorites screen, select a bookmark and tap Edit.

2. Change the name, URL or category.

3. Tap Save to save changes.

If you can’t find a proper category, you can create a new one:

1. In the Edit Favorites screen, tap New Category.

Select a bookmark

Tap Go to open 
the page

Select a 
bookmark

Then tap 
Edit

Tap here to 
change the 
bookmark name

Tap here to 
change the URL
Tap here to choos
a category

Then tap Save to 
save changes
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2. Enter the name for the new category and tap Add.

And you can also delete useless categories:

1. In the Edit Favorites screen, tap Delete Category.

2. Select a category you want to delete and tap Delete.

3. If prompted, tap Yes to confirm or tap Cancel to abort.

Caching pages for future fast access
Browsed pages can be cached for future viewing. Fetching pages from the 
cache loads the page faster.

To enable Cache:
1. In the main screen of jBrowser, tap the Menu icon.

2. Select Settings from the Tools pull-down menu.

Enter the category
name here
And then tap Add

Links contained 
in the category

Tap this to delete the 
selected category
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3. Select Cache/Cookie from the pick list in the lower right corner of the 
Profile setting screen.

4. Check Cache Enabled option to enable it.

5. Then tap OK.

Using Cookies to store information related to a 
session
Some WAP sites store information in a small text file, called a “cookie”. 
Cookies usually contain information about you and your preferences for 
that WAP site. A site can use this information to customize the pages you 
see the next time you visit.

Allowing a WAP site to create a cookie does not give the site access to the 
rest of your handheld. A cookie only stores the information you provide 
while visiting the WAP site.

To enable Cookies:
1. In the main screen of jBrowser, tap the Menu icon.

2. Select Settings from the Tools pull-down menu.

3. Select Cache/Cookie from the pick list in the lower right corner of the 
Profile setting screen.

Select Cache/Cookie 
from the pick list

Check this to enable it

Customize the 
size of Cache 
Tap this to clear 
all cached data
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4. Check Cookie Enabled option to enable it.

5. Then tap OK.

Tracking the sites you’ve visited with History
Keep track of the web sites visited by you! URLs of the sites visited by you 
are stored in History. 

To see History list:

1. In the main screen of jBrowser, tap the Menu icon

2. Select History from the Go pull-down menu.

3. History entries can be viewed by Page Title or by Page URL. Select 
your option from the pick list at the top of the screen.

• To visit a site from history, just select that site and tap Go. 
• To delete the history entries, click tap Clear.

Select Cache/Cookie 
from the pick list

Check this to enable it

Customize the size 
of Cookies here
Tap this to clear all 
saved Cookies
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Using STK (SIM Tool Kit)
Your SIM card may provide additional services, such as mobile banking, 
flights inquiring etc.

NOTE: Menu is shown only if your SIM cards supports STK. 
The title and contents of the menu entirely depends on the 
services provided by your network operator or your SIM card 
vendor. For details of using STK, please contact your network 
operator or your SIM card vendor.

Diverting incoming calls
If you want to make certain that your incoming calls are correctly handled 
when you are unable to answer them, you can use the Call Divert service to 
divert them to another phone number.

To open Call Divert setting screen:
1. Tap the Home icon and select Communication from the pick list in the 

upper right corner.

2. Tap Call Divert.

This icon indicates that Call Divert is currently enabled.

Tap this to switch Call Divert on/off.

Apply this number to all items below if it’s checked.

Divert all incoming calls to the specified number.

Divert calls if your phone’s busy.

Divert calls if the incoming calls are not answered within 
a specified time.
Divert calls if your phone is turned off or if you’re 
unreachable.

Only when you tap Done, changes will take effect.
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Setting Ringtone Profiles for incoming calls or 
messages

Use various ringtone profiles to adopt to different environment you’re 
currently situated in.

To open Profiles setting screen, do one of the following:
• Tap the speaker icon  in the status bar on the top of the screen to 

enter the Ringtone Profiles setting screen.
• Tap the Home icon and select Communication from the pick list in 

the upper right corner of the screen, and then tap the Profiles 
application icon. 

• Tap the Home icon and tap Prefs from the Applications Launcher, 
and then select GSM/GPRS from the pick list in the upper right 
corner. 

Managing melodies with Melody Manager
You can manage downloaded or received melodies with this application.

To open Melody Manager:
1. Tap the Home icon and select Communications from the pick list in 

the upper right corner of the screen.

2. Tap Melody Manager.

Tap the Profile pick list to select a preferred profile.

Or you can adjust the options below specifically to 
customize a profile which might suit you best.

Tap this to restore to default settings.

Tap this to return to previous screen.
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NOTE: Embedded melodies (indicated with a icon like this ) 
can not be deleted.

Tap to select

Volume pick list 
(High/Medium/
Low)

Stop the playing melody

Delete the selected melody

Tap to play the 
selected melody
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8
Working with Studio 
Applications
Your Smartphone includes the following studio applications:

• Camera
• Melody Manager
• Photo Album
• Photo Editor

Using the Camera
With the camera you can take pictures whenever & wherever you are. The 
pictures are automatically saved in the PhotoAlbum application, where you 
can organize and rename them in albums. You can also send photos to your 
friends in a multimedia message or infrared connection. The camera 
produces JPEG pictures. 

To activate the camera:
1. Tap the Applications icon, and select Studio from the pick list in the 

upper right corner of the screen.

2. Tap the Camera icon

3. Alternatively, press the Camera button on the front panel of your 
Smartphone.
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Taking pictures
1. Press the Camera button on the front panel of your unit in standby 

mode. The Camera application opens and you can see the view to be 
captured onscreen.

2. Use the screen as a viewfinder, when the view is satisfying, press the 
Camera button to take a picture.

3. Meanwhile, the scene will be hold still on screen for a specify time as 
you’ve set in Preferences, we call it Preview. 

4. To resume from Preview screen, tap on the screen or press the Camera 
button.

While taking pictures, you can use buttons below to adjust white balance, 
exposure rate and picture resolution, and you can also add interesting 
frames to your pictures. The camera features 2X digital zoom.

To change resolution:

• Tap  repeatedly to cycle through different resolutions 
(320X240 or 160X160).

To adjust white balance:

• Tap  repeatedly to cycle through different white balance 
modes. White balance modes are:

–  : Sunny

–  : Cloudy

–  : Bulb
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–  : Fluorescent lamp

–  : Auto

To adjust exposure:
• Tap the leftward/rightward triangle icon on the exposure composite 

button  to increase/decrease exposure rate. The rate 
ranges from -4 to +4.

To add frames:

• Tap  repeatedly to cycle through different frames. When cycled 
to the end/start, no frame will be added.

To zoom in/out:
Tap  to zoom in, and it turns into  at the same time. Tap  to zoom 
out, and it turns into .

To jump to PhotoAlbum:

Tap  for quick access to the main screen of PhotoAlbum.

Previewing photos taken in the current session
The time between you activate Camera and you leave is called a session. 
You can use the jogdial on the front panel of your Smartphone to preview 
the photos you’ve just taken in the current session. 

To preview the photos taken in the current session
1. Push the jogdial up, down, left or right to display the photos you’ve 

just taken in the current session.
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2. While previewing photos, push the jogdial up/left or down/right to 
view previous or next photo.

3. To resume to Camera, tap Done on the bottom of the screen of press 
the Camera button.

Camera modes
There are 3 camera modes provided. Tap  repeatedly to cycle 
through these modes.

• Normal : lets you take one normal picture at a time. Please 
refer to “Taking Pictures” in previous part.

• Splash : enables you take 3 (default) continuous pictures 
while you hold down the Camera button. Once you release the 
Camera button, camera stops shooting. 

• Self-Timer : lets you set up the shot and then get into the 
picture. Countdown is indicated by blinking numbers in the middle 
of the screen. Self-Timer operation is cancelable. 
To enable Self-Timer:

a. While the camera is in stand-by mode, tap  repeatedly 
until  appears.

b. Press the Camera button, then a jumping digit appears in the 
middle of the screen indicating seconds left. Before the 

Push the 
jogdial in any 
direction to 
preview

Send the current 
photo via MMS

Return to 
Camera

Total photos taken in 
the current session

Current photo 
number

Delete the 
current photo
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countdown ends, get yourself into the picture, and the camera 
will automatically shoot. When the action is finished, the 
camera mode resumes to Normal automatically. 

c. You can press the Exit button on the front panel of your 
Smartphone to abort while the countdown is progressing.

Setting camera preferences
In the camera preferences screen, you can set the number of frames that 
each splash consists of and countdown seconds of Self-Timer, turn on/off 
chatter sound, specify which special effect will be applied to pictures.

To set Preferences:

1. When the camera is in stand-by mode, tap  to open the Preferences 
screen.

2. Tap different pick lists to specify different values for different item.

3. Tap Ok to save changes, tap Cancel to abort.

Viewing photos with PhotoAlbum
PhotoAlbum allows you to view, organize, delete, and send photos and 
pictures stored in your phone. In PhotoAlbum you can organize images:

• taken with the camera;

Pictures each splash 
contains (1-9)

Self-timer (5-25 
seconds)
Chatter sound (None 
or Kacha)
Special effects (Normal 
means no effect)
Insert Date to every 
picture you take.
Set the time that 
preview screen lasts
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• sent to your Inbox in a multimedia or a picture message, as an e-
mail attachment, via an infrared connection. After receiving the 
image in Inbox, you need to save it in PhotoAlbm. 

To open PhotoAlbum:
1. Tap the Home icon, and select Studio from the pick list in the upper 

right corner of the screen.

2. Tap the PhotoAlbum icon.

Managing albums
There are four albums preset in this application. 

• My Splashes stores the splashes taken with the camera. Splashes 
can be converted to separate photos and stored in a new album.

• MMS Pictures stores the pictures received via multimedia 
messages or pictures you draw with Doodles. Photos in this album 
can be move or copy to other albums but My Splashes.

• My Photos stores photos taken with the camera, pictures received 
from other devices via IrDA port or pictures synchronized from 
your desktop computer. Photos in this album can be move or copy 
to other albums except My Splashes.

• My Notes stores pictures you created with PhotoEditor application. 
Photos in this album can be move or copy to other albums but My 
Splashes.

• Internal Card provides extra space for you to store photos!
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Yet you can create new albums to store particular photos, or delete those 
alums you don’t use any more.

To create a new album:
1. In the main screen of PhotoAlbum, tap New.

2. Select the destination to where your album will be saved.

3. Enter the name of the new album.

4. Tap OK.

To delete an album
1. In the main screen of PhotoAlbum, tap the album you want to delete.

2. In the index screen of the selected album, tap  to enter the Details 
screen.

3. Tap Delete.

Select the destination 
(Phone or memory card)

Enter the name of the 
new album here

Tap here to rename 
the album

Number of pictures 
stored in the current 
album

Tap Delete to remove 
the current album
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Viewing photos in Icon view
Icon view displays miniature versions of your photos so that you can see 
several photos on the screen at the same time. Use this view to browse 
through photos and locate a photo when you don’t know the name of the 
photo.

To view photos in Icon view:

1. Tap the view mode icon  repeatedly to cycle through the three 
modes (Icon, List, Album), until  (Icon view) appears.

2. Tap the Album pick list in the upper right corner and select the album 
you want to view.

3. Tap the icon of the photo you want to view.

Traditional view Icon view

Album pick 
list

Tap this to 
return to the 
main screen of 
PhotoAlbum

Tap the photo 
to view in full 
screen

Tap this to 
return to 
Icon view

Check details 
of the photo

Delete current 
photo

Zoom in
Zoom out

Zoom 
percentage

Tap the photo 
to return
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TIP: While view the photo, tap the Menu icon to show more 
options that you can do with the photo. You can set the current 
photo as wall paper, copy or move the photo from current album 
to another album, send the photo as an MMS attachment or send 
to photo to other devices via IrDA port.

4. Tap Done to return to Icon view.

Viewing photos in List view
List view displays a list of your photos so that you can see the names file 
formats associated with your photos.

To view photos in List view:

1. Tap the view mode icon  repeatedly to cycle through the three 
modes (Icon/List/Traditional), until  (List view) appears.

2. Tap the name of the photo you want to view (Please refer to “Viewing 
photos in Icon view” in previous part).

3. Tap Done to return to List view.

Traditional view List view

Album pick 
list
File format

Name of the 
photo

Tap this to 
mark it as 
a selected 
item

Tap this to delete 
the selected items
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Viewing photos in Album view
Traditional view displays photos in the way traditional physical albums do. 
It also displays miniature versions of your photos, but only 4 photos are 
displayed at a time.

To view photos in Album view:
1. By default, photos are displayed in Album view when you open an 

album.

2. Tap the page tabs on the right side to toggle among different pages if 
your photos exceed one page.

3. Tap the icon of the photo you want to view. For details, please refer to 
“Viewing photos in Icon view” in the previous part.

4. Tap Done to return to Album view.

Viewing a slide show
A slide show is a sequential presentation of each of the photos in the 
current album. You can set the length of time each photo remains on the 
screen in the Details screen of the album.

To view a slide show:
1. In Icon, List or Album view, tap the Album pick list in the upper right 

corner to select a album you want to view.

2. Tap Play.

page tab

Tap an icon 
to view
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Slide show settings
You can set the length of time each photo remains on the screen, effects, 
and background music in the Play Setting screen.

1. In the list screen of an album, tap  to enter the Album Details 
screen.

2. In the Details screen, tap Play Setting to show Play Setting screen.
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3. Tap OK to save changes and return.

Organizing Photos
You can organize your photos by filing them into different albums.

To file photos in albums:
1. In the list screen of an album, tap the menu icon.

2. Select “Copy all photos to...” or “Move all photos to...” to copy or 
move (cut) all the photos in the current album to a specific album.

3. Select the destination from the Album pick list.

4. If there’s no suitable album, tap “New album” button to create a new 
album. For details of creating new albums, please refer to “Managing 
albums” in the previous part.

5. Tap OK.

9 effects available 
(Random: apply effects 
to photos randomly; 
Sequential: apply effects 
to photos sequentially)
Ranged from 3 Secs. to 
2Mins.
Tap this to skip to 
MelodyManager to select 
a sound clip as 
background music

Check this to enable loop play

Tap the Album 
pick list to select 
a target album

Tap this to create 
a new album

“Copy” will be 
replaced by “Move” 
if “Move all photos 
to...” command is 
selected
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To sort photos in List/Icon/Traditional view
1. While in the index screen of an album, tap the Menu icon and select 

Sorting from the Options pull-down menu.

2. You can sort photos by Name, Date or by Size. You can also define sort 
order as ascending or descending.

3. Tap OK then changes will take effect and will be applied to List, Icon 
or Traditional view at the same time.

To delete photos in Icon/Traditional view
1. While in the index screen of an album, tap the Menu icon.

2. Select “Delete all photos...” from the Options pull-down menu.

3. Tap Yes to delete when prompted, or tap Cancel to abort.

Alternatively, you can:

1. Locate the icon of the photo you want to delete and tap on it in the 
index screen to view.

2. Tap  to delete the photo you’re viewing.

To delete photos in List view
• Check the check boxes next the photos you want to delete, and tap 

Delete to delete those selected photos.
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• Or tap the Menu icon and select Select All from the Edit pull-down 
menu, then tap Delete to delete all photos in the current album.

Using the PhotoEditor
You can use this application to modify existing photos, or add more fun 
elements to photos. You can even create your own pictures with multiple 
and powerful tools. And pictures create with PhotoEditor can be attached 
to multimedia messages (MMS).

Creating you own pictures:
1. In the main screen of PhotoEditor, tap the Menu icon and select New 

from the File pull-down menu.

2. Define the size of the new picture, and tap OK.

Tap this to 
mark it as 
a selected 
item

Tap this to delete 
the selected items
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3. Use the tools provided (3 main toolbars, totally 11 different tools), and 
of course your imagination and creativity, to draw anything you like.

• Toobar A: 

 - Toolbar switcher. Tap this to toggle among the 3 main toolbars.

 - Color picker, indicating the color in use.

 - Thickness level indicator (4 levels). If Straight Line is selected in 

Toolbar C, it changes to . If Freehand is selected in 

Toolbar C, it changes back to .

 - Tap this to add a frame. Tap this repeatedly to cycle through all the 

funny frames.

 - Stamp. Tap this to skip to Stamp screen, select a stamp to insert to 

the picture.
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 - ShortHand. Tap this to skip to ShortHand application and insert a 

script from ShortHand to the current picture.

• Toolbar B: 

 - Rotate. Tap this to call out hide items. You can select to rotate the 

screen 900 CW, 1800 CW, 2700 CCW, flip the screen horizontally or 

vertically.

 - Size adjustment. Tap this to call out hidden items.You can select 4X 

(400%), 2X (200%), 1/2 (50%) or 1/4 (25%).

 - Zoom. Tap this to switch between Zoom In and Zoom Out.

• Toobar C: 

 - Hand Tool, moves the picture within its window.

 - Rectangular Marquee Tool. When this tool is in use, tap and drag 

your stylus on screen to draw a selection box. Then you can move, 

copy, cut or paste the selected content.

 - Straight Line. Tap this to call out hidden items.

Select a stamp and tap Done to insert it to the picture
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4. While drawing a picture, tap the Menu icon to show more options you 
can do with the picture:

• Select Undo from the Edit menu to withdraw the last action, or 
select Redo to redo the last withdrawn action.

• Select Cut Selected or Copy Selected from the Edit menu to cut or 
copy the content selected with Rectangular Marquee Tool. Select 
Paste Selected to paste the selected content.

• Select Grey or Antique from the Effects Menu to apply Grey or 
Antique effect to the current picture.

• Select Hide Toolbar from the Options Menu to hide the toolbar on 
the bottom of the screen. To recall the toolbar, select Show Toolbar 
from the Options Menu.

5. When finished, tap the Menu icon and select Save from the File pull-
down menu.

Modifying an existing photo
1. In the main screen of PhotoEditor, tap the Menu icon and select Open 

from the File menu to skip the index screen of My Notes Album.

Circle

Squar

Color picker

Freehand Straight Line

Text

Eraser

Paint 

Selected tool will be 
indicated in this box

Album pick 
list
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2. You can use the Album pick list in the upper right corner to skip to 
another album.

3. Locate the desired photo and tap on the photo to open it in 
PhotoEditor.

4. For details of using tools provided to modify the photo, please refer to 
previous part “Creating your own pictures”.

5. When finished, tap the Menu icon and select “Save as” from the File 
menu to save the modified photo as a new file; or select “Save” to 
replace the original photo with the modified one.
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9
Working with Main 
Applications
Your Smartphone includes the following basic main applications:

• Address Book
• Clock

• Alarm
• Calculator
• Date Book
• GSL Launcher
• Memo Pad
• Short Hand
• To Do List
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Using the Address Book
The Address Book lets you keep names, addresses, telephone numbers, and 
other information about your personal or business contacts.

Use the Address Book to: 

• Quickly enter, look up, or duplicate names, addresses, phone 
numbers, and other information.

• Enter up to five phone numbers (home, work, fax, mobile and so 
on) or e-mail addresses for each name.

• Assign Address Book entries to categories so that you can organize 
and view them in logical group,.

• Specify unique ringtones for any individual, so you can identify the 
caller from general incoming calls.

• Attach a photo to each contact which will appear on the incoming 
call screen.

• Customize birthday alert for each contact so that your handheld will 
remind you in advance at a specified time and send your preset 
greetings to the person via SMS, MMS and Email.

• Define which phone number appears in the Address List for each 
Address Book entry. 

• Attach a note to each Address Book entry, in which you can enter 
additional information about the entry.

To open the Address Book: 

1. Tap Home icon .

2. Select Main from the pick list in the upper right corner.

3. Tap the Address Book icon .

Adding and using Address Book entries
The Address Book application stores name and address information about 
people or businesses.
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Creating an Address Book entry
A record in Address Book is called an entry. You can create entries on your 
Smartphone, or you can use Smartphone to create entries on your computer 
and then download them to your Smartphone with your next HotSync 
operation.

Smartphone also has data import capabilities that let you load database 
files into the Address Book on your Smartphone. 

See Smartphone online Help for more information.

To create a new Address Book entry:
1. In the List screen of Address Book, tap New.

2. Enter the last name of the person you want to add to your Address 
Book. 

3. You can move to any field by tapping it directly.

4. If you want to be able to sort the Address Book by company name, 
enter the information you want in the Company field. 

5. Enter any other information that you want to include in the entry.

6. Tap the scroll arrows to move to the next page of information.

7. To attach a note to an entry, tap Note. Enter the information you want 
in the text input area, and then tap Done.

Cursor at 
Last name
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8. To distinguish the entry from other general contacts, you can assign a 
particular ringtone for its incoming calls and messages.

9. You can also add a Birthday Reminder to remind you when the 
birthday of the person arrives.

10. You can even add a photo to the entry. So, when the person calls you, 
you’ll see his/her photo on the incoming call screen.

11. When you have finished entering information, tap Done.

TIP: To create an entry that always appears at the top of the 
Address List, begin the Last name or Company field with a 
symbol, as in *If Found Call.* This entry can contain contact 
information in case you lose your Smartphone.

Select a melody and 
tap OK to return

Tap this field to jump 
to MelodyManager

Tap this field to show 
Birthday Setting dialog box

Tap this field to set the date 
of birthday using calendar

Tap this and follow onscreen
instructions to select the way
your Smartphone alerts you 
when the day comes.
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To add a photo to an address entry:

1. Tap  to popup the pick list and select Capture to jump to Camera 
application. 

2. Press the Camera button to take a new photo. If you press the Camera 
button more than once, then only the last photo will be attached to the 
entry. For details of using the Camera, please refer to Chapter 7, 
“Working with Studio Applications”

3. Press the Exit button to return to the editing screen of the new address 
entry. Now tap  again, you’ll see two more commands are added to 
the pick list. Select “View image” to view the image you’ve just taken, 
or select “No image” to cancel image attachment.

Besides taking a new photo, you can also select a photo from PhotoAlbum 
application and add it to the address entry.
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1. Tap  to popup the pick list and select Select to skip to My Photos 
album.

2. Locate and tap on the desired photo to add it to the address entry.

To assign a ringtone for a whole category of contacts:
1. In the List screen or editing screen of Address Book, tap the Menu 

icon.

2. Select Category Ring Tone from the Option menu to show Category 
RingTone Setting dialog box.

3. Tap the Category field to select a desired category.

4. Tap the RingTone field to select a ringtone for the selected category.

5. Tap Done.

Tap Album pick 
list to switch to 
another album

Locate and tap 
on the desired 
photo to add it 
to the address 
entry you’re 
editing

Tap this field to select a ringtone for the 
selected category
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To view details of an address entry:
1. You can select to view entries stored in SIM card or entries stored in 

the memory of your Smartphone. Tap  to list entries stored in SIM 
card; tap  to list entries stored in the memory of your Smartphone. 

2. You can select to view only phone numbers of an entry or select to view 
complete information about the entry:

• Tap the Name field of an address entry in Address List view to 
view complete information.

• Tap the Number field to view phone numbers only.

3. Tap Done when you have finished viewing the entry.

Tap this to edit 
the current entry

Tap this to return

Tap New to 
create an new 
entry

Tap this to send 
a text message 
to this person

Tap the Name field 
to view details

Office number
Office number (with a 
photo attached)

Mobile

Home

Selected number 
will be shown here

Select a number 
to dial

Tap this to send a 
text message to the 
selected number

Tap this to dial the 
selected number

Tap this to return to 
List view
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Duplicating an entry
You can duplicate existing entries, which can be helpful when you want to 
enter multiple people from a single organization. When you duplicate an 
entry, the word Copy highlighted with bright color appears next to the 
name in the First Name field. 

To duplicate an entry:
1. From the Address Book, tap a name you want to duplicate.

2. Do one of the following:

• Tap the Address Edit tab at the top of the screen; then tap Duplicate 
Address in the Record menu. 

• In the text input area of your Smartphone, drag a diagonal line from 
the lower left to upper right to display the Command toolbar; then 
write a T in the text input area to initiate the Duplicate Address 
command.

3. Edit the record as necessary. 

Selecting different types of phone numbers and addresses
You can select the types of phone numbers or e-mail addresses that an 
Address Book entry displays. Any changes you make apply only to the 
current entry. 

To select other types of phone numbers in an entry:
1. Tap the entry that you want to change in the Address list. 

2. Tap Edit.

3. Tap the pick list next to the label you want to change.

4. Select a new label.
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Editing Address Book entries
You can change the type of information that appears in the Address List 
screen, categorize an entry, and hide an entry for security reasons. You can 
also delete entries. 

To edit an Address Book entry:
1. Tap the entry that you want to change in the Address list.

2. Tap Edit.

3. Tap Details.

4. In the Address Entry Details dialog box, select any of the following 
settings:

• Tap Show In List, and in the pick list tap which type of phone or 
other information you want to appear in the Address List screen. 
Options are Work, Home, Fax, Other, and E-mail. 

• Tap Category, and then tap a category in the pick list that you want 
to assign to the entry. 

• Tap Private to hide the entry when Security is turned on.
5. To attach a note to an entry, tap Note, enter information in the text 

input area, and tap OK.

6. To delete an entry, tap Delete.

7. Tap OK.

Changing the Address Book display
You can change how Address Book lists are sorted and you can add custom 
fields for entering additional information, using preferences. You can also 
have the Address Book display the last category you selected each time 
you return to the application.



Using the Address Book

Smartphone User’s Manual 151
   

This is the internet version of the User Manual.Print only for private use.

To change how lists are sorted:
1. In the Address list or in Address view, tap the Menu icon.

2. Tap Options, and then tap Preferences.

3. Choose an option to sort Address Book lists from the List By pick list:

• Tap Last Name, First Name to sort alphabetically by an individual’s 
last name and then first name.

• Tap Company, Last Name to sort alphabetically by the company 
name, and then an individual’s last name.

4. Tap OK.

To add custom fields at the end of Address Edit screens:
1. In the Address list or in Address view, tap the Menu icon.

If you want to have the Address Book re-display the last 
category you selected on returning to the application, 
check this option
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2. Tap Options, and then tap Rename Custom Fields.

3. In the text input area, rename the fields to identify the information 
you’ll enter in them. The names you give the custom fields appear in 
all entries, at the end of the Address Edit screen. 

4. Tap OK in the Rename Custom Fields dialog box.

Exchanging address entries between SIM card and phone 
memory
You can export address entries stored in phone memory to SIM card, or 
export address entries stored in SIM card to phone memory. Differed from 
address entries stored in phone memory, each SIM card entry contains less 
information. So please note that copying entries to SIM card might cause 
lost of information.

To export an entry from phone memory to SIM card
1. In the Address list, press down the jogdial to highlight an entry. 

2. Tap the Menu icon and select “Export to SIM Card”.
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3. In the popup dialog box, change the name if necessary, and tap Select 
Phone to select the phone number to be exported to SIM card (only if 
the entry contains more than 1 phone number).

4. If the information display in the dialog box is correct, tap OK.

To export address entries from SIM card to phone memory
1. In the Address list, tap the Menu icon and select “Export to Address 

Book”.

• If no entry is selected, system prompts: Do you want to export all 
records? Tap Yes to proceed.

2. In the popup dialog box, select Export Current Record to export the 
selected entry only or select Export All Records to export all entries to 
phone memory. And you can select which category the entries will be 
exported to.

3. Tap Ok.
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Using the Date Book
The Date Book lets you quickly and easily schedule appointments or any 
activity associated with a date or date and time. When you open the Date 
Book, the current date and a list of times for a standard business day are 
displayed. 

Use the Date Book to
• Schedule events: timed events, which have both times and dates; 

untimed events, for example, birthdays or anniversaries; repeating 
events, such as a weekly meeting held on the same day at the same 
time; continuous events, such as a vacation or three-day 
conference; and all day events, which reflect the default hours of a 
day as set by the user. 

• Display your schedule in different ways: by Day, Week, Month, or 
Agenda view. 

• Set an alarm to sound minutes, hours, or days before a scheduled 
appointment. 

• Attach notes to events to describe or clarify Date Book entries. 
• Rearrange or delete events from your schedule.

To open the Date Book application:
1. Tap the Home icon and select Main from the pick list in the upper 

right corner.

2. Tap the Date Book icon  to open the Date Book to view today’s 
schedules. 

The date is displayed at the top right of the screen. 

NOTE: Tap the view mode icons at the bottom left of the screen 
to display schedules in Day, Week, Month, and Agenda views. 

Scheduling events
An entry in the Date Book is called an event. When you schedule an event, 
its description appears on the time line, and its duration is set to 1 hour by 
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default. You can easily change the start time and duration for any event. 
You can schedule the following types of events in the Date Book:

• Timed events, such as meetings, that have a specific date and a 
specific start and end time. 

• Untimed events, such as birthdays, holidays, and anniversaries. 
These events occur on a particular date but have no specific start or 
end times; they appear at the top of the list of times marked with a 
diamond. You can schedule more than one untimed event on the 
same date. 

• Repeating events, such as weekly meetings that are held on the 
same day at the same time each week. 

• Continuous events, such as a vacation or a three-day conference.
• All day events, consume valid hours of a day preset by the user. 

Scheduling timed events
You can schedule timed events for the current date or for future dates. 

To schedule a timed event for the current date:
1. Tap Date Book from the Applications Launcher to open the Date Book 

to today’s schedule. The current date and a list of times for a normal 
business day are displayed in Day view.

2. With the current day selected, tap the line next to the time that 
corresponds to the start of the event. 

3. Enter a description of the event, up to 255 characters in length.

4. Set the event’s duration:

• If the event is 1-hour long, skip to the end of this procedure.

Time bar shows the 
default duration.

Tap a line next 
to desired time; 
then enter text.
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• If the event is longer or shorter than an hour, tap directly on the 
time to open the Set Time dialog box.

TIP: You can open the Set Time dialog box (to select a start 
time) by making sure no event is selected, and then writing a 
number on the number side of the text input area.

5. Set the duration of the event in either of the following ways:

• Tap the time columns in the Set Time dialog box to set the Start 
Time; Tap End Time; then tap the time columns to set the End 
Time.

• Tap All Day if the event lasts all day. The default hours of a 
standard business day are set by the user, and may be changed using 
the Preferences command in the Date Book application. See the 
section “Changing the displayed Start and End Times” in this 
chapter later.

6. Tap OK.

Tap the time to 
display the Set 
Time dialog box.

Start Time 
highlighted

Tap to scroll to 
earlier hours.

Tap to scroll to 
later hours.

Tap to change 
hours.

Tap to change 
minutes. 
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To schedule a timed event for another date:
1. Select the date you want in one of the following ways: 

• Tap the desired day of the week in the date bar at the top of the 
screen. If necessary, tap the Previous week or Next week scroll 
arrows to move to another week.

• Tap Go To at the bottom of the screen to open the Go to Date dialog 
box. Select a date by tapping a year, month, and day in the calendar.

2. After locating the desired date, follow the steps for scheduling an event 
for the current day.

Scheduling untimed events
1. Select the event date you want, as described in the previous procedure, 

“To schedule a timed event for another date.” 

2. Tap New.

Previous week Next week

Select the date in 
this week

Previous year Next year

Tap to select month

Tap to select day

Tap to select the 
current date
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3. In the Set Time dialog box, tap No Time. 

TIP: You can create a new untimed event by making sure no 
event is selected and then writing letters in the text input area. 
When you start writing, the untimed event appears at the top of 
the screen 

4. Enter a description of the event.

5. Tap a blank area on the screen to deselect the untimed event.

NOTE: If you create a timed event and later want to make it an 
untimed event, tap directly on the event time on the Date Book 
screen; then tap No Time and OK. 

Scheduling repeating or continuous events 
The Repeat function lets you schedule events that recur at regular intervals 
or extend over a period of consecutive days. Repeating events include a 

New 
untimed 
event
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birthday and a weekly guitar lesson that falls on the same day of the week 
and the same time of day. Continuous events might include a business trip 
or a vacation.

To schedule a repeating or continuous event:
1. Tap the event (Be sure to tap the event and not the time next to the 

event.). 

Typically, a continuous event is an untimed event.

2. Tap Details.

3. Tap the Repeat box to open the Change Repeat dialog box.

4. Tap Day, Week, Month, or Year to set how often the event repeats. For 
a continuous event, tap Day.

5. Enter a number that corresponds to how often you want the event to 
repeat on the Every line. 

6. For example, if you select Month and enter the number 2, the event 
repeats every other month.

7. To set an end date for the repeating or continuous event, tap the End 
On pick list and tap Choose Date. Use the date picker to select an end 
date.

8. Tap OK. An  icon that represents a repeating event appears to the 
far right on the event line.

Making changes to repeating or continuous events
When changes are made to a repeating or continuous event, you can 
decided which events to change the events:all of the spectrum events,the 
current events ,or the events that take place in the future.

Tap the Repeat 
box.



Using the Date Book

Smartphone User’s Manual 160
   

This is the internet version of the User Manual.Print only for private use.

To delete repeating events:
1. Select the event you want to delete.

2. Tap Details. The Event Details screen opens.

3. Tap Delete. The Delete Event screen opens asking for confirmation of 
the deletion.

TIP: You can also select Delete Event from the Record menu. 
This opens the Repeating Event screen.

4. Select one of the following options:

• Tap OK to delete a single occurrence of this event
• Tap Cancel to go back to the previous box
• The Save archive copy on PC option will store deleted record in an 

archive file on your Desktop at the next HotSync operation. Some 
record will be hidden but not deleted until then.

The event is removed from your datebook and you are returned to the day 
view where you started. These steps apply to all changes you make to 
repeating or continuous events.

About scheduling repeating or continuous events
Keep the following in mind when scheduling repeating or continuous 
events:

• If you change the start date of a repeating event, your Smartphone 
calculates the number of days you moved the event. Your 
Smartphone then automatically changes the end date to maintain 
the duration of the repeating event.

• If you change the repeat interval (e.g., daily to weekly) of a 
repeating event, past occurrences (prior to the day on which you 

Tap Delete
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change the setting) are not changed, and your Smartphone creates a 
new repeating event.

• If you change the date of an occurrence of a repeating event (e.g., 
from January 14 to January 15) and apply the change to all 
occurrences, the new date becomes the start date of the repeating 
event. Your Smartphone adjusts the end date to maintain the 
duration of the event.

• If you change other repeat settings (for example, time, alarm, 
private) of a repeating event and apply the change to all 
occurrences, your Smartphone creates a new event. The start date 
of this new event is the day on which the setting is changed. Past 
occurrences (prior to the day of the change) are not changed.

• If you apply a change to a single occurrence of a repeating event 
(e.g., time), that occurrence no longer shows the Repeat icon.

Rescheduling events
You can reschedule events using the Details option in the Date Book. You 
can also use the Details option to convert untimed events into timed events. 

To reschedule an event:
1. Tap the event you want to reschedule.

2. Tap Details.

3. To change the time, tap the Time box, select a new time, and then tap 
OK. 

4. To change the date, tap the Date box, select a new date, and then tap 
OK.

Adding Address Book information to an event
You can add a name, address, and telephone number to an event using the 
Phone Lookup option. For instructions, see “Using Phone Lookup” in 
Chapter 5, “Performing Common Tasks”.

Setting the alarm
The Alarm setting lets you set an audible alarm for events in your Date 
Book, and display a reminder message on-screen. For untimed events, only 
the reminder message appears.
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Setting an alarm for an event
You can set an alarm for minutes, hours, or days before an event. When you 
set an alarm, an Alarm icon appears to the far right of the event with the 
alarm. 

You can also set a silent alarm for untimed events that displays a reminder 
message on-screen before the day of the event. The alarm triggers at the 
specified period of minutes, hours, or days before midnight of the day on 
which the untimed event begins. 

For example, you set a 5-minute alarm for an untimed event that occurs on 
February 4. The reminder message will appear at 11:55 p.m. on the night of 
February 3. The reminder remains onscreen until you turn on your 
Smartphone and tap OK to turn off the reminder.

To set an alarm for an event:
1. Tap the event to which you want to assign an alarm.

2. Tap Details.

3. Tap the Alarm check box to select it. Tap None to appear Change 
Alarm dialog box.

4. The default setting, 5 Minutes, appears. Tap the label in the upper side 
to select the style of tip.

5. Set the alarm time:

• Tap the Alarm box to show Change Alarm screen.

• Enter any number from 0 to 99 (inclusive) as the number of time 
units.

Enter number 
of time units 
here.

Tab Here to 
select the 
type of alarm Tap the pick 

list to select 
unit of time.

Tap here to skip to 
MelodyManager and select 
a melody as alarm sound
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• Tap the pick list to change the time unit; select Minutes, Hours, or 
Days.

• Tap the Alarm Sound box to select a melody from MelodyManager 
as the alarm sound.

NOTE: You can set to be notified by Email, SMSorMMS if your 
Smartphone is not with you at that time. Then the Email address or the 
number of the recipient of the alarm message (SMS/MMS) need to be 
specified accordingly.

6. Tap OK.

Once an alarm has gone off, you can tap the Snooze option to dismiss the 
alarm for a 5-minute period. 

To dismiss the alarm using the snooze option:
When the alarm dialog box appears, tap Snooze to delay the alarm for a 
preset five-minute period. 

Each time you tap Snooze, the alarm is dismissed for an additional 5-
minute period. 

Setting alarm options
You can set the alarm to go off automatically for each new event using 
preferences. You can also set a tone for the alarm and the number of times 
the alarm sounds. 

To set alarm options:
1. To open the Preferences dialog box, do one of the following: 

• In the Date Book, tap the Menu icon.
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• Tap the inverted tab at the top of the Date Book screen to display 
the menu bar.

• In the text input area, drag a diagonal line from the lower left to 
upper right to display the Command toolbar. Type an R, the 
Graffiti® 2 ShortCut for the Preferences command. 

2. In the Options menu; tap Preferences.

3. Select from the following options: 

• Tap Alarm Preset to set an alarm for each new event automatically. 
The silent alarm for untimed events is defined by minutes, days, or 
hours before midnight of the date of the event. 

• Tap the Alarm Sound box to select a melody from MelodyManager 
as the alarm sound.

• Tap Duration pick list to select the duration each time the alarm 
sound plays.

• Tap Remind Me to define how many times the alarm sounds—once 
or twice; or three, five, or ten times.

• Tap Play Every to set how often the alarm sounds—every minute; 
or every 5, 10, or 30 minutes.

4. Tap OK.

NOTE: Events with alarm enabled will be indicated with a clock 
icon  at the far right side of the event line.
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Changing the Date Book view
The Date Book includes four views for displaying your appointments: day 
view, week view, month view, and agenda view. 

To display the Date Book views: 
1. Tap a view icon in the lower-left area of the Date Book screen.

To display the current time:
Tap and hold down the stylus on the date in the date bar to display the time. 
(When you release the stylus, the menu bar appears.) 

Working in Week view
Week view displays a calendar of your events for an entire week. This view 
lets you quickly review your appointments and available time slots. In 
addition, the graphical display helps you spot overlaps and conflicts in your 
schedule.

To display the Week view:
1. Tap the Week view icon to switch to Week view. 

2. Push the jogdial left or right to move forward or backward a week at a 
time, or tap on a specific day to display the details of an event. 

NOTE: The Week View also shows untimed events and events 
before and after the range of times displayed.

Date Book view mode icons

Week view
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3. Tap an event to display a description of the event at the top of the 
screen.

Tips for using Week view
Keep the following points in mind when using Week view: 

• To reschedule an event while in Week view, tap and drag the event 
to a different time or day.

• Tap a blank time on any day to move to that day and have the time 
selected for a new event. 

• Tap any day or date that appears at the top of the Week view to 
move directly to that day without selecting an event.

• The Week view displays the time span defined by the Start Time 
and End Time in the Date Book Preferences settings. If you have an 
event before or after this time span, a bar appears at the top or 
bottom of that day's column. Use the onscreen scroll arrows to 
scroll to the event.

previous week The next week

Bar indicates earlier event.

Dot indicates untimed event.

Bar indicates later event. 

Event details

Tap to show event details.
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Spotting event conflicts
With the ability to define specific start and end times for any event, it is 
possible to schedule events that overlap (an event that starts before a 
previous event finishes).

An event conflict (time overlap) appears in the Week view as overlapping 
time bars and in the Day view as overlapping brackets to the left of the 
conflicting times.

Working in Month view
The Month View screen shows which days have scheduled events. Dots 
and lines in the Month view indicate events, repeating events, and untimed 
events.

You can control the dots and lines that appear in the Month View. See 
“Changing the Date Book display of events” for more information.

Tips for using Month view
Keep the following points in mind when using the Month view: 

Event 
conflicts

Previous/next month

Dots on right side indicate events.

Dots below date indicate untimed events.

Month View icon

Dashed line indicates continuous event.

Solar calendar
Lunar calendar
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• Tap a day in the Month view to display that day in the Day view.
• Tap the scroll arrows in the upper right corner to move forward or 

backward a month. 
• Tap Go To to open the date selector and select a different month.
• Use the scroll buttons on the front panel of your Smartphone to 

move between months. Press the top button to display the previous 
month, the bottom button to display the next month. 

Working in Agenda view
The Agenda view lets you view appointments, untimed events, and To Do 
List items in a single screen. Although it is primarily a viewing option, you 
can also use the Agenda view to check off completed To Do List items. To 
go to a Day View of any event on the Agenda view screen, simply tap the 
desired event. 

To display the Agenda View:
1. Tap the Agenda view icon to switch to Agenda view.

2. Use the jogdial to move forward or backward a day at a time or to 
display more To Do items.

Agenda view

Scroll the list 
for each view
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Tips for using Agenda view
• Tap any appointment while in Agenda view to display the Day 

View of the appointment. 
• Check off completed To Do List items in the Agenda view, or click 

a description of an item to go directly into the To Do List 
application. 

• You can change the category of To Do items shown. Tap on the 
pick list and select the new category. See the chapter on “Using the 
To Do List” for more information on To Do items.

Changing the Date Book display
In Day or Month view, you can change which events appear in the Date 
Book. In Day view, you can display time bars that highlight event conflicts.

To change the Date Book display of events:
1. In Day view or Month view, tap the Menu icon.

2. Tap Options, and then tap Display Options.

3. For Day view, select from the following options:

• Tap Show Time Bars to display time bars showing the duration of 
an event and any event conflicts.

• Tap Compress Day View to display start and end times for each 
event, but no blank time slots at the bottom of the screen, to 
minimize scrolling. Clear the option to display all time slots. 

4. For Month view, select whether to display Timed, Untimed, or Daily 
Repeating events.

5. Tap OK.
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Changing the displayed Start and End Times
You can change the preferences used for new entries. Preferences include 
display starting time, display ending time, and alarm characteristics. See 
the section “Setting alarm options” earlier in this chapter for more 
information on alarm preferences.

To change the start and end time in the Date Book:
1. In the Date Book, tap the Menu icon.

2. Tap Option, and then tap Preferences.

The Start and End Time are used by the various Date Book screens. The 
Day view schedules events to start and end at these times when the All Day 
option is selected. The Week view displays the time span defined by the 
Start Time and End Time.

3. Tap Start Time and use the scroll arrows to select a new start time for 
the Date Book screens. Repeat the step to set a new end time. If the 
time slots you select do not fit on one screen, you can tap the scroll 
arrows to scroll up and down.

4. Tap OK.
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Using the Memo Pad
The Memo Pad provides a place to take notes that are not associated with 
records in the Date Book, Address Book, or To Do List.

Use the Memo Pad to
• Take notes or write any kind of message on your Smartphone. 
• Drag and drop memos into popular computer applications like 

Microsoft® Word when you synchronize using Smartphone and 
HotSync® technology.

• Assign memos to categories so that you can organize and view 
them in logical groups.

• Write down phone numbers and other types of information. Later, 
you can copy and paste this information into other applications. 

To open the Memo Pad application:

1. Tap the Home icon . And select Main from the pick list in the 
upper right corner.

2. Tap the Memo Pad icon .

Creating memos
A record in the Memo Pad is called a memo. A memo can contain up to 
4,000 characters. The number of memos you can store is limited only by 
the memory available on your Smartphone.
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When you create a new memo, you can add information to it from the 
Address Book application, such as a phone number or address, using the 
Phone Lookup option. If you want to know about the detailed guide, please 
look over “Finding address book recorders” of the “Find recorder” of the 
“Performing Common Tasks” in the chapter 4

To create a new memo:

1. Tap the Memo Pad icon on the front panel of your Smartphone to 
display the Memo List.

2. Tap the New button.

TIP: You can also create a new memo by beginning to write in the 
text input area in the Memo List screen. The first letter is automatically 
capitalized and begins your new memo. 

3. Input the text you want to appear in the memo. Press down the jogdial 
to move down to new lines in the memo.

Tap New.
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4. Tap Graphic to insert a photo (or create a new photo) to the memo.

NOTE: For instructions, see “Using the PhotoEditor” in Chapter 
8, “Working with Studio Applications”.

5. When finished, tap the Menu icon and select Back from the File menu 
to return.

6. Tap Done.

You can categorize memos and sort them by categories. See “Categorizing 
Records” and “Sorting Records” in Chapter 5, “Performing Common 
Tasks” for more information.

Tap Graphic

Tap Back to return to
the previous interface
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Reviewing memos
The Memo List displays the first line of a memo. This makes it easy to 
locate and review your memos. You can easily sort memos in the Memo 
List or move through memos using Memo options.

To review a memo:

1. In the Memo List, tap the text of the memo.

2. Browse or edit the text in the memo. 

3. Tap the Done button.

To change the order in which memos appear in the Memo List:

1. In the Memo List, tap the Menu icon on the front panel of your 
Smartphone

2. Choose Options > Preferences; and select one of the following options.

• Tap Manual to sort new memos in the sequence in which you create 
them.

• Tap Alphabetical to sort new and existing memos in numerical and 
then alphabetical sequence. 

Tap a memo 
to browse its 
contents
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3. Tap OK.

Tap the pick list to 
select a method
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Using the To Do List
The To Do List is a convenient place to create reminders and prioritize the 
things that you have to do.

Use the To Do List to
• Make a quick and convenient list of things to do.
• Assign a priority level to each task.
• Assign a due date for any or all of your To Do List items. 
• Assign To Do List items to categories so that you can organize and 

view them in logical groups. 
• Sort your To Do List items either by the due date, priority level, or 

by the category.
• Attach notes to individual To Do List items for a description or 

clarification of the task. 

To open the To Do List application:

1. Tap the Home icon .

2. Select Main from the pick list in the upper right corner.

3. Tap the To Do List icon .

Creating To Do List items
A To Do List item is a reminder of some task that you have to complete. A 
record in the To Do List is called an item.
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1. Tap the New button.

2. Enter the content of the current To Do List item. The text can be 
longer than one line.

TIP: You can add a name, address, and phone number to a To 
Do List item using the Phone Lookup option. 

3. Tap the other place onscreen to deselect the current To Do List item.

TIP: If no To Do List item is selected currently, writing in the text 
input area automatically creates a new item.

Setting To Do List priorities
You can set priorities for tasks in your To Do List according to their 
importance or urgency. Items appear by priority and due date at the top of 
the To Do List by default, with 1 the highest priority. Changing an item’s 
priority may move its position in the list. 

New To Do List items automatically have a priority of 1. If you select 
another item first, before creating a new item, the item you create appears 
beneath the selected item with the same priority as the selected item. 

To set the priority of a To Do List item
1. If priorities aren’t visible in the To Do List, tap Show at the bottom of 

the list, select Show Priorities check box, and tap OK.

Tap New.

New To Do 
item
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2. Tap the Priority number on the left side of the To Do List items.

3. Tap the Priority number that you want to set, with 1 the most 
important and 5, the least important. 

Checking off To Do List items
You can check off a To Do List item to indicate that you’ve completed it. 

To check off a To Do List item:
1.In the To Do List, tap show. Tap Show Completed Items. If you clear 
this setting, your To Do items disappear from the list when you 
complete (check) them. 

NOTE: Items that no longer appear on the list because Show 
Completed Items is turned off have not been deleted. They are 
still in the memory of your Smartphone. You must purge 
completed items to remove them from memory.

4. Tap the check box on the left side of the item.

Tap to select 
priority.

Tap here

Completed To 
Do List item
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Changing priorities and due dates
You can change the To Do List to display the due date assigned to an item, 
change its priority, and assign a category to the task with the To Do Item 
Details dialog box. 

You can then sort To Do List items by priority, due date, or category.

To change the priority and due date of a To Do List item:
1. In the To Do List, tap the item you want to change.

2. Tap the Details button.

3. In the To Do Item Details dialog box, tap No Date to open the Due Date 
pick list.

4. Select the date that you want to assign to the current item. 

5. Select Private check box to hide this item when Security is enabled.

6. Tap the Note button to attach a note. You can even insert a picture 
here by tapping the Graphic button. When finished, tap Done.

Tap here.

Tap Graphic to 
insert or create a 
photo.
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NOTE: For instructions on creating pictures, see “Using the 
PhotoEditor” in Chapter 8, “Working with Studio Applications”. 
When finished drawing the picture, tap the Menu icon; then 
choose File > Back to return to the previous Note editing screen.

7. Tap OK.

TIP: If the Show Due Dates option is enabled in the To Do 
Preferences dialog box, you can tap directly on the due date in 
the To Do List to open the pick list shown in step 3.

To sort To Do items
1. In the To Do List, tap Show.

2. In the To Do Preferences screen, tap Sort By, and then select an option 
from the pick list:

• Select Priority, Due Date to sort items by priority first, and then due 
date. Select Due Date, Priority to reverse that order.

• Select Category, Priority to sort items by category first, and then 
priority. Select Priority, Category to reverse that order.

3. Tap OK.

Displaying completed and due items
You can make the To Do List display completed items and their completion 
dates, as well as due items and their due dates. 

To display completed and due items in the To Do List:
1. In the To Do List main interface, tap the Show button.



Using the To Do List

Smartphone User’s Manual 181
   

This is the internet version of the User Manual.Print only for private use.

2. In the To Do Preferences dialog box, select from the following settings:

• Select Show Completed Items check box to display your completed 
items in the To Do List. If this setting is turned off, completed To 
Do items disappear from the list, but are kept in the memory of your 
Smartphone. You must purge completed items to remove them 
from memory.

• Select Show Only Due Items check box to show only the items that 
are currently due, past due, or have no due date specified. When 
this setting is active, items that are not yet due do not appear in the 
list until their due date.

• Select Record Completion Date check box to replace the due date 
with the actual date when you complete (check) the item. If you do 
not assign a due date to an item, the completion date still records 
when you complete the item.

• Select Show Due Dates check box to display the due dates for items 
in the To Do List and to display an exclamation mark next to items 
that remain incomplete after the due date passes.

• Select Show Priorities check box to display each item’s priority.
• Select Show Categories check box to display each item’s category.

3. Tap OK.



Using the Clock

Smartphone User’s Manual 182
   

This is the internet version of the User Manual.Print only for private use.

Using the Clock
Clock enables you to view the current time and date in multiple locations 
and to set 6 alarms. And tools like Countdown, StopWatch are also 
provided.

To open the Clock application:
1. Tap the Home icon .

2. Select Main from the pick list in the upper left corner.

3. Tap the Clock icon .

Clock
You can use Clock to select the time zone for the primary location. Keep in 
mind that the primary location settings are system date and time and that 
these settings are used by all the applications on you Smartphone. The 
primary location settings also serve as a point of reference for the 
secondary locations.

Setting the location:
1. Select Clock from the pick list in the upper right corner.

2. Use the location pick list to select your preferred primary and 
secondary location

Setting the date and time
The primary location settings also appear in the Date & Time Preferences 
screen. Similarly, if you change the settings in the Date & Time 

Tap the location 
pick list to select 
preferred location

Primary

Secondary
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Preferences screen, those settings become your system date and time and 
also appear under the primary location in Clock. 

To set the date
1. Tap the ticking clock to open the Date & Time Preferences screen 

directly.

2. Tap the Set Date box.

3. Tap the arrows to select the current year.

4. Tap the current month.

5. Tap the current date.

To set the time:
1. Tap the Set Time box.

Tap the arrows to 
select year

Tap to select 
month

Tap to select 
date
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2. Tap the upward or downward arrow to change the hour.

3. Tap each minute number box, and then tap the arrow to change the 
number.

4. Tap AM or PM to change the display style.

5. Tap OK.

CountDown
1. Select CountDown from the pick list in the upper right corner.

2. Tap the Tap the upward/downward triangle buttons to set the start 
time.

3. Tap Start to start countdown.

4. Tap Pause to pause.

5. Tap Reset to reset the time to zero.

Setting
1. In the main screen of Countdown, tap the Menu icon

2. Select Setting from the Option menu.

Tap the upward/downward 
triangle buttons to set the 
start time
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3. Tap the Alarm Sound box to select a melody which will sound when 
the count down stops.

4. Tap a desired melody and tap OK.

Stopwatch
1. Select “Stop watch” from the pick list in the upper right corner.

2. Tap the Start button to begin counting.

3. Tap the Pause button to pause counting.

4. Tap the Reset button to set the time to the default value “00:00:00”.

Tap to select a 
melody
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Using the Alarm
The Alarm application enables you to set an alarm for events. When the 
alarm is triggered, your handheld will vibrate, play sound, flash back light 
or even send you SMS/MMS/Email.

To set a new alarm:

1. Tap the Home icon .

2. Select Main from the pick list in the upper left corner.

3. Tap the Alarm icon .

4. Tap any item to enter setting screen.

5. Check the option “Enable alarm” to show further settings.

• Repeat
– None: no repeat.
– Daily: repeat everyday.
– Weekly: If it is selected, there will be more options to let you 

decide on which day you want to repeat the alarm.
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• Time
Please refer to the relevant part in Clock.

• Date
Please refer to the relevant part in Clock.

• End On
Determines when the repeating alarm will end:

– No End Date: no end date.
– Choose Date...: specify a date when the repeat will end.

• Comment
Tap the blank area next to add comment

• Details...

Alert mode: select a method the alarm notifies you. Flash back 
light, vibrate, or play melody/sound. 

You can set alert time and frequency here. 

You can even set to be notified by Email, SMS or MMS if your 
Smart Phone is not with you at that time:

Alert mode

Tap this to set alter-
native alert modes

Select the way in which
the alert information

will be sent
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Using the Calculator
You can perform general mathematical functions with the Calculator, such 
as addition, subtraction, multiplication, and division. 

Use the Calculator to: 

• Perform basic calculations.
• Store and get values.
• Display the last series of calculations, which is useful for 

confirming a series of “chain” calculations.

To open the Calculator application:
Tap the Calculator icon  next to the text input area.

Using the Calculator buttons
The Calculator includes several buttons to help you perform calculations.

•
The CE button clears the last number you entered. Use this button 
can clear a mistake number while entering during a calculation. 
This button enables you to re-enter the number without starting the 
calculation over.

•
The C button clears the entire calculation and enables you to begin 
a new calculation.
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•  
The Plus/Minus button switches the current number between a 
negative and positive value. If you want to enter a negative number, 
enter the number first and then press the +/- button.

•
The M+ button places the current number in memory. Each new 
number you enter with the M+ button is added to the total stored in 
memory. The number that you add can be either a calculated value 
or any number you enter by pressing the number buttons. Pressing 
this button has no effect on the current calculation (or series of 
calculations); it merely places the value into memory until it is 
recalled.

•
The MR button recalls the stored value from memory and inserts it 
in the current calculation.

•
The MC button clears any value that is stored in the Calculator 
memory.

Displaying recent calculations
The Recent Calculations command lets you review the last series of 
calculations and helps you confirm a chain of calculations.

To display recent calculations:
1. In the Calculator application, tap the Menu icon.

2. Tap the Options, and then tap the Recent Calculations.
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3. When you have finished reviewing the calculations, tap OK.

Tap Recent 
Calculations
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Using the GSLauncher
GSLauncher enables you to customize the style and color of the desktop 
appearance.

To open the GSLauncher application:
1. Tap Home icon .

2. Select Main from the pick list in the upper right corner.

3. Tap the GSLauncher icon .

NOTE: This icon will not appear unless you are using the 
standard Palm launcher.

Changing launcher style
1. When using the GSLauncher, tap the Menu icon .

2. Select Set Launcher from the Option menu.

Standard Palm launcher GSLauncher

Tap this to switch 
to GSlauncher
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3. Tap the Launcher Style pick list to switch the current Phone style to 
PDA style.

4. Tap Done.

Changing wallpaper
1. When using the GSLauncher, tap the Menu icon .

2. Select Set Launcher from the Option menu.

3. Tap the Wallpaper pick list and select your favorite wallpaper.

Current style is 
Phone, tap the 
pick list to select 
PDA style

Phone Style PDA Style

Current category
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TIP: If you can’t find any suitable wallpaper in the list, tap From 
Album to select a photo from PhotoAlbum and set it as your 
wallpaper.

4. Tap Done.

Changing font color
1. When using the GSLauncher, tap the Menu icon .

2. Select Set Launcher from the Option menu.

3. Tap the “A” symbol at Font Color field to display Pick Color screen.

4. Select a favorite color from the Pick Color screen.

5. Tap OK.

Selected color 
will be shown on 
the background 
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6. Tap Done.

Now you see the font color is changed to the color you’ve just selected.

Managing categories
The category feature enables you to manage the applications shown 
onscreen in the Applications Launcher. You can assign applications to 
different categories and then display application as per categories. As 
default, your handheld includes system categories, such as All and Unfiled; 
and user-defined categories, such as Games, Main, and System. You can 
not modify the system categories, but you can rename and delete the user-
defined categories. In addition, you can create your own user-defined 
categories. Up to 15 user-defined categories can be created. 

To rename, create and delete a category
1. In the application list screen, tap the Menu icon.

2. Select Edit Folder from the Option menu.

3. Tap Edit

Tap this to select 
a category to be 
renamed
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4. You can:

• Select a category and tap Rename to rename the selected category.

Rename category name and tap OK.

• Tap New to create a new category

Enter a new category name and tap OK.

• Select a category and tap Delete.

Tap Yes to delete the selected category.

Enter the new 
category name 
here

Enter the new 
category name 
here

Tap Yes to confirm 
deletion and move all 
entries in the selected 
category to Unfiled 
category
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NOTE: All entries in the selected category will be moved to 
Unfiled category after deletion.

5. Tap OK.

6. Tap Done.

To hide categories from the Applications Launcher
1. In the application list screen, tap the Menu icon.

2. Select Edit Folder from the Option menu.

3. Select the categories you want to hide.

4. Tap Done.

Toggling among categories in GSLauncher
1. Tap the category tab on the top of the screen.

2. Tap the arrows to scroll up/down the category list and select one to 
view applications within.

Tap the check box 
next to the name of 
the category to hide 
the category

Tap the arrows to 
scroll up/down 
the category list
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To return to standard Palm Applications 
Launcher

1. If GSLauncher is currently in use, tap the Home icon.

2. Tap the Menu icon and select Exist GSLauncher from the App pull-
down menu.
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Using the Shorthand application
The Shorthand application enables you to save shorthand notes in graphical 
format. Directly write on the display with your stylus, when you lift the 
stylus off the display, the drawing or the word will be shown on the top of 
the screen.

To open Shorthand:
1. Tap the Home icon .

2. Select Main from the pick list in the upper left corner.

3. Tap the Shorthand application icon .

To create a new record:
1. Tap New.

2. Directly write on the display with your stylus. 

You can elect a color for strokes from the color box. 

3. Tap  to save.

Input the title here

Line feed

Space

Backspace

Save
Stroke color
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10
Enjoying with Game 
Applications
Besides all the powerful tools used to organize your business and personal 
life, we’ve also preset 5 thrilling and fantastic games in your Smartphone.

And you can find more games from the bundled CD-ROM.

Your Smartphone includes the following game applications:

• Bejeweled- a gem-sWAPping puzzle game.
• Big Money - a crazy game of coin collecting fun from the same 

stable as the award winning Bejeweled.
• Insanquarium - feed the fish and fight aliens in this new action 

game
• Megabowling - a game which is similar to bowling, one of the most 

popular and classical games! It enable you to enjoy the true 
physical laws when throwing the ball or just rest, while checking 
keenness of your vision and excellence of your response. 

• Zap!2000 - Zap!2000 brings to your Smartphone all the best 
features you could want in a shoot-em-up game.

For instructions, please refer to the online help respectively.
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11
Working with Utility 
Applications

Using Card Manager
You can use this application to manage records, configuration profiles, 
application files and application data stored in the internal memory card in 
your Smartphone or in an external card (like SD card). And you can check 
your Smartphone’s memory usage here.

To open the Card Manager application:
1. Tap the Home icon and select Utilities from the pick list in the upper 

right corner of the screen.

2. Tap the Card Manager icon .

NOTE: Card Manager will search for all existing applications 
when started, it will take you a few seconds.
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Browsing files
Select Internal or External Card from the pick list in the upper right corner 
to browse data at respective location.

• Tap the tabs at the bottom of the list screen to switch between 
Handheld Application List and Card Application List.

• In the upper left corner of the list screen, tap the category pick list 
to toggle among different categories of files.

• Tap the Sort By pick list and select to sort the file list by size, type 
or creator.

Copying files
You can copy files from internal card to external card or from external card 
to internal card.

1. Select the file you want to copy.

• Select desired file by tapping on the file name in the file list 
• Tap Sel All below the file list to select all the files in the current list.

TIP: Uncheck the check box to deselect a file. To deselect all 
files, tap Clr All below the file list.

2. Tap Copy. If prompted, tap Yes to confirm.

Tap this tab to 
view 
applications 
stored in cardsHandheld Application list Card Application list

Sort By pick 
list (category/
size/creator)
Category pick 
list

Free memory 
of Handheld

Tap this pick list to switch between 
Internal Card and External Card
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3. Tap OK, a dialog box will appear showing the status of transmit; if 
duplicates found, a dialog box will prompt you whether to overwrite it 
or not.

Moving files
You can move (cut) files from your internal card to external card or move 
(cut) files from external card to internal card.

1. Select the file you want to move.

• Select desired file by tapping on the file name in the file list 
• Tap Sel All below the file list to select all the files in the current list.

2. Tap Move. If prompted, tap Yes to confirm.

3. Tap OK, a dialog box will appear showing the status of moving; if 
duplicates found, a dialog box will prompt you whether to overwrite it 
or not.

NOTE: If the selected file is a system file like Currency, a dialog box 
will warn you “can not move files”.

Deleting files
Delete applications in handheld or in external card.

1. Select the file you want to delete.

• Select desired file by tapping on the file name from the file list 
• Tap Sel All below the file list to select all the files in the current list.

2. Tap Delete. If prompted, tap OK to confirm.

NOTE: If the selected file is a system file, such as Currency, a dialog 
box will warn you “can not delete files”.
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Creating folders
You can create new folders in external card.

1. Select External Card from the pick list in the upper right corner (can 
not create folders in internal card).

2. Tap the Menu icon .

3. Select Create folder from the Tool menu.

4. Enter the folder name in the dialog box.

5. Tap OK.

Renaming files
You can rename files in external card (can not rename files in internal 
card).

1. Select External Card from the pick list in the upper right corner.

2. Select the file you want to rename.

3. Tap the Menu icon .

Tap the Menu icon or tap 
the inverted tab to show 
application menu
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4. Select Rename from the Tool menu.

5. Enter the new file name.

6. Tap OK.

Dictionaries
Your Smartphone exclusively includes 2 powerful but easy-to-use 
dictionaries.

English-Chinese Dictionary
To look for Chinese explanation for an English word:

1. Tap the Home icon  and select Utilities from the pick list in the upper 
right corner of the screen. 

2. Tap the E-C Dict application icon to run.

3. Input the word you want to translate in the Input field, and the 
dictionary will list out the words in similar spelling. 

4. Tap the desired word from the list or directly tap Enter button on the 
right side of the Input field to enter explanation screen.

Tap the Menu icon or tap 
the inverted tab to show 
application menu
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Chinese-English Dictionary
To open C-E Dict:

1. Tap the Home icon and select Utilities from the pick list in the upper 
right corner of the screen.

2. Tap the C-E Dict application icon to run.

For details of using the C-E Dict, please refer to the previous part, 
“English-Chinese Dictionary”
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Using the Shortcut
For quick access to favorite applications, you can create shortcuts for those 
applications in Shortcut. To enter the list screen of Short. cut, do one of the 
following:

• Press the Volume +/- button on the left side panel of the unit.
• Tap the Shortcut application icon in Applications Launcher.

To run applications from Shortcut:
When Shortcut is opened, tap any application directly from the list to run.

TIP: You can store shortcuts in 2 groups, and each group can 
contain up to 6 shortcuts. To switch between the 2 groups of 
shortcuts, press Volume +/- button on the left side panel of the 
unit. 

To add a new application to the list of shortcuts:
1. Tap Edit Shortcut on the bottom of the list screen of Shortcut.

By default, only SMS, MMS, jBrowser, Emailer, SKT and GSM On/Off application are 
listed in Shortcut.

2. Tap Add in the Edit Shortcut dialog box.

Existing 
shortcuts

Tap this to show Edit 
Shortcut dialog box
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3. Select desired applications by tapping the checkboxes left to them and 
tap OK.

To rename a shortcut:
1. Tap Edit Shortcut on the bottom of the list screen of Shortcut.

2. Select a shortcut and tap Rename in the Edit Shortcut dialog box.

3. Input the new name for the shortcut and tap OK.

To remove a shortcut:
1. Tap Edit Shortcut on the bottom of the list screen of Shortcut.

2. Select a shortcut and tap Remove in the Edit Shortcut dialog box.

Tap this to list out 
all the available 
applications

When finish, tap OK.

Selected items
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12
Working with 
System Applications
Your Smartphone includes the following utility system applications:

• Preference
• Security
• Card Info
• Flash Backup Manager
• GSM On/Off
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Customizing your Smartphone
You can customize your Smartphone in the following ways:

• Display personal information such as your name and address
• Display the current date and time, and different date and time 

formats for other countries and time zones
• Choose how long your Smartphone stays on before shutting down 

to save the battery
• Control the sound volume
• Allow your Smartphone to automatically receive any data beamed 

to it
• Configure networking parameters.

To open the Preferences application:
You set preferences to customize your device.

To enter the Preferences screen:

1. Tap the Home icon .

2. Select All or System from the pick list in the upper right corner of the 
screen.

3. Tap the Prefs icon .

Owner Preferences
Owner preferences let you record a name, company name, phone number, 
or any other information you want to include on your Smartphone.

If you use the Security application to turn off and lock your Smartphone 
with a password, information that you enter in the Owner Preferences 
appears the next time you turn on your Smartphone. 

To change owner preferences on your Smartphone: 
1. From the Preferences screen, tap Owner from the pick list in the upper 

right corner.

2. On the Owner Preferences screen, enter the text you want to associate 
with your Smartphone. If you enter more text than can fit on one 
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screen, a scroll bar appears at the right side of the screen. 

NOTE: If you have assigned a password to your device using 
the Security application, you must unlock the Owner Preferences 
screen to change the information on it. 

To unlock the Owner Preferences screen: 
1. Display the Owner Preferences screen.

2. Tap Unlock. The Unlock Message dialog box appears. 

3. Enter your current password (the one you entered in the Security 
application), then tap OK. 

4. Edit the Owner Preferences text as desired. 

Date & Time Preferences
The Date & Time Preferences screen lets you set the date, time, and time 
zone for your device.

To set the date:
1. From the Preferences screen, tap Date & Time from the pick list in the 

upper right corner.

2. On the Date & Time screen, tap the Set Date box; then tap the arrow 
at the top of the Set Date Screen to select the current year.

3. Tap the month; then tap the current date.

The screen closes and the dates you selected are displayed in the Set Date 
box.
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To set the time:
1. On the Date & Time screen, tap the Set Time box; then tap the up or 

down arrow to change the hour. 

2. Tap each minute number, and then tap an arrow to change the 
number. 

3. If available, tap AM or PM. 

4. Tap OK to set the new time and return to the Date & Time screen.

NOTE: To display time based on a 24-hour clock, change the 
time format. See “Formatting the date, time, and numbers” later in 
this chapter.

To set the time zone:
1. On the Date & Time screen, tap the Set Time Zone box.

2. Use the up and down arrows to scroll to your country and time zone. 
The hardware scroll buttons can be used to page by page.

3. Make sure your time zone is highlighted, then tap OK.

TIP: Choose the time zone from the list that corresponds to 
where you are. When you travel, use this dialog to change time 
zones. If you’re not sure what time zone you are in, find out what 
time it is, and select the time zone which shows the current new 
time.
Do not use the time zone dialog to switch between daylight saving 
time and standard time. Use the Daylight Saving pick list.
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The screen closes and the time zone you selected is displayed in the Date & 
Time screen.

To set daylight saving time:
• On the Date & Time screen, tap on the Daylight Saving pick list to 

toggle this feature on or off.

Formats Preferences
The Formats Preferences screen lets you choose a default country for your 
device and also lets you set defaults for times, dates, and number formats. 
When selecting a country and time, date, and number formats, keep the 
following in mind: 

• When you select a country, the time, date, and number formats as 
well as the week’s starting day are adjusted, For example, in 
Germany, time often is expressed using a 24-hour clock and the 
starting day of the week is Monday; in the United States, however, 
time is expressed using a 12-hour clock with an AM or PM suffix 
and the starting day of the week is Sunday. You can customize your 
own settings.

• The Time setting defines the format for the time of day, which 
appears in all applications on your Smartphone. 

To choose a country as default: 
1. Tap the Home icon; then tap the Prefs icon.

2. In the pick list in the upper right corner, tap Formats.

3. Tap the Preset To pick list, and tap a country name.
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To change the format of the time, date, week start, and numbers:
1. In the Formats Preferences screen, tap the Time pick list and select a 

format, where H is hour and M is minute. 

2. Tap the Date pick list and select a format, where D is day, M is month, 
and Y is year.

3. Tap the Week starts pick list, and select whether you want the first day 
of the week to be Sunday or Monday. 

• This setting controls the Day, Week, Month, and Agenda views in 
Date Book and all other aspects of your Smartphone that display a 
calendar.

4. Tap the Numbers pick list, and select formats for the decimal point 
and thousands separator.

General Preferences
In this screen, you can set the sounds and volumes, Auto-Off feature, and 
Beam Receive feature.

Setting the auto-off delay time:
You can set when your Smartphone automatically shuts off. Your 
Smartphone automatically turns off the power and backlight after a period 
of inactivity, to conserve battery power. If you find that your Smartphone 
shuts itself off before you finish reviewing the information on the screen, 
you can increase the automatic shutoff setting.

To set the auto shutoff interval:
1. Tap the Home icon; then tap the Prefs icon. 

2. In the pick list in the upper right corner, tap General.

3. In the General Preferences screen, change the auto-shutoff time by 
tapping the Auto-off After pick list. Tap an option—30 seconds, 1 
minute, 2 minutes, or 3 minutes.

Setting the sounds and volumes
You can control the sound for system alerts, alarms, and games using the 
General Preferences screen.
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To set the sounds:
1. Tap the Home icon; then tap the Prefs icon. 

2. In the pick list in the upper right corner, tap General.

3. To set sounds and volumes, tap the System, Alarm, or Game Sound 
pick list, and select the sound level—Off, Low, Medium, or High.

• Turning off the System Sound also turns off the chime tones used 
during HotSync operations. 

NOTE: The Game Sound setting typically works only with newer 
games that are programmed to respond to it.

Setting Beam Receive Feature
You can choose to turn off the Beam Receive feature. This prohibits 
anyone from beaming information to your handheld. It also results in a 
slight saving of battery power.

To change the Beam Receive setting:
• In the General preferences screen, tap the Beam Receive pick list 

and select On or Off.

Buttons preferences
The Buttons preferences screen enables you to associate different 
applications with the buttons on the front panel of your Smartphone. For 
example, if you find that you seldom use the Camera and often use Mail, 
you can assign the Camera button to start the Mail application.

You can also change whether the full-screen pen stroke activates the 
Graffiti 2 Help application or one of your controls using Buttons 
preferences.

Any changes you make in the Buttons Preferences screen become effective 
immediately; you do not have to change to a different screen or application.

If you assign a different application to button, you can still access the 
original application using the Applications Launcher.
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To Change the Buttons preferences:
1. Tap the Home icon; then tap the Prefs icon. 

2. In the pick list in the upper right corner, tap Buttons.

3. Tap the pick list next to the button you want to reassign.

4. Select the application that you want to assign to the button.

To change what the full-screen pen stroke activates:
1. In Buttons preferences screen, tap Pen on the bottom of the screen.

2. Tap the pick list, and tap one of the following settings for the full-
screen pen stroke:

• Backlight turns on the backlight of your Smartphone.
• Keyboard opens the onscreen keyboard for entering text characters.
• Graffiti 2 Help opens a series of screens that show the complete 

Graffiti 2 character set.
• Turn Off & Lock turns off and locks the Smartphone. You must 

assign a password to lock the Smartphone. When locked, you need 
to enter the password to use your Smartphone.

Tap arrow to show 
pick list

Tap default to restore all the 
buttons to their factory settings
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• Beam Data beams the current record to other IR enabled devices.
3. Tap OK.

Adv.Setting Preferences
You can select different skin color for the system appearance here.

To set the skin color:
1. Tap the Home icon; then tap the Prefs icon. 

2. In the pick list in the upper right corner, tap Adv.Setting.

3. Tap the pick list in the lower part of the screen to select a desired skin 
color.

To display time while the unit is off
1. Tap the Home icon and select System from the pick list in the upper 

right corner.

2. Tap the Prefs icon and select Adv.Setting from the pick list in the 
upper right corner.

3. From the Adv.Setting screen, check the checkbox in the upper part the 
screen to enable this feature.

Check this box to enable the 
this feature.
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PowerOn Preferences
1. Tap the Home icon and select System from the pick list in the upper 

right corner.

2. Tap the Prefs icon and select PowerOn from the pick list in the upper 
right corner.

Graffiti 2 Preferences
The Graffiti 2 tuner provides alternate strokes for making the T, P, Y, and $ 
characters. For example, you may want to write the letter “T” by using 
strokes similar to a space and an “L”. But if this technique is difficult to 
control, you can turn off this option. For details, please refer to “Using the 
Graffiti 2 Tuner” in Chapter 4, “Entering Data in Your Smartphone”.

GSM/GPRS Preferences
You can set your ringtone profile, SMS/EMS, MMS, WAP Browser and 
Email configuration profiles here.

To open GSM/GPRS preferences screen:
1. Tap the Home icon and select System from the pick list in the upper 

right corner.

2. Tap the Prefs icon and Select GSM/GPRS from the pick list in the 
upper right corner.

Tap here to enter the 
power-on greeting.



Customizing your Smartphone

Smartphone User’s Manual 218
   

This is the internet version of the User Manual.Print only for private use.

To set ringtone profile
1. In GSM/GPRS screen, tap Profile from the pick list in the upper right 

corner. 

2. Tap Profile pick list to select a profile which suits the environment 
you’re currently situated in.

3. Tap “Incoming type” pick list to switch between Call and Message 
types. You can specify settings for each type separately.

4. Tap Alert pick list to define the way your phone alerts you when 
there’s an incoming call or message.

5. Tap Melody box to select a melody as the ringtone.

6. Drag the slider leftward/rightward to increase/decrease ringtone 
volume.

To set SMS/EMS
1. In GSM/GPRS screen, tap SMS/EMS from the pick list in the upper 

right corner. 
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• Warn Over: You’ll get a warning if the content of the outgoing 
message exceeds 1 or more parts (customizable). Tap the pick list 
the specify the number.

• Expires: Set a period of time for which the message can be retained 
in the message folder before you send it out. Tap the pick list to 
specify the period.

• Message Center
– Auto: Before sending text messages, you must input the number 

of the message service centre, which you can get from your 
service provider. If your SIM card contains the number to the 
service centre, it can be recognized once the SIM card is 
inserted. 

– Custom: If your SIM card does not contain the number to the 
message service centre, you must specify the number yourself.

To set Email
1. In GSM/GPRS screen, tap Email from the pick list in the upper right 

corner. 

2. Select your e-mail service provider from the Mailbox pick list:

• Select your service provider and tap Detail to show Details screen. 
In Details screen, you can see all the settings are preset, you only 
need to complete your e-mail address at the Email Address line.

Mailbox pick list

User name of 
your e-mail 
account
Password of 
your e-mail 
account
Service pick list

Tap Detail to view details 
of the select profile

Complete 
your e-mail 
address here

• POP3 login first: when connected, 
log in POP3 Server first

• Keep mails on server: it means that you 
leave your mails in the server and what 
you receive using the EMailer 
application is just the COPY of the 
original mails.
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• If your service provider is not in the list, you can select any empty 
profile titled Profile6, Profile7 or Profile8, and then tap Details to 
enter your email address, and specify the SMTP Server and POP3 
Server (provided by your e-mail service provider).

3. Enter your user name and password.

• If you enter your password, you’ll login to the server without being 
prompted for a password.

• If you leave it blank, you’ll be prompted for a password every time 
you send or receive e-mail.

4. Select a connection service (your network operator) from the Service 
pick list.

Tap Default to reset to default values.

To set jMMS
1. In GSM/GPRS screen, tap jMMS from the pick list in the upper right 

corner. 

2. Select a profile from the MMS Profile pick list.

If you’re not sure whether the selected profile suits you, tap Edit to view its 
detailed information and make necessary changes. 

For details of configuring MMS Profile, please contact your service 
provider.

3. Tap Network Connection pick list to select your network operator.

MMS Profile 
pick list

Tap Edit to 
customize the 
selected profile.

For details of 
configuring 
MMS Profile, 
please contact 
your service 
provider.
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To set jBrowser
1. In GSM/GPRS screen, tap jBrowser from the pick list in the upper 

right corner. 

2. Select a profile from the list in the middle of the screen.

3. Tap Edit to configure the selected profile.

• Homepage: Enter the URL of WML page that you wish to have as 
your homepage.

• Gateway/IP Address/Port: Please inquire your service provider.
• Mode: Select ConnectionLess or ConnectionOriented. Selecting 

ConnectionLess enables temporary data communication, while 
ConnectionOriented is of continuous data communication.

Select your 
profile here
Configure the 
selected profile
Selected profile 
will be shown here

Accordingly, the 
network that the 
select profile uses 
will be automatically 
applied

Current profile

Tap Done to 
return to Profile 
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NOTE: Port number should be 9201 for Connection Oriented 
connection and 9200 for Connection Less connection. If WTLS 
enabled version of gateway is being used, then port 9203 can be 
used.

• WTLS Security: Check this option to enable data encryption. If 
checked, Authentication type need to be specified. Authentication 
type can be set to either Anon (anonymous) or Auth 
(authenticated), depending on the configuration of your dial-in 
server.

• Tap Done to return.
4. Select Cache/Cookie from the pick list in the lower right corner of the 

Profile setting screen.

• Check Cache Enabled option to enable it.
Browsed pages can be cached for future viewing. Fetching pages 
from the cache loads the page faster.

• Check Cookie Enabled option to enable it.
Some WAP sites store information in a small text file, called a 
“cookie”. Cookies usually contain information about you and your 
preferences for that WAP site. A site can use this information to 
customize the pages you see the next time you visit.

Allowing a WAP site to create a cookie does not give the site 
access to the rest of your handheld. A cookie only stores the 
information you provide while visiting the WAP site.

Select Cache/Cookie 
from the pick list

Check this to enable it

Customize the 
size of Cache here

Tap this to clear 
all cached data
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5. Then tap OK to return to Profile setting screen.

6. Tap Apply to save changes.

Connection preferences
The Connection Preferences screen allows you to create configurations for 
communicating with a PC, modem, or GSM mobile phone. Configurations, 
or profiles, once activated are available to various end-user applications 
running on the Smartphone. The Connection Preferences screen displays a 
list of available configurations that can be modified to reflect the required 
settings. This list will vary depending on the software you have added to 
your Smartphone.

You can also create custom configurations, which include the following:

Check this to enable it

Customize the size 
of Cookies here
Tap this to clear all 
saved Cookies

Cradle/Cable This connection type defines the direct cradle/cable 
connection between your organizer and your 
desktop computer. It is used when performing a 
local HotSync. Your Smartphone is connected by 
its universal port to the cradle of HotSync cable. 
The cradle/cable is attached to a serial (COM) port 
on your desktop computer.

Standard Modem This connection type defines a connection between 
a modem attached to your Smartphone and a 
modem attached to a serial (COM) port on your PC.
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To open Connection preferences screen:
1. Tap the Home icon and select System from the pick list in the upper 

right corner.

2. Tap the Prefs icon and Select Connection from the pick list in the 
upper right corner.

To edit IR to a PC/Handheld connection
The following example shows you how to edit the IR to a PC/Handheld 
connection to adjust the communication speed; you can similarly edit other 
connections or settings or create a custom connection. You can use the IR 
to a PC/Handheld connection to perform a remote IR HotSync operation. 
To accomplish the HotSync operation, your handheld sends data through 
its IR port to an IR port in your desktop computer, and synchronize with 
your desktop application.

IR to a PC/Handheld This connection type defines a connection between 
the IR port of your Smartphone and the infrared 
device of your computer or handheld device.

Default Phone 
Connection

Use you Smartphone directly connect to GSM 
network.

Infrared to GSM 
Phone

This connection type defines a connection between 
the IR port of your Smartphone and an infrared-
enabled GSM mobile phone. 

Serial to GSM 
Phone

This connection type defines a connection between 
the serial port of your Smartphone and a GSM 
mobile phone, using a special cable designed to 
match your phone. 
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1. Tap the IR to a PC/Handheld and tap Edit.

2. Tap Details.

3. Tap the pick list to select appropriate speed

4. Tap OK

5. Tap OK again to save the configuration.

After you create the configuration, you need to set up the HotSync 
Manager of your Desktop application and the HotSync application of you 
handheld to perform a modem HotSync operation.

Network preferences
Network preferences settings are for advanced users only. Changing your 
Network preferences settings affects your Smartphone's ability to operate 
in a wireless environment.

Tap to select a 
connection

Tap Edit

Select speed
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To open Network preferences screen:
1. Tap the Home icon and select System from the pick list in the upper 

right corner.

2. Tap the Prefs icon and Select Network from the pick list in the upper 
right corner.

To select a service
Use the Service setting to select the service template for your service 
provider or for a dial-in server. Service templates are a set of service 
provider and dial-in server configuration settings that you can create, save 
and reuse. Also you can create new service template. See “Creating 
additional service templates” later in this chapter.

1. Tap the Service pick list.

2. Select the predefined service template you want to use.

To enter user name and password
The User Name setting identifies the name you use when you log in to your 
service provider or your dial-in server. Although this field can contain 
multiple lines of text, only two lines appear onscreen. The Password box 
identifies the password you use to log in to your service provider or your 
dial-in server. Your entry in the Password box determines whether your 
Smartphone prompts you to enter a password each time you log in to your 
network.

1. Tap the User Name field to enter your user name.

2. Tap the Password box to enter you password.

Tap here to display 
a list of service 
template.
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3. Tap Ok

The Password box is updated to display the word “Assigned”.

To Select a connection
Use the Connection setting to select the method you want to use to connect  
to your service provider or to a dial-in server. See “Connection 
preferences” previously in this chapter for information about creating and 
configuring connection settings.

1. Tap the Connection pick list.

2. Select the connection you want to use.

To add Phone settings
Some services require a telephone number. When you select the Phone 
field, a dialog box opens in which you define the telephone number you use 
to connect with your service provider or dial-in server. In addition, you can 

Tap here to enter 
your user name

Tap here to show 
Password dialog box

Enter password here

Tap here display a list of 
available connections
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define a prefix, disable call waiting, and give special instructions for using 
a call card.

1. Tap the Phone box.

2. Enter the number of your service provider or dial-in server.

3. Enter a prefix if needed.

A prefix is a number that you dial before the telephone number to access an 
out side line. For example, many offices require you dial “9” before dialing 
a number outside the building.

1. Tap the Dial prefix checkbox to select it.
2. Enter the prefix.

4. Disable call waiting feature if necessary.

Call waiting can cause your session to terminate if you receive a call while 
you are connected. If your telephone has call waiting, you need to disable 
this feature before logging in to your service provider or dial-in server.

1. Tap the Disable call waiting box to select it.

Enter the phone 
number here

Select this box if you 
need to use a prefix

Enter the prefix here
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2. Enter the code to disable call waiting on the Disable call waiting 
line.
Each telephone company assigns a code to disable call waiting. Contact 
your local telephone company for the code that is appropriate for you.

5. Tap the Use calling card box if you need to use a calling card.

The Use calling card field enable you to use your calling card when dialing 
your service provider or Internet server. Keep in mind that there is usually a 
delay before you enter your calling card number. When you define your 
calling card number, you need to add commas at the beginning to 
compensate for this delay. Each comma delays transmission of your calling 
card number for two seconds.

1. Tap the Use calling card box to select it.
2. Enter your calling card number on the Use calling card line.

6. Tap OK to save Phone settings and return to Network preferences 
screen.

Select this box if you need 
to disable call waiting

Enter your disable code here

Select this box if you need 
to use a calling card

Enter your calling card number here
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To add details to a service template
If you are using one of the predefined service template, you probably need 
to enter only your user name and telephone number. If you are creating a 
new service template, you may need to provide additional information to 
your service provider or dial-in server. You use the Details dialog box to 
add more information to a selected service template.

In the Network preferences screen, tap Details.

• Idle timeout 
The idle time out setting defines how long your handheld waits 
before dropping the connection with your service provider or dial-
in server when you switch out of a TCP/IP application. Tap the pick 
list to select one of the following options:

– 1 minute: Waits one minute for you to open another application 
before it drops the connection.

– 2 minutes: Waits two minutes.
– 3 minutes: Waits three minutes.
– Never: Maintains your PPP, SLIP or CSLIP connection until 

you turn off your Smartphone.
Caution: By enabling this option, you may incur significant 

charges if the connection to your service provider is left open.

• DNS
The Domain Naming System (DNS) is a mechanism in the Internet 
for translating the names of host computers into IP address. When 
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you enter a DNS number (or IP address) you are identifying a 
specific server that handles that translation services.

Each IP address has four sections, separated by periods.In the 
Details dialog box, you enter each section separately. Each section 
of an IP address is made up of a number from 0 to 255; umbers are 
the only allowable characters in this field.

Ask your service provider or system administrator for the correct 
primary or secondary DNS IP numbers.

Many systems do not require that you enter a DNS number. If you 
are not sure, leave the DNS field blank.

1. Tap the Query DNS check box to deselect it.

2. Tap the space to the left of the first period in the Primary DNS field, 
and then enter the first section of the IP address. Each section must 
be a number from 0 to 255.

3. Repeat step 2 to complete all the sections of primary DNS and 
secondary DNS number.

• IP Address
Everyone who logs in to the Internet needs to have a unique 
identifier (an IP address), whether permanent or temporary. Some 
networks dynamically assign a temporary IP address when clients 
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log in. The IP Address field lets you identify whether your network 
provides automatic (dynamic) temporary IP addressing.

If your IP address is permanently assigned, you need to get that 
information from your system administrator. If you are not sure, 
select Automatic.

1. Tap the IP Address checkbox to identify dynamic IP addressing.

2. Tap the IP Address check box to deselect it and display a 
permanent IP address field below the checkbox. 

3. Tap the space to the left of the first period, and then enter the first 
section of the IP address.

4. Tap OK.

• Script
A login script is a series of commands that automates logging in to 
a network server - for example, your corporate network or your 
wireless service provider. A login script is associated with a 
specific service template created in Network Preferences.

A login script is something that you are likely to receive from your 
system administrator if your company has a system in which you 
log in to the corporate servers from your handheld using a modem 
or network connection. The script is generally prepared by the 
system administrator and distributed to users who need it. It 

Dynamic IP
Permanent IP
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automates the events that must take place in order to establish a 
connection between your handheld and the corporate servers.

You can create login scripts from the Login Script dialog box on 
you handheld, accessed from the Details dialog box in Network 
Preferences.

1. Tap the End pick list and select commands from the list to create a 
login script. 
Some commands, such as Send, requires you to supply additional 
information. Those command have a parameter field so that you 
can add the necessary data.

2. The following commands are available:

Wait For Tells your hand held to wait for specific characters from 
the TCP/IP server before executing the next command.

Wait For 
Prompt

Detects a challenge-response prompt corning from the 
server and then displays the dynamically generated 
challenge value. You then enter the challenge value into 
your token card, which in turn generated response value 
for you to enter on your handheld. This command takes 
two arguments, separated by a vertical bar ( | ) on the input 
line.

Send Transmits specific characters to the TCP/IP server to 
which you are connecting. 

Send CR Transmits a carriage return or LF character to the TCP/IP 
server to which you are connection.

Tap here to see 
list of available 
commands
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3. Repeat step 1 and 2 until the login script is complete.
4. Tap OK.

To create additional service templates
You can create additional service templates by duplicating existing 
templates and editing information. After you create a duplicate template, 
you can add and edit settings.

1. In the Network preferences screen, tap the Service pick list.

2. Select the template you want to duplicate.

Send User ID Transmits the user ID information entered in the User ID 
field of the Network Preferences screen.

Send  
Password

Transmits the password entered in the Password field of 
the Network Preferences screen. If you did not enter a 
password, this command prompts you to enter one. The 
Password command is usually followed by a Send CR 
command.

Delay Tells your handheld to wait a specific number of the 
seconds before executing the next command in the login 
script.

Get IP Reads and IP address and uses it as the IP address for your 
handheld. This commands used with SLIP connections.

Prompt Opens a dialog box and prompts you to enter text of some 
kind (for example, a password or a security code).

End Identifies the last line in the login script.
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3. Tap the Menu icon on the front of you Smartphone and select 
Duplicate from the Service menu.

A copy of the service template is now added to the Service pick list

4. Select the duplicated template and modify the template according to 
your needs.

To delete a service template
1. In the Network preferences screen, tap the Service pick list.

2. Select the template you want to delete.

3. Tap the Menu icon on the front of you Smartphone and select Delete 
from the Service menu.

4. Tap OK.

To connect to your service
• Tap Connect to dial the current service.
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To close a connection
• Tap Disconnect to terminate the connection between your 

Smartphone and your service.

Phone preferences
Select a connection for your phone applications.

1. Tap the Home icon.

2. Select All or System from the pick list in the upper right corner of the 
screen.

3. Tap the Prefs icon.

4. In the pick list in the upper right corner, tap Phone.

5. Tap the pick list in the middle of the screen to select a preferred 
connection.

6. Tap Test to test the connection.
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Shortcuts Preferences
he ShortCuts preferences screen enables you to define abbreviations for 
entering text. You can create a ShortCut for any work, letters, or numbers. 
All ShortCuts you create appear on the list in the ShortCut preferences 
screen. All the ShortCuts are available in any of your handheld applications 
and are backed up on your computer when you perform HotSync operation.

To create a new ShortCut
1. Tap New.

2. On the ShortCut name line, enter the letters you want use to activate 
the ShortCut.

3. Tap the ShortCut Text area to enter the text you want to appear when 
write the ShortCut characters.

TIP: You may want to add a space (space character) after the 
last word in your ShortCut text. This way, a space automatically 
follows the ShortCut text.

4. Tap OK.

To use a ShortCut, stroke the ShortCut command followed by the ShortCut 
characters. The ShortCut symbol appears at the insertion point to show that 
you are in ShortCut mode.
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To edit a ShortCut
1. Tap the ShortCut you want to edit.

2. Tap Edit.

3. Make the changes you want.

4. Tap OK.

To delete a ShortCut
1. Tap the ShortCut you want to delete.

2. Tap Delete.

3. Tap Yes.

Digitizer Preferences
The digitizer screen opens the digitizer calibration screen. This is the same 
screen that appears when you start your handheld for the first time. You can 
calibrate your screen after a hard reset or your digitizer drifts. For details, 
please refer to “Starting your phone and calibrating its screen” in Chapter 
2, “Introduction to the Smartphone”.

ShortCut symbol
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Using Security to protect your private 
information

Your handheld comes with a security feature so that unauthorized users 
cannot view the entries you want to protect. Use the security feature to do 
the following: 

• Mask or hide entries you have defined as private. The Mask option 
displays a gray bar over private records, and the Hide option 
completely removes (hides) private records. 

• Assign a password to viewing options to enhance security. 
Assigning a password requires you to enter a password before 
private entries can be viewed; no assigning a password lets you 
view private entries when you Show Records from the Security 
dialog box. 

• Lock and turn off your Smartphone so that a password must be 
entered before you can use the device again. 

• Hide records that you have defined as private, with or without a 
password. Without a password, private records are hidden until you 
set the Security application to display them; with a password, you 
must enter the password to view the private entries.

To open Security
1. Tap the Home icon and select system from the pick list in the upper 

right corner.

2. Tap the Security icon .

You can mask and hide private records with or without a password. 
Without a password, private records are hidden or masked until you set the 
Security preference to show them. With a password, you must enter the 
password to view the private entries.
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Assigning a password 
You can assign a password to protect your private records and to lock your 
handheld. You can mask the password from accidental viewing. To quickly 
log in, you can also assign a short, quick password that works only at your 
first login attempt and for a limited amount of time. You can set the amount 
of time you need to enter the quick password. 

To assign a password: 
1. Tap the Password box. 

2. Enter a password. 

3. Enter a hint to help you remember your password if you forget it. This 
is optional. 

4. Tap OK. 

5. Enter the same password a second time, and press OK.

Changing or deleting a password 
Once you define a password for your handheld, you can change or delete it 
at any time. You must enter the current password before you can change or 
delete it. 

To change or delete your password: 
1. Tap the Password box. 
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2. Enter the current password. 

3. Tap OK

4. Do one of the following: 

• To change the password or hint, enter the new information, and tap 
OK.

• To remove the password, tap Unassign. 

Masking your private entries
Masking your password entry secures your password against accidental 
viewing by another person. The password only shows asterisks as you are 
entering the characters. 

To mask private records:
1. In Security preferences screen, tap the Current Privacy pick list, tap 

Mask Records.

2. Tap OK.

Now, records marked as private are masked with a gray bar. 
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Locking your handheld 
You can lock your handheld so that it cannot be operated until your 
password is entered. In the event that your handheld is lost or stolen, this 
helps protect your data from unauthorized use. You can set your handheld 
to lock automatically, or you can lock it manually. 

Locking your handheld automatically
You can set your handheld to lock automatically when any one of the 
following occurs: 

• When you turn off the power 
• At a time you specify 
• After a period of inactivity you specify.

To set you handheld to lock when you turn it off:
1. Tap the Auto Lock Handheld box. 

2. Enter your password. 

3. Select On power off. 

Tap here

Tap here



Using Security to protect your private
information

Smartphone User’s Manual 243
   

This is the internet version of the User Manual.Print only for private use.

4. Tap OK. 

NOTE: Turn off and then turn on your handheld to enable this 
change. 

To set your handheld to lock at a preset time
1. Tap the Auto Lock Handheld box. 

2. Enter your password. 

3. Select Lock at a preset time.

4. Use the arrow to set time

5. Tap OK. 

NOTE: Turn off and then turn on your handheld to enable this 
change.

Tap here

Tap At a preset time
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To set your handheld to lock after a period of inactivity: 
1. Tap the Auto Lock Handheld box. 

2. Enter your password. 

3. Select After a preset delay. 

4. Enter the inactive period, and then select Minute(s) or Hour(s) from 
the pick list. 

5. Tap OK.

NOTE: You need to turn off and then turn on your handheld 
before this change is enabled. 

Tap here

Tap After a preset delay

Tap the pick list to 
select a time unit

Enter the amount of time
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IMPORTANT: If you lock your handheld, you must enter the 
exact password to reactivate your handheld. If you forget the 
password, your handheld will present the hint you have entered to 
help you remember the password. If you still cannot remember 
the password, you must perform a hard reset to resume using 
your handheld. Performing a hard reset deletes all the records in 
your handheld; however, you can restore all synchronized data at 
the next HotSync operation. See “Performing a hard reset” in 
Appendix A for more information.

Locking your handheld manually
You can turn off and lock your handheld manually.

To lock and turn off your handheld: 
1. Tap Lock & Turn Off. 

2. To use your handheld, turn it on and then enter the password. 

Recovering from a forgotten password 

IMPORTANT: Deleting a forgotten password also deletes all 
entries and files marked as Private. 

If you are not locked out of your handheld and you forgot your password, 
your handheld displays a hint, if you entered one, to help you remember the 
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password. If you are still unable to remember the password, you can delete 
it from your handheld. 

IMPORTANT: If you synchronize with your computer before 
deleting a forgotten password, your handheld restores your 
private entries the next time you perform a HotSync operation, but 
it does not restore the password. 

To delete a forgotten password: 
1. Tap the Password box. 

2. Tap Lost Password. 

3. Tap Yes.

Marking records private
In many applications, you can make individual records private. Private 
records remain visible and accessible, however, until you select the 
Security setting to hide or mask all private records. 

Masked records appear as gray placeholders in the same position they 
would appear if they were not masked, and are marked with a lock icon. 

Tap here to delete the password
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Hidden records disappear completely from the screen. If you define a 
password for your handheld, you must enter it to display private records. 

To hide all private records:
1. Tap the Current Privacy pick list and select Hide Private Records. 

2. Tap OK to confirm that you want to hide private records.

To mask all private records: 
1. Tap the Current Privacy pick list and select Mask Records. 
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2. Tap OK to confirm that you want to mask private records.

To display all private records
1. Do one of the following: 

• Tap the Current Privacy pick list and select Show Private Records. 
• If you do not have a password, hidden and masked records become 

visible. 
If you have a password, the Show Private Records dialog box 
appears. Go to step 2. 

2. Enter your password. 

3. Tap OK.

To unmask individual records
1. Select a masked record.

2. Do one of the following: 

• Tap the Current Privacy pick list and select Show Private Records. 
• If you do not have a password, hidden and masked records become 

visible. 
If you have a password, the Show Private Records dialog box 
appears. Go to step 3. 

3. Enter your password.

4. Tap OK.

To make a record private
1. Display the entry that you want to make private. 
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2. Tap Details. 

3. Tap the Private check box. 

4. Tap OK.



Flash Backup Manager

Smartphone User’s Manual 250
   

This is the internet version of the User Manual.Print only for private use.

Flash Backup Manager
There are many applications for you to use, and they are stored in ROM, so 
they will not be lost when the power is off.

As for the data created by users, including those generated by applications, 
e.g. the events created by Date Book, photos/messages received and e-
mails/data generated by the Palm Desktop synchronization application and 
data generated by other devices. All of them are stored in RAM, so the data 
will be lost in 3 minutes after power off.

In order to prevent the loss of data as a result of power off, there are two 
ways to backup data.

• Backup data to PC with Palm Desktop synchronization application. 
Data will be restored via the synchronization application when 
incidents happen.

• Backup data to Flash in the local machine via the Flash Backup 
Manager application (Flash will not lose data when power off). 
When accidents happen, you could restore data via Flash Backup 
Manager.

To open Flash Backup:
1. Tap the Home icon .

2. Select System from the pick list in the upper right corner.

3. Tap the Flash Backup icon .

Backing up data manually
Please note when backing up data:

• The capacity of Flash is only 2M Bytes, so the data in Flash should 
not exceed 2M Bytes.

• As for the applications which are downloaded and installed by 
users, they can't be stored in Flash, as a result, users need to 
reinstall the applications when accidents happen. But the data 
which are generated by the execution of these applications can be 
stored in Flash.
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• Users are recommended to backup data regularly.

Enabling auto backup
Instead backing up data by manually, you can set you Smartphone to 
backup data in specific situation or at a regular interval automatically.

Enabling Low Bat Backup
This feature enables your Smartphone to backup data automatically when a 
low battery warning issued.

To enable Low Bat Backup
1. In the main screen of Flash Backup, tap the Menu icon.

Memory usage

Tap this to 
backup your data

Tap this 
check box 
to enable 

Tap this to 
delete the 
last backup 
record
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2. Select Preferences from the Options menu.

3. Tap the Enable Low Bat Backup checkbox.

4. Tap OK.

Enabling Auto Backup
you can set you Smartphone to backup data at a regular interval 
automatically.

To enable Low Bat Backup
1. In the main screen of Flash Backup, tap the Menu icon.

2. Select Preferences from the Options menu.

3. Tap the Enable Low Bat Backup checkbox.

4. Input the amount of time, and tap the pick list to select time unit.

5. Specify the time you want your Smartphone to perform a backup 
operation.

6. Tap OK.

Restoring data from flash memory
Before storing data from flash memory, please make sure the data in flash 
memory is newer that those in Palm Desktop, or you are recommended to 
restore from Palm Desktop.

To restore data from flash memory
In the main screen of Flash Backup, tap the Restore button on the bottom of 
the screen to restore the last backup record.

Tap this checkbox to enable it

Enter the amount of time here

Tap the pick list to 
select time unit

Specify the time you want 
your Smartphone to perform 
a backup operation
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NOTE: If no data has been backed up, then Restore command 
will be unavailable.
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Using CardInfo
The CardInfo application enables you to review general information of 
different storage media, including Internal Card (an built-in memory card), 
and External Card (SD/MMC).

To open the CardInfo application:
1. Tap the Home icon.

2. Select System from pick list in the upper right corner.

3. Tap the CardInfo icon .

Reviewing card information
You can view the card name, type, available storage space, and a summary 
of its contents.

Renaming a card
Renaming a card enables you to give an easy-to-recognize name to the 
card.

To rename a card
1. Tap the Menu icon.

2. Select Rename Card from the Card menu.

Card information

Summarized card info
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3. Enter the new name for the card.

4. Tap the Rename.

Formatting a card
1. Tap the Menu icon.

2. Select Format Card from the Card menu.

3. Tap OK.
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Turing on/off GSM connection
Before making/receiving calls, sending/receiving messages, surfing the 
Internet or other activities require network connection, you must turn of 
GSM first. Or when you are on a flight, you can use this function to turn off 
GSM and use your handheld merely as a PDA.

To open GSM On/Off application:
1. Tap the Home icon .

2. Select System from the pick list in the upper left corner.

3. Tap the GSM On/Off application icon .

To turn on/off GSM:
• If the GSM connection is currently OFF, tap the button labeled 

“Turn On GSM” in the middle of the screen to turn on GSM.
• If the GSM connection is currently ON, tap the button labeled 

“Turn Off GSM” in the middle of the screen to turn on GSM.

The Signal Strength icon shows 
that GSM is currently Off

Tap this to turn on 
GSM

GSM is now on

Tap this to turn off 
GSM

If the Auto On and 
Auto Off functions are 
enabled, the GSM will 
be activated and 
deactivated 
automatically at the 
time you specified.
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13
Exchanging and 
Updating Data using 
HotSync® Operations
HotSync® technology lets you synchronize - exchange and update - data 
between one or more Palm OS handhelds and Palm Desktop software or 
another PIM such as Microsoft Outlook. To synchronize data, you must 
connect your Handheld and Palm Desktop software either directly, by 
connecting your Smartphone with the HotSync cable to your computer or 
using infrared communications.

The HotSync process automatically synchronizes data between your 
Smartphone and Palm Desktop. Changes you make on your Smartphone or 
Palm Desktop appear in both places after a HotSync operation. HotSync 
technology synchronizes only the needed portions of files, thus reducing 
synchronization time. 

You can synchronize your data by connecting your Smartphone directly to 
your computer with the serial port HotSync cable. You can also perform 
HotSync operations using the IR port on your organizer. This chapter 
describes how to select HotSync options and perform a HotSync operation 
via infrared communications. 

Performing a HotSync operation for the first time
The first time you synchronize your data, you must enter user information 
on both the Smartphone and Palm Desktop. After you enter this 
information and synchronize, the HotSync Manager recognizes your 
Smartphone and doesn’t ask for this information again.
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If you are a System Administrator preparing several Smartphones for a 
group of users, you may want to create a user profile. See “Creating a user 
profile” later in this chapter before performing the following steps.

Performing the first local HotSync operation
You must perform your first HotSync operation with a local, direct 
connection.

The following steps assume that you have already installed the Palm 
Desktop. If you have not installed this software, see “Installing Palm 
Desktop” in Chapter 1, “Introduction to the Smartphone” for instructions.

To perform a local HotSync operation:
1. Connect your Smartphone to computer’s serial port through the 

HotSync cable.

2. If the HotSync Manager is not running, start it: On the Windows 
desktop, click Start, and then choose Programs. Navigate to the Palm 
Desktop program group and choose HotSync Manager. Alternatively, 
you can start the Palm Desktop which automatically opens the 
HotSync Manager.

3. Tap the HotSync application icon from the Application Launcher on 
your Smartphone.

4. Select Local from the main screen of HotSync. And tap the HotSync 
icon in the middle of the screen to start.

5. If you are performing the HotSync operation for the first time, you 
must enter a user name in the New User dialog box appeared on your 
computer monitor and click OK.

6. The HotSync Progress dialog box appears and synchronization begins.

Every Smartphone should have a unique name. To prevent loss of a user’s 
records, never try to synchronize more than one Smartphone to the same 
user name.
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7. Wait for a message on your Smartphone indicating that the process is 
complete.

When the HotSync process is complete, you can disconnect your 
Smartphone from HotSync cable.

Creating a user profile
You can create a user profile to load data into an Smartphone without 
associating that data with a user name, using the File Link feature. This 
feature lets System Administrators configure several Smartphones with 
specific information (such as a company phone list) before distributing 
them to their actual users. For more information on the File Link option, 
see “Using File Link” later in this chapter.

The User Profile feature is designed only for the first-time HotSync 
operation, before you assign a User ID to a particular Smartphone. 

To create a user profile:
1. Open Smartphone.

2. From the Tools menu, choose Users.

3. Click Profiles. 

4. Click New. Enter a unique name for the profile, and click OK. 

5. Repeat steps 3 and 4 for each profile that you want to create. When 
you have finished, click OK to return to Smartphone. 

6. Select the profile from the User list and create the data for the profile 
(for example, company phone list, and so on).



Exchanging and Updating Data using
HotSync® Operations

Selecting HotSync setup options

Smartphone User’s Manual 260
   

This is the internet version of the User Manual.Print only for private use.

To use a profile for the first-time HotSync operation:
1. Connect your Smartphone to computer's serial port through the 

HotSync cable.

2. Click the HotSync Manager icon in the Windows system tray.

3. Click Profiles.

4. Select the profile that you want to load on the Smartphone, and click 
OK.

5. Click Yes to transfer all the profile data to the Smartphone.

The next time you perform a HotSync operation, Smartphone prompts you 
to assign a user name to the Smartphone.

Selecting HotSync setup options
You can choose when you want HotSync Manager to run.

To set the HotSync options:
1. Click the HotSync Manager icon in the Windows system tray.

2. Choose Setup. 

3. Click the General tab, and select one of the following options:
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• Always Available adds HotSync Manager to the Startup folder and 
constantly monitors the communication port for synchronization 
requests from your Smartphone. With this option, the HotSync 
Manager synchronizes data even when Palm Desktop is not 
running.

• Available Only When Palm Desktop Is Running starts HotSync 
Manager and monitors requests automatically when you open 
Smartphone.

• Manual monitors requests only when you select HotSync Manager 
from the Start menu.
If you’re not sure which option to use, keep the default setting, 
Always Available.

4. Click the Local tab to display the settings for the connection between 
your computer and the Smartphone.

5. If needed, choose another Serial Port to identify the port that Palm 
Desktop uses to communicate with your Smartphone. 

6. This selection should match the number of the port to which you 
connected the Smartphone. Your Smartphone cannot share this port 
with an internal modem or other devices. See “Product Layout” in 
Chapter 2, “Introduction to the Smartphone”, if you have trouble 
identifying the serial port.
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7. If needed, set the speed to determine the speed at which data is 
transferred between your Palm Desktop and Smartphone. 

8. Try the As Fast As Possible rate first, and adjust downward if you 
experience problems. This setting allows Palm Desktop and your 
Smartphone to find and use the fastest speed.

9. Click the Modem tab to display the modem settings and adjust the 
options as needed. See “Performing a HotSync operation via a 
modem” later in this chapter for more information.

10. If you are attached to a network, click the Network tab to display the 
network settings and adjust the options as needed. See “Conducting a 
HotSync operation via a network” later in this chapter for more 
information.

11. Click OK.

Customizing HotSync application settings
For each application, you can define a set of options that determines how 
records are handled during synchronization. These options are called a 
“conduit.” By default, a HotSync operation synchronizes all files between 
the Palm Desktop and Smartphone. 

In general, you should leave the settings to synchronize all files. The only 
reason you might want to change these settings is to overwrite data on 
either your Palm Desktop or Smartphone, or to avoid synchronizing a 
particular type of file because you don’t use it.

In addition to the conduits for Date Book, Address Book, To Do List, and 
Memo Pad, Smartphone includes System and Install conduits. The System 
conduit backs up the system information stored on your Smartphone, 
including Graffiti® 2 ShortCuts. The Install conduit installs applications on 
your Smartphone. 

To customize HotSync application settings:
1. Click the HotSync icon in the Windows system tray (bottom right 

corner of the taskbar).
Tip: You can also click the HotSync command on the Palm Desktop menu bar.

2. From the HotSync Manager menu, choose Custom.
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3. Select the appropriate user name from the list.

4. Select an application in the Conduit list. Click Change.

5. Click the direction in which you want to write data, or click Do 
Nothing to skip data transfer for an application.

6. Choose how long the setting will remain in effect:

• To have the setting affect only the next HotSync operation, deselect 
“Set As Default”. Thereafter, the HotSync Actions restore their 
default settings. 
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• To use a new setting as the default, select the Set As Default option. 
Thereafter, whatever you selected as the default setting is used 
when you click the Default button in the Custom dialog.

7. Click OK.

8. Repeat steps 4 through 7 to change conduit settings for other 
applications.

9. Click Done to activate your settings.

IR HotSync operations
Your organizer is equipped with an infrared (IR) port that supports the 
IrCOMM implementation of the standards for infrared communication 
established by the Infrared Data Association (IrDA). This means that you 
can beam data to any other device that supports the IrCOMM 
implementation of the IrDA standards. Most importantly, you can use the 
IR port to perform HotSync operations. You don’t need a HotSync cable to 
do this. This is very useful if you travel with an infrared-enabled laptop. 
You simply enable infrared communication on your laptop and Smartphone 
and follow the steps in “Performing an IR HotSync operation” later in this 
section.

Preparing your computer for infrared 
communication
Before you can perform a HotSync operation using the IR port, the 
computer you want to synchronize with must meet the following 
requirements:

• The computer must support the IrCOMM implementation of the 
IrDA standards.

• The computer must have an enabled built-in infrared port, or an 
enabled infrared device attached to the computer.

Desktop computers are likely to require an infrared device attached to a 
physical COM port. Laptops are likely to have a built-in IR port. Your 
computer must also have an installed infrared driver. 

Check if your computer supports infrared communication
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Infrared communication is built into the operating system for Microsoft 
Windows 98. Check your computer’s documentation to determine if the 
computer supports infrared communication.

Check if your Windows 95 computer supports infrared 
communication.

1. Click Start in the Windows taskbar.

2. Choose Settings, and then choose Control Panel.

3. In the Control Panel look for the infrared icon.

If the icon is there, your computer is enabled for infrared communication. 
If it isn’t there, you need to install an infrared driver.

After you install the infrared driver or determine that the infrared driver is 
already installed successfully, check the ports used by your computer for 
infrared communication.

To check the ports used for infrared communication:
1. In the Windows taskbar click Start, choose Settings, and then choose 

Control Panel.

2. Double-click Infrared.

3. Click the Options tab.

4. Select Enable infrared communication.

The COM port displayed in the drop-down box is the port where your 
infrared device is attached. It should be different from any port used by the 
HotSync Manager.

5. Make a note of which port is listed as “Providing application support”. 
You need this information to configure the HotSync Manager for 
infrared communication. This port is the simulated port. It is the 
channel through which the actual infrared communication takes place 
between your computer and your Smartphone. 

6. Deselect all other check boxes in the Options tab.

7. Click Apply and OK.
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Configuring HotSync Manager for infrared 
communication
Next you need to go to the HotSync Manager and specify the simulated 
port used for infrared communication.

To configure HotSync Manager for infrared communication:
1. Click the HotSync Manager icon in the Windows system tray.

2. Make sure Local is checked on the menu.

3. Choose Setup.

4. Click the Local tab.

5. In the Serial Port drop-down box, select the COM port that was given 
as the simulated port in the Options tab of the Infrared Monitor.

6. Click OK.

The HotSync Manager is now communicating with the simulated port 
defined for infrared communication.

NOTE: You cannot use your HotSync cable again until you 
reconfigure the HotSync Manager to communicate with the port defined 
for HotSync cable synchronization.

Performing an IR HotSync operation
After you complete the steps to prepare for an IR HotSync operation it is 
easy to perform the actual operation.

To perform an IR HotSync operation:
1. Tap the Home icon, and select System from the pick list in the upper 

right corner.

2. Tap the HotSync icon.

3. Tap Local.

4. Tap the pick list below the HotSync icon and select IR to a PC/
Handheld.

5. Position the IR port of your Smartphone within a couple of inches of 
the infrared port of your computer.
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6. Tap the HotSync icon to start the IR HotSync operation.

Returning to using the HotSync cable for 
HotSync operations
It’s easy to return to using the HotSync cable for HotSync operations.

To return to HotSync cable synchronization operations:
1. Connect the HotSync cable to a serial (COM) port on your computer.

2. Click the HotSync Manager icon in the Windows system tray.

3. Choose Setup, and then click Local.

4. Select the COM port where your HotSync cable is connected.

5. Click OK.

The next time you want to perform a HotSync operation just select Local 
from the menu. You can leave the HotSync application on your 
Smartphone set to perform IR HotSync operations and still use the 
HotSync cable. This is useful if you perform HotSync operations with both 
your desktop computer and a laptop that you travel with. When you travel 
you don’t have to carry a cable. When you are in the office just connect 
your organizer with the HotSync cable.

Conducting a HotSync operation via the modem
You can use a modem to synchronize your Smartphone when you are away 
from your computer.

NOTE: The first HotSync operation must be local, using the HotSync 
cable. After that, you can perform a modem HotSync operation.

To perform a HotSync operation via the modem you must complete the 
following steps:

• Connect a modem to your computer.
• Configure the Smartphone for use with your modem.
• Connect a modem to your Smartphone.
• Configure the Modem preferences on your Smartphone for use with 

your modem (Serial to Modem or IrCOMM to Modem). See 
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“Network Preferences” and “Connection Preferences” in Chapter 
10, “Working with System Applications”.

Preparing your computer
You must perform a few steps to prepare your computer for a modem 
HotSync operation. Be sure to perform these steps before you leave your 
office so that your computer is ready to receive a call from your 
Smartphone. 

To prepare your computer for a modem HotSync operation:
1. Confirm that the computer modem is connected and turned on, and 

that no communications applications, such as fax or telephony 
software, are running on a COM port.

NOTE: Make sure that the computer is disconnected from all online 
services, such as America Online (AOL) and CompuServe, to avoid 
conflicts with the COM port.

2. Start HotSync Manager if not running, and from the HotSync 
Manager menu, choose Modem.

3. Adjust the following options as needed: 
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• Serial Port to identify the port for the modem. If you are unsure of 
the port assignment, look at the Modem Properties in the Windows 
Control Panel.

• Speed to determine the speed at which data is transferred. Try the 
As Fast As Possible rate first, and adjust downward if you 
experience problems. This setting lets Palm Desktop and your 
Smartphone find and use the fastest speed.

• Modem to identify the modem type or manufacturer. Refer to your 
modem manual or face plate for its type or settings. If you’re not 
sure of your modem type or your modem doesn’t match any listed, 
select Hayes Basic.

• Setup String to identify the setup string for your particular modem. 
Not all modems require a setup string. Refer to your modem 
manual and enter the setup string if recommended by the 
manufacturer.

4. Click OK.

Preparing your Smartphone
In addition to preparing your computer, you must perform a few steps to 
prepare your Smartphone for a modem HotSync operation. 

To prepare your Smartphone for a modem HotSync operation:
1. Tap the Home icon. 

2. Tap the HotSync icon. 

3. Tap Modem.

4. Tap the pick list in the lower screen to select Default Phone 
Connection.

Tap this pick list to select 
Standard Modem
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5. Tap the Enter Phone # field.

NOTE: If you plan to connect to your company’s dial-in server 
(network modem) instead of connecting to a computer modem, see 
“Performing a HotSync operation via a network” later in this chapter.

6. Enter the telephone number to access the modem connected to your 
computer.

7. If needed, enter a dial prefix (such as “9”) to access an outside line, and 
then tap the Dial Prefix check box.

TIP: You can enter a comma in the field to introduce a “pause” in the 
dialing sequence. 

8. If the phone line you’re using for the Smartphone has Call Waiting, 
select the Disable call waiting check box to avoid an interruption 
during the Modem HotSync Operation. 

9. If you want to use a calling card to place the call, select the check box 
and enter the calling card number. 

10. Tap OK.

11. Tap the Menu icon. 
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12. Tap Options, and then tap Modem Sync Prefs.

13. Tap Direct to modem.

14. Tap OK.

Selecting conduits for a modem HotSync 
operation
You can define which files, applications, or both on your Smartphone 
synchronize during a modem HotSync operation, to minimize the time 
required to synchronize data. To define what synchronizes, you use the 
Conduit Setup dialog box.

Applications that do not have a database (such as games) do not 
synchronize—even if you select the item in the Conduit Setup dialog box. 

To define which files or applications on your device synchronize during 
a HotSync operation:

1. Tap the Home icon. 

2. Tap the HotSync icon. 

3. Tap the Menu icon. 

4. Tap Options, and then tap Conduit Setup.

5. In the Conduit Setup dialog box, tap the check boxes to deselect the 
files and applications that you do not want to synchronize during a 
modem HotSync operation. The default setting is to synchronize all 
files. 

Tap Direct to modem
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6. Tap OK.

Performing a HotSync operation via a modem
After you prepare your computer and your Smartphone, and select your 
Conduit Setup options, you are ready to perform a modem HotSync 
operation.

To perform a modem HotSync operation:
1. Tap the Home icon. 

2. Tap the HotSync icon. 

3. Tap the Modem icon to dial the Smartphone modem and synchronize 
the applications.

4. Wait for the HotSync operation to complete.

Conducting a HotSync operation via a network
When you use the Network HotSync software, you can take advantage of 
the LAN and WAN connectivity available in many office environments. 
The Network HotSync software lets you perform a HotSync operation by 
dialing in to a network or by using a cradle that is connected to any 
computer on your LAN or WAN (provided that the computer connected to 
the cradle also has the Network HotSync software installed, your computer 
is on, and the HotSync Manager is running).

The Network HotSync software requires the following:

• Your computer has TCP/IP support installed.
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• Both your company’s network system and its remote access server 
support TCP/IP. (Your System Administrator has this information.)

• You have a remote access account. (If you don’t have an account, 
consult your System Administrator.)

Everything you need to connect to your company’s dial-in server (network 
modem) is included with Palm Desktop and Smartphone software. You 
need to activate the feature, however, on both Palm Desktop and your 
Smartphone.

To prepare your computer for a network HotSync operation:
1. Click the HotSync Manager icon in the Windows system tray.

The Windows system tray is usually in the lower right corner on your computer 
display. The location may vary depending on the location of the taskbar and the 
version of Windows you are using.

2. From the HotSync Manager menu, choose Network.

3. From the HotSync Manager menu, choose Setup.

4. Click the Network tab and make sure that a check mark appears next 
to your user name. If no check mark appears, select the check box next 
to your user name.
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5. Click OK.

6. Place your Smartphone in the cradle, and perform a HotSync 
operation.

The HotSync operation records network information about your computer 
on your Smartphone. With this information, your Smartphone can locate 
your computer when you perform a HotSync operation over the network.

To prepare your Smartphone for a network HotSync operation:
1. Tap the Home icon. 

2. Tap the HotSync icon. 

3. Tap the Menu icon. 

4. Tap Options, then tap Modem Sync Prefs.

5. Tap Network.

6. Tap OK.

Using File Link
The File Link feature lets you import Address Book and Memo Pad 
information into your Smartphone from a separate external file such as a 
company phone list. HotSync Manager stores the data in a separate 
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category on your Palm Desktop and your Smartphone. You can set the File 
Link feature to check for changes to the external file when you perform a 
HotSync operation. 

With File Link, you can import data stored in any of the following file 
formats:

• Comma delimited (.csv).
• Tab delimited (.tsv).
• Memo Pad archive (.mpa).
• Address Book archive (.aba).
• Text (.txt).

For information on how to set up a file link, see the Palm Desktop online 
Help.
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14
Using the Attention 
Manager
Many applications (such as Date Book, Clock, and SMS) want to get your 
attention with some sort of alarm. Attention Manager allows you to 
conveniently manage all of these notifications in one place. Appointments 
and messages can stack up while you are away from your device. Attention 
Manager lets you view them from a single list, where you can selectively 
dismiss or follow up on each event.

Applications will signal for your attention at two different levels: insistent 
and subtle. Each will be discussed in detail below.

Insistent alarms
Insistent applications open a Reminders dialog screen, and may play a 
sound, or vibrate, depending on your hardware configuration. Alarms 
continue until you snooze or dismiss them. If the sound can be interrupted, 
you can tap anywhere on the screen, or push any button to silence it. 
Attention Manager will always open immediately when new insistent 
alarms are posted.
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Using the Reminder dialog screen
The Reminder dialog screen has three buttons for responding to an alarm:

OK: Makes the reminder go away, with no further notification.

Snooze: Switches to the application that was running when the alarm went 
off, and returns to the Reminder dialog screen after five minutes. You can 
go back to the Reminder dialog screen right away by tapping on the 
blinking indicator in the upper left corner of the screen. For more 
information, see “Understanding the blinking alarm indicator” below. 

Go To: Switches to the application that created the alarm, and shows the 
record that caused the alarm, although you may have to navigate within the 
application. There is no further notification.

Setting alarm volume
You control most alarm volumes globally in the General panel of the Prefs 
menu:

• From the Applications Launcher, tap the Prefs icon.
• Tap the General pick list in the upper right corner of the screen.
• Set the volume using the Alarm Sound pick list. If your device has a 

vibrate, turn these features on or off using their pick lists in this 
menu.
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Setting alarm sound effects
Some applications allow you to set the song or sound effect to use, and how 
many times to play it, with a pause in between. For example, to set alarm 
preferences for the Date Book, do the following:

1. While displaying the Date Book application, tap the Menu icon.
2. Tap the Options menu, and select Preferences.
3. Tap the Alarm Preset check box, if you want alarms to sound, then 

select the following from the pick lists:
• How soon you want the alarm to sound before the event
• The alarm song or sound effect (for example, Bird or Concerto)
• How many times the alarm repeats before giving up
• The pause between each time the alarm sounds

Using the Reminders list screen
The Reminders dialog screen changes to a list of items that require your 
attention under two insistent alarm conditions:

• When a second application attempts to get your attention and the 
first has not been dismissed or snoozed.

• When a first application makes a second attempt and the first has 
not been dismissed or snoozed.

Each listed reminder contains the date and time of the event. Depending on 
the application displaying the reminder, you may see an icon representing 
the application, and up to two lines of text. 
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Tapping on the text or icon will “Go To” that item and delete the event 
from the Reminders list screen.

Tapping in the check box will clear that item, similar to a To Do list item. 
The Attention Manager will draw a line through the text lines, pause for a 
moment, and then remove the item from the list, although the original data 
remains in the application.

The Reminders list screen displays three buttons that are used to respond to 
all of the items in the list:

Snooze: Puts the Reminders list screen to sleep for five minutes. After this 
interval, the Reminders list screen is displayed again. You can go directly 
to the Reminders list screen without waiting, by tapping on the blinking 
alarm indicator. For more detail, see “Understanding the blinking alarm 
indicator” below.

Done: If the Reminders list appeared because of more than one insistent 
alarm, tapping Done closes the Reminders list screen, although the events 
will remain in the application that created them. The Reminders list screen 
will not appear again, unless you tap the blinking alarm indicator in the 
menu bar.

If the Reminders list appeared after you tapped the Snooze button, then 
tapped the blinking alarm indicator, then tapped the Done button, the 
reminder will continue to snooze.

For more detail, see “Understanding the blinking alarm indicator” below.

Clear All: removes all of the items from the list, but does not close the 
Reminders screen. Tap this button to erase a list of events that have passed 
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Subtle alarms
Some applications provide a visual, and optionally audible indication, but 
do not otherwise disrupt your work flow. Subtle alarms do not display a 
Reminders screen. Instead, a blinking indicator will flash in the upper left 
corner of the title bar (of applications that allow it) when an alarm is 
present. 

Understanding the blinking alarm indicator
A blinking alarm indicator appears in the upper left corner of the screen in 
the menu bar (of applications that allow it) under the following conditions:

• While viewing a Reminders dialog screen, you tap the Done or the 
Snooze button

• A subtle alarm is present
The indicator appears in three different states:

• Off: The indicator is not shown at all when the list is empty.
• Blinking, two states: When the list is not empty but there are no 

new items, then the “star” indicator will blink on and off until the 
list has been emptied.

• Blinking, three states: When a new subtle alarm is received, the 
star will alternate flashing solid, exploded, then off, until you view 
the new event.

Tapping on the indicator opens the Attention Manager in list mode, even if 
there is only one item.
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15
Appendix I Reset 
your G88
Under normal circumstances, you will not have to use the reset button. On 
rare occasions, however, your handheld may no longer respond to buttons 
or to the screen. In this case, you need to perform a reset to get your 
handheld running again. 

Performing a soft reset 
A soft reset tells your handheld to stop what it's doing and start over again. 
All records and entries stored in your handheld are retained with a soft 
reset. After a soft reset, the Welcome screen appears, followed by the Date 
and Time Preferences screen (to set the date and the time). 

To perform a soft reset: 
Use the reset tip tool, or the tip of an unfolded paper clip (or similar object 
without a sharp tip), to gently press the reset button inside the hole on the 
side panel of your handheld. 



Appendix I  Reset your G88

Smartphone User’s Manual 282
   

This is the internet version of the User Manual.Print only for private use.

TIP: The metal and plastic stylus that comes with your handheld 
has a reset tip. 

Performing a hard reset 
With a hard reset, all records and entries stored in your handheld are 
erased. Never perform a hard reset unless a soft reset does not solve your 
problem. 

NOTE: You can restore any data previously synchronized with 
your computer during the next HotSync operation. 

To perform a hard reset: 
1. Hold down the power button on the front panel of the handheld. 

2. While holding down the power button, use the reset tip tool, or the tip 
of an unfolded paper clip (or similar object without a sharp tip), to 
gently press and release the reset button. 

3. Wait for the Palm Powered logo to appear; then release the power 
button. 

Reset button 
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4. When a message appears on the handheld screen warning that you are 
about to erase all the data stored on your handheld, do one of the 
following: 

• Push the jogdial up to complete the hard reset and display the 
Digitizer screen. 

• Press other buttons to perform a soft reset. 

NOTE: With a hard reset, the current date and time are 
retained. Formats preferences and other settings are restored to 
their factory default settings. 

1.Hold down the 
power button 

2.Insert the 
unfolded paper 
clip into here
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Appendix II: Install 
CD
• Put the CD in the driver, the install application will start 

automatism, if it doesn't work, please select “Install" in the CD.

• You must finish the first part "Install Palm Desktop 4.1 " and the 
second part" Install Album Desktop and Conduits", or your G88 
will not synchronize the software ,information and photos with 
your computer.

• If you want to synchronize information with the "Microsoft 
Outlook" of your computer in your G88, please continue installing 
the third part "Install the support application" .

• Finish installing, you can use you computer to synchronize your 
PDA with a data line at the first time. 
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• You can also select the following software to install:
– Frame Converter.
– Melody Converter. 

• Otherwise, you can also select some useful software to install in the 
following folders.
– bbbox: Including some useful information, such as: common 

sense of the file and so on.
– Toolbox: Including some useful software, such as: Ebook, 

exchange rate and so on.
– Game: Including some interesting games: Mummy,pharaoh and 

so on.

• User manual: Including English and Chinese user manual.

Installation Steps:
• First put in GSPDA Sync disk, then will show the next picture, 

Please select the first option [Install Palm Desktop 4.1] to install.
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• After do this, then will show the next picture:

• After moved the files, then will show the next picture again:
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• Now, Select Next option to continue the Installation. After do this, 
then will show the next picture:

• Select the first option I accept the terms in the license agreement, 
then select Next option to continue the next Installation.
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• After the picture had been displayed, first select first option 
[complete], and select Next option again, then will show the next 
picture, Please enter the username.

• After Entering the username, please again select Next option to 
continue the next Installation.
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• After then, Select USB or the correct position of SERIAL PORT, 
select Next option to continue the next Installation.

• After performed the previous steps, then select Install option, will 
display the next picture.
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• Then following display the next pictures, Please select Finish 
option.

• After complete installation, will display the original picture.
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• After complete the first step of installation, according to the panes 
have been displayed., then select the option of the second step of 
installation to continue the next Installation. After do this, will 
display the next picture.

• In this step, Please select [English],then press Enter to continue 
installation.

• After this step, will display the next pane.
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• After the pane had been shown, select finish, will display the next 
picture.
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• Then select[I accept the terms of the license agreement ],Continue 
to select Next to install, after this installation, please enter the name 
and the company of user.
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• After entered the name and company, select Next to continue 
installation.

• After installation, will display Y and X options, then please select 
Y to continue installation.
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16
Appendix III Product 
Specification
CPU Palm OS 4.1.2

CPU Motorola DragonBall MC68VZ328 33MHz

Display 160x240 pixels, 260K # color, MD-TFD colour LCD

with back light of4 x white LED

Memory 16MB ROM

16MB SDRAM

32MB Flash (Included 22MB for user backup)

Connectivity I/O connector (18 pins connector) 

- Hot Sync (USB 1.1)

- Battery charging

- Audio Jack

IrDA 1.1 - Covers 25 cm distance

- Speed 115.2kbps

Ringtone 32 Polyphonic Melody

Camera Image Size:CIF (320 x 240)

GSM/GPRS E-GSM/GPRS 900 / 1800 dual band module

GPRS class 10

Standby Time 850Ah 1300Ah
3 hoursTalk time*

Standby time*
2 hours
100 hours 150 hours
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Weight Gross weight: 580 gram/set.

Net weight: 115 gram/unit.

Dimension 100 x 49 x 21 mm

# Depends on applications in use.

* Depends on usage method/network.
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Appendix IV: Care 
and maintenance
This unit is a product of superior design and craftsmanship and should be 
treated with care. Please read the suggestions below carefully, which will 
help you enjoy the functions of the product and its accessories longer.

• Do not dispose of batteries in a fire!
• Keep it and all its parts and accessories out of children's reach.
• Keep it dry. Precipitation, humidity and liquids that contain 

minerals will corrode electronic circuits.
• Do not use or store it in dusty, dirty places, which may reduce the 

performance of the product and cause damage.
• Do not place it in hot places. High temperatures can shorten the life 

of electronic devices, damage batteries and warp or melt certain 
plastic parts.

• Do not attempt to open it. Non-professional handling of the device 
may cause damage to it or even invalidate the warranty.

• Do not drop, knock or shake it. Rough handling can reduce the 
lifetime of the unit or cause damage.

• Do not use strong detergents, chemicals or alcohol to clean it, or 
use dry cloth to wipe the screen. Please wipe it with soft and 
slightly dampened cloth or anti-static cloth.

• If the unit, battery, charger or any accessory is not working 
properly, take them to your nearest authorized and qualified 
service center. Non-professional handling may cause great damage 
and invalidate the warranty.
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Copyright

• Copyright © 2004 Group Sense PDA Ltd. All rights reserved.
• Palm OS and the Palm Powered logo are registered trademarks and 

Palm Desktop is a trademark of the Palm Trademark Holding 
Company, LLC. HotSync and Graffiti are registered trademarks of 
PalmSource, Inc. Other brands names may be trademarks of their 
respective owners.

• THE CHINESE HANDWRITING RECOGNITION SYSTEM IS 
AUTHORIZED BY HANWANG THCHNOLOGY CO., LTD.

• The manufacturer reserves the right to change the specifications 
without notice.

Declaration

• This User Guide is published by Group Sense PDA Ltd., without 
any warranty. Improvement and changes to this User Guide 
necessitated to typographical errors, inaccuracies of current 
information, or improvements to programs and/or equipment, may 
be made by Group Sense PDA Ltd. at any time and without notice. 
Such changes will, however, be incorporated into new editions of 
this User Guide.

• Some of the services in this User Guide are not supported by all 
networks. This also applies to the GSM International Emergency 
Number 112.

• Please contact your network operator or service provider if you are 
in doubt whether you can use a particular service or not.
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